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Welcome to DB2 Connect!
The DB2 Connect Quick Beginnings
books provide a focused introduction
to the installation and configuration
of DB2 Connect products.

This Quick Beginnings book will guide
you through the planning,
installation, migration (if necessary),
and set up of a DB2 Connect
Enterprise Edition server. First, you
will ensure that your host or AS/400
database is enabled for
communications. Next you will
install DB2 Connect and test its
connection to the host or AS/400.
Once you have established this
connection, you will install a DB2
client and configure it to use DB2
Connect to communicate with the
host or AS/400 database.

DB2
Universal
Database

How This Book is Structured

Setting up DB2 Connect is a multi-step process. The sections in this book
follow the typical sequence of tasks necessary to go from installing DB2
Connect to using client applications with your database. DB2 Connect
Enterprise Edition is often installed with hundreds or thousands of clients in
mind. For this reason, we advocate doing a test installation, as described
below. After the test configuration has proven stable, you can use it as the
template for an unattended installation of DB2 Connect and your clients
across your organization.

The typical steps to installing and configuring DB2 Connect are as follows:
Step 1. Determine how you want to use DB2 Connect in your network. For

the available options, see “Accessing Host or AS/400 DB2 Data from
the Desktop Using DB2 Connect Enterprise Edition” on page 4.

Step 2. Verify that you have the correct hardware and software prerequisites
on both your workstation and the host database server. See
“Chapter 2. Planning for Installation” on page 23 for prerequisites.

Step 3. Verify that your host or AS/400 database server is configured to
accept connections from DRDA Application Requesters such as DB2

© Copyright IBM Corp. 1993, 1999 vii



Connect. See “Part 3. Preparing Host and AS/400 Databases for DB2
Connect Communications” on page 45.

Step 4. The next step is to install your DB2 Connect software. You will use
this workstation to configure and verify your host and AS/400
connections. For DB2 Connect installation instructions, see “Part 2.
DB2 Connect Installation” on page 21.

Step 5. After installation, you will establish the connection between DB2
Connect and your host or AS/400 database system. DB2 Connect
can locate and configure all TCP/IP and most SNA connections for
you. If you are using a supported SNA product that DB2 Connect
does not automatically configure, see the chapter in “Part 4.
Configuring Access to Host and AS/400 Databases” on page 63 that
corresponds to your SNA product.

Step 6. Bind the programs and utilities provided with DB2 Connect to your
host or AS/400 database. For instructions on binding programs and
utilities provided with your DB2 Connect product, see “Step 6. Bind
Utilities and Applications to the Database Server” on page 96.

Step 7. You will need to test the connection. See “Chapter 7. Configuring
DB2 Connect to Host or AS/400 Communications Using the CCA”
on page 65 for more information.

Step 8. Enable the Multisite Update feature if you wish. See “Chapter 9.
Enabling Multisite Updates (Two-Phase Commit)” on page 99 for
more information.

Step 9. If you are planning to use Net.Data, WebSphere, transaction
monitors (for example, CICS, Encina, Tuxedo, MQSeries, Component
Broker) or your own application server software, install these
products or applications now. For information on installing Net.Data
or WebSphere consult the documentation provided with these
products as part of the DB2 Connect Enterprise Edition product
package. For other products consult the installation documentation
provided with the product.

Step 10. Choose a representative run-time client workstation and install and
configure DB2 Run-Time Client. You will use this workstation to test
connectivity from DB2 run-time clients to host and AS/400 servers,
as well as to test applications that use this connectivity. For
instructions on installing a client, see “Part 5. Installing and
Configuring Clients” on page 105.

Step 11. Install DB2 Run-Time clients on all end-user workstations that will
use applications that connect to host and AS/400 database servers.
For instructions on deploying DB2 Run-Time Client on a large
number of workstations, refer to the Installation and Configuration
Supplement.
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Step 12. You are now ready to use DB2 Connect with all your applications.
For ongoing administration of your OS/390 database servers and
DB2 Connect Enterprise Edition servers, select a workstation and
install the DB2 Administration Client. You can install the DB2
Administration client on a dedicated workstation, or on the same
machine where DB2 Connect is running. See “Part 5. Installing and
Configuring Clients” on page 105 for instructions on installing and
configuring DB2 Administration clients.

Step 13. Workstations that will be used for application development should
have the DB2 Software Developer’s Kit installed. See “Part 5.
Installing and Configuring Clients” on page 105 for instructions on
installing and configuring the DB2 Software Developer’s Kit.

Step 14. If you want to use this workstation to administer DB2 for OS/390 or
DB2 Universal Database for UNIX, Windows NT or OS/2 servers,
install the DB2 Administration Client component of DB2 Connect.
For more information on using Client tools, see “Appendix C. Using
the Control Center to Administer DB2 for OS/390 and DB2 Connect
Enterprise Edition servers” on page 167.

Conventions

This book uses the following highlighting conventions:
v Boldface indicates commands or graphical user interface (GUI) controls

such as names of fields, folders, icons, or menu choices.
v Italics indicates variables that you should replace with your own value. It is

also used to indicate book titles and to emphasize words.
v Monospace indicates file names, directory paths, and examples of text you

enter exactly as shown.

This icon marks a fast path. A fast path guides you to information
specific to your configuration where multiple options are available.

This icon marks a tip. It provides additional information that can help
you complete a task.

For a complete description of the DB2 library, see “Appendix B. How the DB2
Library Is Structured” on page 151.
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v If you do not follow the documented installation method with the
recommended defaults, it may be necessary to refer to the
Administration Guide and the Command Reference to complete the
installation and configuration.

v The term Windows 32-bit operating systems refers to Windows 95,
Windows 98, or Windows NT.

v The term Windows 9x refers to Windows 95 or Windows 98.

v The term DB2 client refers to a DB2 Run-Time Client or a DB2
Administration Client.

v The term DB2 Universal Database refers to DB2 Universal Database
on OS/2, UNIX, and Windows 32-bit operating systems, unless
otherwise stated.
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Part 1. Introduction to DB2 Connect for OS/2 and
Windows NT
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Chapter 1. About DB2 Connect
DB2 Connect Enterprise Edition

DB2 Connect Enterprise Edition is a connectivity server that
concentrates and manages connections from multiple desktop clients
and web applications to DB2 database servers running on host or
AS/400 systems. IBM’s DB2 for AS/400, DB2 for OS/390, and DB2 for
VSE & VM databases continue to be the systems of choice for
managing most critical data for the world’s largest organizations.
While these host and AS/400 databases manage the data, there is a
great demand to integrate this data with applications running on
Windows, UNIX, OS/2 and Apple workstations.

DB2 Connect Enterprise Edition enables local and remote client
applications to create, update, control, and manage DB2 databases and
host systems using Structured Query Language (SQL), DB2 APIs
(Application Programming Interfaces), ODBC (Open Database
Connectivity), JDBC (Java Database Connectivity), SQLJ (Embedded
SQLJ for Java), or DB2 CLI (Call Level Interface). In addition, DB2
Connect supports Microsoft Windows data interfaces such as ActiveX
Data Objects (ADO), Remote Data Objects (RDO), and OLE DB.

DB2 Connect Enterprise Edition is currently available for AIX, HP-UX,
Linux, OS/2, Solaris, and Windows NT operating systems. These
servers provide support for applications running on Windows 3.1,
Windows 9x, Windows NT, UNIX (AIX, SCO UnixWare 7, Solaris,
HP-UX, Linux, Silicon Graphics IRIX, SINIX), OS/2, and Apple
Macintosh workstations.

DB2 Connect Personal Edition

DB2 Connect Personal Edition provides access from a single
workstation to DB2 databases residing on servers such as MVS/ESA,
OS/390, OS/400, VM and VSE, as well as to DB2 Universal Database
servers on Windows NT, UNIX, and OS/2. DB2 Connect Personal
Edition provides the same rich set of APIs as DB2 Connect Enterprise
Edition, and also features integrated SNA support on all Windows
platforms.

This product is currently available for OS/2, Linux, Windows 9x, and
Windows NT operating systems.

© Copyright IBM Corp. 1993, 1999 3



Working with DB2 Data

As well as providing a relational database to store your data, DB2 lets you
issue requests to administer, query, update, insert, or delete data using local or
remote client applications.

Accessing DB2 Data from Remote Clients

DB2 clients provide a run-time environment that enables client applications to
access one or more remote databases. With a DB2 Administration Client, you
can remotely administer DB2 or DB2 Connect servers. Local applications, and
all Java applications (either local or remote), access a database through a DB2
client. All remote applications that are not Java applets must have a DB2
client installed on the client machine before they can access the remote
database.

DB2 Version 6 clients are supported on:
v Windows 9x or Windows NT
v UNIX (AIX, HP-UX, Linux, SGI IRIX, and Solaris)
v OS/2

DB2 clients for the following releases and platforms are available for
download from the web:

v DB2 Version 1.2 for DOS

v DB2 Version 2.1 for Macintosh

v DB2 Version 2.1 for SCO Open Server

v DB2 Version 5.2 for SCO UnixWare 7

v DB2 Version 2.1 for SINIX

v DB2 Version 5.2 for Windows 3.1

To obtain these clients, connect to the IBM DB2 clients web site at
http://www.software.ibm.com/data/db2/db2tech/clientpak.html

Accessing Host or AS/400 DB2 Data from the Desktop Using DB2 Connect
Enterprise Edition

A DB2 Connect server enables DB2 clients on a LAN access to data that is
stored on host or AS/400 systems.

DB2 Universal Database Enterprise Edition and DB2 Universal
Database Enterprise - Extended Edition include the DB2 Connect
Server Support component. All references to DB2 Connect Enterprise
Edition also apply to the DB2 Connect Server Support component.

DB2 Connect Enterprise Edition is most appropriate for environments where:
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v Host and AS/400 database servers do not support native TCP/IP
connectivity and direct connectivity from desktop workstations via SNA is
not desirable (see Figure 1 on page 7).

v Application is implemented using data-aware Java applets (see Figure 5 on
page 12).

v Web servers are used to implement web-based applications (see Figure 6 on
page 14, Figure 5 on page 12 and Figure 4 on page 10).

v Middle-tier application server is employed.
v Transaction monitor such as CICS, Encina, Microsoft Transaction Server

(MTS), Tuxedo, Component Broker, and MQSeries are used (see Figure 2 on
page 8).

Applications are provided with transparent access to host or AS/400 data
through a standard architecture for managing distributed data. This standard
is known as Distributed Relational Database Architecture (DRDA). Use of
DRDA allows your applications to establish a fast connection to host and
AS/400 databases without expensive host components or proprietary
gateways.

A great deal of the data in many large organizations is managed by DB2 for
AS/400, DB2 for MVS/ESA, DB2 for OS/390, or DB2 for VSE & VM.
Applications that run on any of the supported platforms can work with this
data transparently, as if a local database server managed it. DB2 Connect
Enterprise Edition is required for supporting applications which access host or
AS/400 data and exploit transaction monitors (for example, CICS, Encina,
Microsoft Transaction Server) as well as applications that are implemented as
Java applets. In addition, you can use a wide range of off-the-shelf or
custom-developed database applications with DB2 Connect and its associated
tools. For example, you can use DB2 Connect products with:

v Spreadsheets, such as Lotus 1-2-3 and Microsoft Excel, to analyze real-time
data without having the cost and complexity of data extract and import
procedures.

v Decision support tools, such as Business Objects, Brio and Cognos, and
Crystal Reports, to provide real-time information.

v Database products, such as Lotus Approach and Microsoft Access.
v Development tools, such as PowerSoft PowerBuilder, Microsoft Visual Basic,

and Borland Delphi, to create client/server solutions.

Although DB2 Connect is often installed on an intermediate server machine to
connect DB2 clients to a host or AS/400 database, it is also installed on
machines where multiple local users want to access the host or AS/400
servers directly. For example, DB2 Connect may be installed on a large
machine with many local users. It may also be installed on a Web server,

Chapter 1. About DB2 Connect 5



Transaction Processor (TP) monitor, or other 3-tier application server machines
with multiple local SQL application processes and threads. In these cases, you
can choose to install DB2 Connect on the same machine for simplicity, or on a
separate machine to off-load CPU cycles.

A DB2 Connect server enables multiple clients to connect to host or AS/400
data and can significantly reduce the effort that is required to establish and
maintain access to enterprise data. Figure 1 on page 7 illustrates IBM’s
solution for environments in which you want to use a DB2 client making an
indirect connection to a host or AS/400 database server through DB2 Connect
Enterprise Edition.

In the example, you could replace the DB2 Connect server with a
DB2 server that has the DB2 Connect Server Support component
installed.
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Accessing DB2 Data from the Web Using Java

Java Database Connectivity (JDBC) and Embedded SQL for Java (SQLJ) are
provided with DB2 to allow you to create applications that access data in DB2
databases from the Web.

Programming languages containing embedded SQL are called host languages.
Java differs from the traditional host languages C, COBOL, and FORTRAN, in
ways that significantly affect how it embeds SQL:
v SQLJ and JDBC are open standards, enabling you to easily port SQLJ or

JDBC applications from other standards-compliant database systems to DB2
Universal Database.

v All Java types representing composite data, and data of varying sizes, have
a distinguished value, null, which can be used to represent the SQL NULL
state, giving Java programs an alternative to NULL indicators that are a
fixture of other host languages.

v Java is designed to support programs that, by nature, are heterogeneously
portable (also called ″super portable″ or simply ″downloadable″). Along
with Java’s type system of classes and interfaces, this feature enables
component software. In particular, an SQLJ translator written in Java can
call components that are specialized by database vendors in order to
leverage existing database functions such as authorization, schema
checking, type checking, transactional, and recovery capabilities, and to
generate code optimized for specific databases.

v Java is designed for binary portability in heterogeneous networks, which
promises to enable binary portability for database applications that use
static SQL.

v You can run JDBC applets inside a web page on any system with a
Java-enabled browser, regardless of the platform of your client. Your client
system requires no additional software beyond this browser. The client and
the server share the processing of JDBC and SQLJ applets and applications.

The JDBC server and the DB2 client must reside on the same machine as the
Web server. The JDBC server calls the DB2 client to connect to local, remote,
host, and AS/400 databases. When the applet requests a connection to a DB2
database, the JDBC client opens a TCP/IP connection to the JDBC server on
the machine where the Web server is running.
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JDBC and SQLJ applications can be run from any system that has a DB2 client
installed; a Web browser and a Web server are not required.
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. . .
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SDLC  Token-ring  X.25

*** TCP/IP connectivity requires DB2 for OS/390 V5R1, DB2 for AS/400 V4R2,
or DB2 for VM V6.1

** For AS/400
* For Host connections only

ESCON

Web
Server

JDBC driver

Figure 5. Using Java Applets.

12 Quick Beginnings for OS/2 and Windows NT



For more information on Java enablement, refer to the DB2 Java Enablement
web page at http://www.software.ibm.com/data/db2/java/. For more
information on the JDBC API, point your browser to
http://splash.javasoft.com/.

Accessing DB2 Data from the Web Using Net.Data

Net.Data is provided with DB2 to allow you to create applications that access
data in DB2 databases from the Web.

Use Net.Data to create applications that are stored on a Web server and
viewable from any Web browser. While viewing these documents, users can
either select automated queries or define new ones that retrieve the specified
information directly from a DB2 database.

Automated queries do not require user input; they are links in an HTML
document and, when selected, they trigger existing SQL queries and return
the results from a DB2 database. These links can be triggered repeatedly to
access current DB2 data. Customized queries require user input. Users define
the search characteristics on the Web page by selecting options from a list or
by entering values in fields. They submit the search by clicking on a push
button. Net.Data uses the information that is supplied by the user to
dynamically build a complete SQL statement, and it sends the query to the
DB2 database.

A demonstration of Net.Data applications is available from the IBM Software
Net.Datapage at http://www.software.ibm.com/data/net.data.

Net.Data can be installed with a DB2 server to allow local access to databases.
Net.Datacan be installed with a DB2 client to allow remote access to
databases. In both cases, Net.Data and the Web server must be installed on
the same system.
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Figure 6. Net.Data with DB2 Connect.
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Administering Instances and Databases with the DB2 Administration Tools

You can administer local or remote servers using the DB2 Administration
Tools. Use the Control Center to perform administration tasks such as
configuring DB2 instances and databases, backing up and recovering data,
scheduling jobs, and managing media, all from a graphical interface.

The Control Center for Version 6 has additional support for DB2 UDB for
OS/390.

Note: This option is only available on DB2 Enterprise Edition, DB2 Enterprise
- Extended Edition, DB2 Connect Personal Edition, and DB2 Connect
Enterprise Edition.

If you want to access DB2 for OS/390 functions from the Control Center:
1. Verify the following information with your systems administrator:

a. You have a DB2 for OS/390 license (Version 5 or later).
b. You are using DB2 Connect Enterprise Edition.

2. Apply a function modification identifier. Read the DB2 for OS/390
Program Directory. The program directory identifies and describes the
contents of FMIDs for each tape or cartridge.

3. Apply any additional service to DB2 as described in the program directory.
4. Ensure that you enabled the stored procedures address space.

Managing Communications on the Server

The Control Center allows you to view, update, and reset server protocol
settings. These functions are accessed by clicking with the right mouse button
on an instance and selecting the Setup communications option from the
pop-up menu. This tool helps database administrators to:
v Configure communication parameters in the database manager by clicking

with the right mouse button on an instance and selecting the Configure
option from the pop-up menu.

By default, the setup program automatically detects and configures
most communication protocols that it detects on your system.

v Export database information in a profile that can be used to configure
clients by clicking with the right mouse button on a system and selecting
the Export option from the pop-up menu.

For information on how to configure server communications, refer to the
Installation and Configuration Supplement.
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Monitoring Databases Using DB2 Performance Monitor

With the DB2 Performance Monitor, you can:
v Identify and analyze performance problems in database applications or the

database manager.
v Use the early warning system to detect potential problems.
v Automate actions to correct problems that are discovered.
v Define your own statistics, in addition to the default set that is provided.

You can choose to monitor the current state of database activity or collect
information when specific events occur. The Performance Monitor allows you
to capture point-in-time information at specified intervals. The Event Analyzer
allows you to view information about the occurrence of events such as
deadlocks and transaction completions.

For additional information, refer to the Administration Guide or the online help.

You are also able to use the Windows NT Performance Monitor to
monitor both database and system performance. For information on
how to register DB2 resources and to use the Windows NT
Performance Monitor, refer to the Administration Guide.

Viewing SQL Access Plans Using Visual Explain

Visual Explain helps database administrators and application developers to:
v View the access plan chosen by the database manager’s optimizer for a

given SQL statement.
v Tune SQL statements for better performance.
v Design application programs and databases.
v View all the details of an access plan, including the statistics in the system

catalogs.
v Decide whether or not to add an index to a table.
v Identify the source of problems by analyzing the access plan or

performance of SQL statements.
v Use the portable snapshot function to view snapshots from any remote DB2

server.
v Display access plans for queries on all supported DB2 configurations.

For additional information, refer to the Administration Guide or the online help.

Note: You cannot use Visual Explain to administer host databases.
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Managing Connections to Databases Using the Client Configuration Assistant

The Client Configuration Assistant (CCA) helps you manage your database
connections to remote servers. The CCA is available on OS/2 and Windows
32-bit operating systems. This is the preferred method to set up any OS/2,
Windows 9x, or Windows NT client to communicate with a server.

With the Client Configuration Assistant, you can:
v Catalog databases so that they can be used by applications. Three methods

are available:
– Search the network for available databases and selecting one. Client

access is automatically set up for that database.
– Use a database access profile provided by a database administrator to

automatically define your connections. Client access is automatically set
up for that database.

– Manually configure a connection to a database by entering the required
connection parameters.

v Remove cataloged databases, or change the properties of a cataloged
database.

v Test connections to local or remote databases identified on your system.
v Bind applications to a database by selecting utilities or bind files from a list.
v Tune the client configuration parameters on your system. Parameters are

logically grouped and suggested settings are provided on the interface as
parameters are selected.

Understanding the Administration Server

The Administration Server responds to requests from the DB2 Administration
Tools and the Client Configuration Assistant (CCA). The DB2 Administration
Tools allow you to start, stop, and set database manager configuration
parameters for servers. These tools are also used by the CCA to catalog
databases for a client.

The Administration Server must reside on every server that you want to
administer and detect. The Administration Server is automatically created and
started for you; its default name is DB2DAS00.
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Developing Applications Using the DB2 Software Developer’s Kit

The DB2 Software Developer’s Kit is a collection of tools that are designed to
meet the needs of database application developers. It includes libraries,
header files, documented APIs, and sample programs to build character-based,
multimedia, or object-oriented applications.

A platform-specific version of the DB2 Software Developer’s Kit is available
for each of the supported operating systems and is currently available in the
DB2 Universal Developer’s Edition and the DB2 Personal Developer’s Edition.
Applications that are developed with the DB2 Software Developer’s Kit will
run on any platform where the equivalent DB2 client component is installed.
Through a DB2 client, these applications can access all servers and, by using
the DB2 Connect product (or the DB2 Connect functionality supplied with
DB2 Enterprise - Extended or DB2 Enterprise Edition), they can also access
DB2 Universal Database for AS/400, DB2 Universal Database for OS/390, and
DB2 for VSE & VM database servers.

The DB2 Software Developer’s Kit allows you to develop applications that use
the following interfaces:
v Embedded SQL
v Call Level Interface (CLI) development environment (which is compatible

with ODBC from Microsoft)
v Java Database Connectivity (JDBC)
v Embedded SQL for Java (SQLJ)
v DB2 Application Programming Interfaces (APIs) that use administrative

functions to manage a DB2 database.

The DB2 Software Developer’s Kit includes:
v Precompilers for Java, C, C++, COBOL, and FORTRAN.
v Libraries, include files, and code samples to develop applications that use

SQLJ and DB2 CLI.
v JDBC and SQLJ support to develop Java applications and applets.
v Interactive SQL, through the CLP, to prototype SQL statements and perform

ad-hoc database queries.
v An API to enable other application development tools to implement

precompiler support for DB2 directly with their products.
v An SQL92 and MVS Conformance Flagger to identify embedded SQL

statements in applications not conforming to the ISO/ANSO SQL92 Entry
Level standard, or which are not supported by DB2 for OS/390.
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For complete information on the functionality of the Software Developer’s Kit,
and instructions on how to use them, as well as a full list of supported
compilers for your platform, refer to the Application Building Guide.

Running Your Own Applications

Various types of applications can access DB2 databases:
v Applications developed using a DB2 Software Developer’s Kit that include

embedded SQL (including Java SQLJ applications and applets), APIs, stored
procedures, user-defined functions, calls to DB2 CLI, or calls to JDBC
applications and applets.

v ODBC applications such as Lotus Approach, Microsoft Visual Basic,
PowerSoft PowerBuilder, Borland Delphi and thousands more.

v Net.Data macros containing HTML and SQL.

The DB2 CLI/ODBC driver is an optional component during a DB2 client
install. It is required to run CLI, ODBC, JDBC, and some SQLJ applications.

For more information on running your own applications, refer to the
Installation and Configuration Supplement.
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Part 2. DB2 Connect Installation
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Chapter 2. Planning for Installation
If you know that your system meets all the hardware and software
requirements, and you want to begin installing your DB2 product right
away, go to “Chapter 4. Installing DB2 Connect on Windows NT” on
page 35 or “Chapter 5. Installing DB2 Connect on OS/2” on page 41.

For information on the DB2 family of products, see “Chapter 1. About
DB2 Connect” on page 3.

There are many components that you might want to use in your environment.
Use the product and planning information in this section to ensure that your
system meets the prerequisites and to decide which components you want to
install.

Before you begin your DB2 product installation, you should determine the
requirements for the system that you are planning to install and configure.

Memory Requirements

This section shows the suggested amount of memory that is required to run a
DB2 product. The memory requirements listed here are estimates; the actual
amounts required depend on the functions you are using. Use this
information to plan for systems with a large number of concurrent clients or
databases.

DB2 Connect Requirements

The amount of memory that you require depends on the applications you
intend to run. We suggest that you have a minimum of 32 MB of memory to
access host or AS/400 databases using DB2 Connect Enterprise Edition.
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Complete the provided worksheet in Table 1 and calculate the approximate
values for memory that your system will require.

Table 1. Memory Requirements for DB2 Connect

Number of Clients Connecting to a Server

___ 5 Concurrent Connections 64 MB

___ 10 Concurrent Connections 80 MB

___ 25 Concurrent Connections 96 MB

___ 50 Concurrent Connections 186 MB

___ DB2 Administration Tools 30 MB

Total Memory Requirements __ MB

DB2 Client Requirements

The amount of memory you require to run a DB2 Run-Time Client is
approximately 16 MB. If you are planning to run a DB2 Administration Client,
your client workstation should have approximately 32 MB of available
memory.

Disk Requirements

This section shows the minimum amount of disk space that is required to
install your DB2 product and components. It does not include the disk
requirements necessary for the operating system, application development
tools, and communications products. Consult each product’s documentation
for these values. Estimates for disk space requirements are listed here; the
actual amounts required depend on the functions you are using.

For information about space requirements for data, refer to the Administration
Guide.

Estimating Fixed Disk Requirements

To estimate the disk requirements for a particular configuration, add the
recommended minimum disk sizes for the products and components that you
want to install. Include an allowance for your application data.

Server Components

Use Table 2 on page 25 to estimate the amount of disk space you need to
install DB2 and associated components on your operating system.
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Table 2. Estimating Disk Requirements
Recommended

Minimum Disk (MB)

DB2 Connect for OS/2

DB2 Connect Enterprise Edition 55 MB
DB2 GUI Tools 60 MB
DB2 Connect Support (this is not available with DB2
Workgroup Edition)

1 MB

Online documentation in HTML format (English) 31 MB
Far-East Code Page Conversion Support 5 MB

Total Disk Space Required __ MB

DB2 Connect for Windows NT

DB2 Connect Enterprise Edition for Windows NT 77 MB
DB2 GUI Tools 68 MB
Online documentation in HTML format (English) 31 MB
Far-East Code Page Conversion Support 5 MB

Total Disk Space Required __ MB

Client Components

Use Table 3 to estimate the amount of disk space you need on each of your
client workstations.

If you are planning to use a DB2 client that is not listed in this table, but
is supported by DB2, refer to the Installation and Configuration Supplement
for more information.

If you are installing the Control Center or the online documentation
on a Windows NT FAT or a Windows 9x FAT16 disk partition, you
may require additional amounts of disk space.

Table 3. Disk Requirements for Client Components

Recommended Minimum Disk (MB)

OS/2

DB2 Run-Time Client (Base) 11 MB

- Client Configuration Assistant 6 MB

or

DB2 Administration Client (Base) 11 MB

- DB2 Administration Tools 68 MB

- Client Configuration Assistant 6 MB

Total Disk Space Required __ MB
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Table 3. Disk Requirements for Client Components (continued)

Recommended Minimum Disk (MB)

Windows 32-bit Operating Systems

DB2 Run-Time Client (Base) 11 MB

- Client Configuration Assistant 6 MB

or

DB2 Administration Client (Base) 11 MB

- DB2 Administration Tools 68 MB

- Client Configuration Assistant 6 MB

Total Disk Space Required __ MB

Software Requirements

DB2 Connect Enterprise Edition products use communication software for
establishing host connectivity and connectivity to DB2 Universal Database
servers. In addition, DB2 Connect Enterprise Edition requires connectivity
software to support connections from remote client workstations.

For the host connectivity, software requirements will depend on:
v The protocol that you will be using, that is, SNA (APPC), TCP/IP, or MPTN

(APPC over TCP/IP or vice versa)
v Whether you will be using direct connection.

Server Product Requirements

Table 4 on page 27 lists the operating system and communications software
required for DB2 Connect.
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Table 4. Software Requirements
Product Hardware/Software

Requirements
Communications

OS/2

v DB2 Connect Enterprise
Edition

v OS/2 Warp Version 3 and
Version 4

v OS/2 Warp Connect Version 3

v OS/2 Warp Server Version 4

v OS/2 Warp Server Advanced
V4

v OS/2 Warp Server Advanced
V4 with SMP Feature

v OS/2 Warp Server for
e-business

Versions of OS/2 with built-in
communications capabilities
such as OS/2 Warp Connect,
Warp Server, Warp Server
Advanced, and OS/2 Warp
Version 4 are recommended.

Notes:

1. If you plan to install DB2
Connect using TME 10
SystemView, you must have
TME 10 SystemView LAN
Client provided by the OS/2
Warp Server.

2. The DB2 SNMP subagent
requires DPI 2.0 support
provided by the OS/2 Warp
Server installed. If you plan
to use DB2 SNMP subagent
for system management, you
will have to use OS/2 Warp
Server.

APPC, IPX/SPX, NetBIOS, or TCP/IP

v For local IPX/SPX connectivity, you require Novell NetWare
Requester, Version 2.10 or later.

v Named Pipes is supported locally in WIN-OS/2 sessions on OS/2
Warp Server.

v For local NetBIOS connectivity, you require IBM NTS/2 Version 1.0,
or IBM Communications Manager Version 1.x or later, or IBM OS/2
LAN Requester.

v For TCP/IP connectivity, you require IBM TCP/IP Version 3.0 or
later for OS/2 Warp Versions 3 and 4, and for OS/2 Warp Connect
Version 3. The OS/2 Warp Server Version 4 base operating system
provides TCP/IP connectivity, if selected during installation.

v For SNA (APPC) connectivity, one of the following communications
products is required:

– IBM eNetwork Communications Server for OS/2 Warp Version 5

– IBM eNetwork Personal Communications for OS/2 Warp
Version 4.2

– IBM Communication Server for OS/2 Version 4

Notes:

1. If you plan to use DCE (Distributed Computing Environment)
Security for authenticating users that connect to host databases,
you do not have to install DCE products on your DB2 Connect
workstation. However, you will have to:

v Ensure that you are connecting to DB2 for OS/390 V5.1
database that is enabled for DCE support using OS/390 DCE
Base Services Version 3 if you wish to use DB2 Connect. You
must install DCE Directory Services on both the client and the
DRDA Server, but you do not need DCE installed on the DB2
Connect Enterprise Edition server.

v Ensure that client workstations, using DCE security, have a DCE
product that is at OSF DCE Level 1.1 with the IBM Directory
and Security Server for OS/2 Warp Version 4.

2. If you plan to use two-phase commit with DB2 Connect and
DRDA host systems, you must install the Syncpoint Manager
(SPM) function and its prerequisites.

3. The DB2 SNMP Subagent requires DPI 2.0 support provided by
the OS/2 Warp Server.

4. Installing clients and servers using TME 10 Netfinity requires
TME 10 Netfinity LAN Client provided by the OS/2 Warp Server.
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Table 4. Software Requirements (continued)
Product Hardware/Software

Requirements
Communications

Windows 32-bit Operating Systems

v DB2 Connect Enterprise
Edition (Windows NT
only)

v Windows NT Version 4.0 with
Service Pack 3, or later

APPC, TCP/IP, and MPTN (APPC over TCP/IP)

v The Windows NT base operating system provides NetBIOS,
IPX/SPX, Named Pipes, and TCP/IP connectivity.

For SNA (APPC) connectivity, one of the following communication
products is required:

v IBM Communications Server for Windows NT Version 5.01 or later

v IBM Personal Communications for Windows NT Version 4.1 or
later

v Microsoft SNA Server Version 4 Service Pack 2 or later

Notes:

1. If SNA two-phase commit is necessary, then IBM Communications
Server for Windows NT Version 5.01 or later is required.

2. If you plan to use DCE (Distributed Computing Environment)
with Version 6 of DB2 Universal Database, you will need:

v A DCE product that is at OSF DCE level 1.1 with IBM DCE for
Windows NT Version 2.0.

v To ensure that if you are connecting to DB2 for OS/390 V5.1
database that it is enabled for DCE support using OS/390 DCE
Base Services Version 3.

In addition, DB2 also supports Gradient PC-DCE for Windows
32-bit operating systems Version 2.0 Runtime Media Kit. For DB2
Connect support, you require DB2/MVS Version 5.1 plus its
prerequisite, OS/390 DCE Base Services version 3 for DCE
support.
Note: With DB2 Connect, you must install DCE Directory Services
on the client and the DRDA server. You do not need DCE installed
on a DB2 Connect Enterprise Edition server.

3. If you plan to use LDAP (Lightweight Directory Access Protocol),
you require the IBM eNetwork LDAP Directory Client Version 3.1.
For more information, refer to the Administration Guide.

4. If you plan to use the ADSTAR Distributed Storage Manager
(ADSM) facilities for backup and restore of your databases, you
require the ADSM Client Version 3 or later.

5. If you have the IBM Antivirus program installed on your
operating system, it must be Version 3.0 or later.

6. If you plan to use the Simple Network Management Protocol
(SNMP) subagent, you require DPI 2.0 provided by IBM Netfinity
Agent.

Client Product Requirements

Table 5 on page 29 lists the software requirements needed for a DB2
Administration Client, DB2 Run-Time Client, or a DB2 Software Developer’s
Kit.
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Table 5. Software Requirements for Clients

Component Hardware/Software
Requirements

Communications

v DB2 Run-Time Client
for OS/2

v DB2 Administration
Client for OS/2

v DB2 Software
Developer’s Kit for
OS/2

v OS/2 Warp Version 3 and
Version 4

v OS/2 Warp Connect
Version 3

v OS/2 Warp Server Version
4

v OS/2 Warp Server
Advanced V4

v OS/2 Warp Server
Advanced V4 with SMP
Feature

v OS/2 Warp Server for
e-business

APPC, IPX/SPX, NetBIOS, or TCP/IP

v For APPC connectivity, you require IBM eNetwork
Communications Server for OS/2 Warp Version 5 or IBM
eNetwork Personal Communications for OS/2 Warp
Version 4.2.

v For IPX/SPX connectivity, you require the Novell NetWare
client for OS/2 Version 2.10 or later. IPX/SPX can only be
used to connect to local databases. It cannot be used to
connect to host or AS/400 databases.

v For NetBIOS connectivity, you require IBM NTS/2 Version
1.0, IBM eNetwork Communications Server for OS/2 Warp
Version 5, IBM eNetwork Personal Communications for
OS/2 Warp Version 4.2, or IBM OS/2 LAN Requester.
NetBIOS can only be used to connect to local databases. It
cannot be used to connect to host or AS/400 databases.

v For TCP/IP connectivity, you require IBM TCP/IP Version
2.0 or later.

v The OS/2 base operating system provides Named Pipes
(Local) connectivity. Named Pipes is supported in DOS
and WIN-OS/2 sessions.

Notes:

1. Net.Data requires OS/2 Warp Version 3 or later and a
Web server such as IBM’s Internet Connection Server.

2. For DCE Cell Directory Services Support (CDS) for DB2
Clients for OS/2, you must install IBM Distributed
Computing Environment Cell Directory Service client,
Version 2.10, on each client workstation.

3. If you are planning to use ADSM, PTF 3 for ADSTAR
Distributed Storage Manager (ADSM) Version 3 is
required for an OS/2 client.

v DB2 Run-Time Client
for Windows 9x

v DB2 Administration
Client for Windows
9x

v DB2 Software
Developer’s Kit for
Windows 9x

v Windows 95 4.00.950 or
later

v Windows 98

IPX/SPX, Named Pipes, NetBIOS, or TCP/IP

v The Windows 9x base operating system provides NetBIOS,
IPX/SPX, TCP/IP, and Named Pipes connectivity.
Note: IPX/SPX connectivity is only supported to
Windows NT servers.

v If you plan to use LDAP (Lightweight Directory Access
Protocol), you require the IBM eNetwork LDAP Directory
Client Version 3.1. For more information, refer to the
Administration Guide.
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Table 5. Software Requirements for Clients (continued)

Component Hardware/Software
Requirements

Communications

v DB2 Run-Time Client
for Windows NT

v DB2 Administration
Client for Windows
NT

v DB2 Software
Developer’s Kit for
Windows NT

v Windows NT Version 4.0
with Service Pack 3 or
later

v Windows Terminal Server
(can only run the DB2
Run-Time Client)

APPC, IPX/SPX, Named Pipes, NetBIOS, or TCP/IP

v The Windows NT base operating system provides
NetBIOS, IPX/SPX, TCP/IP, and Named Pipes
connectivity.

v For APPC connectivity, you require one of the following
products:

– IBM eNetwork Communications Server for Windows
NT V5.01 or later.

– IBM eNetwork Personal Communications for Windows
NT V4.2 or later.

– Microsoft SNA Server Version 4 Service Pack 2 or later

– Wall Data Rumba

If you plan to use DCE (Distributed Computing
Environment) with Version 6 of DB2 Universal Database,
you will need to ensure that if you are connecting to DB2
for OS/390 V5.1 database that it is enabled for DCE
support using OS/390 DCE Base Services Version 3.

v If you plan to use LDAP (Lightweight Directory Access
Protocol), you require the IBM eNetwork LDAP Directory
Client Version 3.1. For more information, refer to the
Administration Guide.

v If you plan to use the ADSTAR Distributed Storage
Manager (ADSM) facilities for backup and restore of your
databases, you require the ADSM Client Version 3 or later.

v If you have the IBM Antivirus program installed on your
operating system, it must be Version 3.0 or later.

Possible Client-to-Server Connectivity Scenarios

The following table shows the communication protocols that can be used
when connecting a specific LAN, host or AS/400 DB2 client to a specific DB2
server or DB2 Connect server.

DB2 Workgroup, DB2 Enterprise, and DB2 Enterprise - Extended
Editions can service requests from host or AS/400 clients (DRDA
ARs).

Table 6. Possible Client-to-Server Connectivity Scenarios

Client
Server

AIX HP-UX Linux OS/2 Solaris Windows NT

AS/400 V4R1 SNA N/A N/A SNA SNA SNA

AS/400 V4R2 SNA
TCP/IP

TCP/IP TCP/IP SNA
TCP/IP

SNA
TCP/IP

SNA
TCP/IP

AIX APPC
TCP/IP

TCP/IP TCP/IP APPC
TCP/IP

APPC
TCP/IP

APPC
TCP/IP
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Table 6. Possible Client-to-Server Connectivity Scenarios (continued)

Client
Server

AIX HP-UX Linux OS/2 Solaris Windows NT

HP-UX APPC
TCP/IP

TCP/IP TCP/IP APPC
TCP/IP

APPC
TCP/IP

APPC
TCP/IP

Linux TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP

MVS SNA N/A N/A SNA SNA SNA

OS/2 APPC
IPX/SPX(1),(2)
TCP/IP

TCP/IP TCP/IP APPC
IPX/SPX(1),(2)
NetBIOS
TCP/IP

APPC
IPX/SPX(1)
TCP/IP

APPC
IPX/SPX(1)
NetBIOS
TCP/IP

OS/390 SNA
TCP/IP

TCP/IP TCP/IP SNA
TCP/IP

SNA
TCP/IP

SNA
TCP/IP

Silicon Graphics
IRIX

TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP TCP/IP

SQL/DS SNA N/A N/A SNA SNA SNA

Solaris APPC
TCP/IP

TCP/IP TCP/IP APPC
TCP/IP

APPC
TCP/IP

APPC
TCP/IP

VSE & VM V6 SNA N/A N/A SNA SNA SNA

VSE V6 SNA N/A N/A SNA SNA SNA

VM V6 SNA
TCP/IP

TCP/IP TCP/IP SNA
TCP/IP

SNA
TCP/IP

SNA
TCP/IP

Windows 9x TCP/IP TCP/IP TCP/IP NetBIOS
TCP/IP

TCP/IP IPX/SPX(1)
NPIPE
NetBIOS
TCP/IP

Windows NT APPC
IPX/SPX(1)
TCP/IP

TCP/IP TCP/IP APPC
IPX/SPX(1)
NetBIOS
TCP/IP

APPC
IPX/SPX(1)
TCP/IP

APPC
IPX/SPX(1)
NPIPE
NetBIOS
TCP/IP

1. Direct Addressing

2. File Server Addressing
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Chapter 3. Security Requirements

Since you will be accessing data managed by other systems, you will require a
user ID and password so that you can be authenticated by the system. To
obtain these, contact the administrator responsible for the system where the
data resides.

In addition, to access the system, you will require authorization to access data
objects on the target database server; for example, tables, views, and program
packages. To obtain the appropriate authorization, contact your database
administrator.

An additional DB2 security mechanism called binding allows database
administrators to limit access to specific applications. This mechanism is used
to build program packages or plans. The database administrator then grants
authority to users to execute these packages.

If you will be running an application developed using embedded SQL, a
package will be supplied with your application. You must bind this package
to each database that the application will access. Package files are usually
supplied with the file type .bnd. ODBC users do not bind individual
applications; instead, they must bind the ODBC driver itself to each database
that will be accessed.

To bind applications or the ODBC driver, you require the following privileges
on each database:

DB2 Universal Database for OS/390 or DB2 for MVS
BINDADD privilege, plus CREATE IN COLLECTION NULLID,
SYSCTRL, or SYSADM authority.

DB2 for VSE & VM
DBA authority

DB2/400
*CHANGE authority or higher on the NULLID collection.

If your database administrator will not grant you these privileges, another
user (usually the administrator) must perform the required binds.
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Chapter 4. Installing DB2 Connect on Windows NT

This section describes how to install DB2 Connect Enterprise Edition on
Windows 32-bit operating systems. If you want to install a DB2 client, go to
“Part 5. Installing and Configuring Clients” on page 105. For information on
how to deploy this product using a distributed installation, refer to the
Installation and Configuration Supplement.

Before You Begin

Before you begin the installation, ensure that you have the following items
and information:
__ 1. Ensure that your system meets all of the memory, hardware, and

software requirements to install your DB2 product. For more
information, see “Chapter 2. Planning for Installation” on page 23.

__ 2. The protocol to be used for host connectivity:
__ a. SNA
__ b. TCP/IP
__ c. MPTN

__ 3. A user account that will be used to perform the installation. The
account you specify must:
v Be defined on the local machine.
v Belong to the Local Administrator’s group.
v Have the Act as part of the operating system advanced user right.

You can perform the installation without the Act as part of the
operating system advanced user right, however, the setup program
will be unable to validate the account that you specify for the
Administration Server. We recommend that any user account used to
install this product have this advanced user right.

For information on how to grant user rights, refer to the Windows NT
online help.

__ 4. During installation, you will provide a user account that will be used
by the Administration Server to log on to the system and to start itself
as a service. The account you specify must:
v Be defined on the local machine.
v Belong to the Local Administrator’s group.
v Have the Act as part of the operating system advanced user right.
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By default, the setup program will create a user account using the
username db2admin and password db2admin. You can accept these
default values, create you own user account by modifying the default
values, or provide you own. If you create or provide you own user
account, ensure that it conforms to DB2’s naming rules. For more
information, see “Appendix F. Naming Rules” on page 177.

If you use the default user account db2admin, and do not change the
default password on the setup screen, you should change this
password immediately following the installation since db2admin is
the default password for any installation and is therefore well
known.

To change the password that is associated with the Administration
Server, entering the following command:

db2admin setid username password

__ 5. To verify that DB2 installed correctly, you will need to have a user
account that belongs to the System Administrative (SYSADM) group, is
8 characters or less, and complies with all of DB2’s naming rules.
By default, any user that belongs to the Local Administrators group, on
the local machine where the account is defined, has SYSADM authority
on the instance. For more information, see “Working with the System
Administrative Group” on page 148. For more information on valid
DB2 usernames, see “Appendix F. Naming Rules” on page 177.

Performing the Installation

To install your DB2 product, perform the following steps:
Step 1. Log on to the system with the user account that you created to

perform the installation.
Step 2. Shut down any other programs so that the setup program can update

files as required.
Step 3. Insert the CD-ROM into the drive. The auto-run feature automatically

starts the setup program. The setup program will determine the
system language, and launch the setup program for that language. If
you want to run the setup program in a different language, or the
setup program failed to auto-start, see the tip that follows.
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To manually invoke the setup program, perform the following steps:

a. Click on Start and select the Run option.

b. In the Open field, enter the following command:

x:\setup /i language

where:

v x: represents your CD-ROM drive

v language represents the country code for your language (for
example, EN for English). Table 12 on page 171 lists the code
for each available language.

c. Click on OK.

Step 4. The Welcome window opens.

Step 5. Respond to the setup program’s prompts. Online help is available to
guide you through the remaining steps. Invoke the online help by
clicking on the Help push button or pressing the F1 key at any time.
You can click on the Cancel push button at any time to end the
installation.

The next step applies only if you are using Microsoft SNA Server for Windows NT as
your communication product. If you are using another communications product, such
as IBM eNetwork Communications Server for Windows NT, skip the next step.
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Step 6. After your workstation has rebooted, check that the network adapter
is bound to the DLC communications subsystem by completing the
following steps:
a. Click on Start and select Settings->Control Panel.
b. Double-click on the Network icon.
c. In the Network window, select the Bindings tab.
d. Select All Adapters from the Show bindings for drop-down box.
e. Double-click on the adapter for which you want to see the

bounded protocols
f. Ensure that DLC is enabled. If it is not, click on the Enable push

button to enable the bind the network adapter to the
communications subsystem.

For information on errors encountered during installation, see the
db2.log file. The db2.log file stores general information and error
messages resulting from the install and uninstall activities. By
default, the db2.log file is located in the x:\db2log directory, where
x: represents the drive on which your operating system is installed.

For more information, refer to the Troubleshooting Guide.

Based on your component selections, the installation program has:
v Created DB2 program groups and items (or shortcuts).
v Created the following services on Windows NT: DB2 Governor, DB2 JDBC

Applet Server, DB2 Security Server.
v Updated the Windows registry.

To set up connections to host or AS/400 database servers, go to one of
the following sections:

v “Chapter 7. Configuring DB2 Connect to Host or AS/400
Communications Using the CCA” on page 65

v “Chapter 8. Configuring APPC Communications on the DB2 Connect
Workstation” on page 75

Software Registration

The Software Registration tool is used to register IBM Software with IBM and
update IBM’s Software Customer Profiles. A customer profile contains
identification and demographic information about the users of each IBM
software product. The software registration tool contains information and
instructions on how to register IBM software by modem, telephone, Internet,
FAX, or postal service. To register your software with IBM, perform the
following steps:
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Step 1. Start the IBM Software Registration tool. For more information, see
“Starting the Software Registration Tool” on page 143.

Step 2. Enter the appropriate information and complete the IBM Software
Registration Smart Guide. Click on the Help push button if you need
assistance.

Upgrading from a Try-and-Buy License

To upgrade from a Try-and-Buy license, perform the following steps:

Step 1. Start the Control Center. For more information, see “Starting
the Control Center” on page 144.

Step 2. Click on the License Center icon from the Control Center
toolbar. The License Center opens.

Step 3. Complete the steps to upgrade your DB2 license. For more
information, refer to the License Center’s online help by
pressing the F1 key.

If you are upgrading your DB2 product to a higher entitlement, you
must ensure that you uninstall your current installation of DB2 and
then reinstall your new licensed product.

For example, if you have a Try-and-Buy version of DB2 Workgroup
Edition installed on your machine, and you purchased a license for
DB2 Enterprise Edition, you must ensure that you remove the
installed copy of DB2 Workgroup Edition and then reinstall DB2
Enterprise Edition.

If you did not install the DB2 tools, you can upgrade your
Try-and-Buy license using the db2licm command. For more
information, refer to the Command Reference.
Note: Your Proof of Entitlement and License Information booklets
identify the products for which you are licensed.

You are now ready to use DB2 Connect Enterprise Edition.
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Chapter 5. Installing DB2 Connect on OS/2

This section describes how to install DB2 Connect Enterprise Edition on an
OS/2 workstation. For information on how to deploy this product using a
distributed installation, refer to the Installation and Configuration Supplement.

Before You Begin

Before you begin the installation, be sure that you have the following items
and information:
__ 1. Ensure that your system meets all of the memory, hardware, and

software requirements to install your DB2 product. For more
information, see “Chapter 2. Planning for Installation” on page 23.

__ 2. The protocol to be used for host connectivity:
__ a. SNA
__ b. TCP/IP
__ c. MPTN

__ 3. A user ID to perform the installation.
If UPM is installed, the user ID you specify must have Administrator or
Local Administrator authority. Create a user ID with these characteristics
if necessary.
If UPM is not installed, DB2 will install it and set up the userid USERID
with password PASSWORD.

__ 4. A user ID for the Administration Server.
If UPM is installed, the user ID you specify must have Administrator or
Local Administrator authority. Create a userid with these characteristics if
necessary.
If UPM is not installed, DB2 will install it and the userid specified for
the Administration Server will be created.

__ 5. To verify that DB2 installed correctly, you will need to have a user
account that belongs to the System Administrative (SYSADM) group, is
8 characters or less, and complies with all of DB2’s naming rules.
By default, any user that belongs to the Local Administrators group, on
the local machine where the account is defined, has SYSADM authority
on the instance. For more information, see “Working with the System
Administrative Group” on page 148. For more information on valid
DB2 usernames, see “Appendix F. Naming Rules” on page 177.
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Performing the Installation

To install your DB2 product, perform the following steps:
Step 1. Log on to the system with the user ID that you created to perform

the installation.
Step 2. Insert the CD-ROM in the drive.
Step 3. Open an OS/2 command window and set the directory to your

CD-ROM drive by entering the following command:
cd x:

where x: represents your CD-ROM drive.
Step 4. Enter the following command:

x:\install

where x: represents your CD-ROM drive.

To manually invoke the installation program, enter the following
command:

x:\install /i language

where x: represents your CD-ROM drive and language represents the
country code for your language.

Step 5. The Welcome window opens.

Step 6. Respond to the install program’s prompts. Online help is available to
guide you through the remaining steps. Invoke online help by

42 Quick Beginnings for OS/2 and Windows NT



clicking on the Help push button or the F1 key at any time. You can
click on the Cancel push button at any time to end the installation.

For information on errors encountered during installation, see the
l1.log and l2.log files. These files store general information and
error messages resulting from installation and uninstall activities. By
default, these files are located in the x:\db2log directory; where x:
represents the drive on which your operating system is installed.

For more information, refer to the Troubleshooting Guide.

To set up connections to host or AS/400 database servers, go to one of
the following sections:

v “Chapter 7. Configuring DB2 Connect to Host or AS/400
Communications Using the CCA” on page 65

v “Chapter 8. Configuring APPC Communications on the DB2 Connect
Workstation” on page 75

Software Registration

The Software Registration tool is used to register IBM Software with IBM and
update IBM’s Software Customer Profiles. A customer profile contains
identification and demographic information about the users of each IBM
software product. The software registration tool contains information and
instructions on how to register IBM software by modem, telephone, Internet,
FAX, or postal service. To register your software with IBM, perform the
following steps:
Step 1. Start the IBM Software Registration tool. For more information, see

“Starting the Software Registration Tool” on page 143.

Step 2. Enter the appropriate information and complete the IBM Software
Registration Smart Guide. Click on the Help push button if you need
assistance.
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Upgrading from a Try-and-Buy License

To upgrade from a Try-and-Buy license, perform the following steps:

Step 1. Start the Control Center. For more information, see “Starting
the Control Center” on page 144.

Step 2. Click on the License Center icon from the Control Center
toolbar. The License Center opens.

Step 3. Complete the steps to upgrade your DB2 license. For more
information, refer to the License Center’s online help by
pressing the F1 key.

If you are upgrading your DB2 product to a higher entitlement, you
must ensure that you uninstall your current installation of DB2 and
then reinstall your new licensed product.

For example, if you have a Try-and-Buy version of DB2 Workgroup
Edition installed on your machine, and you purchased a license for
DB2 Enterprise Edition, you must ensure that you remove the
installed copy of DB2 Workgroup Edition and then reinstall DB2
Enterprise Edition.

If you did not install the DB2 tools, you can upgrade your
Try-and-Buy license using the db2licm command. For more
information, refer to the Command Reference.
Note: Your Proof of Entitlement and License Information booklets
identify the products for which you are licensed.

You are now ready to use DB2 Connect Enterprise Edition.
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Part 3. Preparing Host and AS/400 Databases for DB2
Connect Communications
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Chapter 6. Configuring Host and AS/400 Databases for DB2
Connect

This section describes the steps required to configure host and AS/400
database servers to accept connections from DB2 Connect workstations. These
steps must be performed by users who have the necessary system privileges
and special expertise, such as your network or system administrator and your
DB2 administrator.

For more information on configuring host and AS/400 database servers, refer
to the following publications:
v The DB2 for OS/390 Installation Guide (GC26-8970) contains the most

complete and up-to-date information for DB2 Universal Database for
OS/390.

v The online Connectivity Supplement provided with DB2 Connect contains
selected information on setting up a host or AS/400 database server
communications.

v Distributed Relational Database Cross Platform Connectivity and Applications
(SG24-4311) contains useful post-configuration information.

The sample values used in this section match those used elsewhere in this
book. When you follow the instructions provided you must substitute your
own values for elements such as network name, LU name, and mode name.

Preparing MVS/ESA or OS/390 for DB2 Connect

Your VTAM administrator and your host system administrator must configure
VTAM and OS/390 (or MVS/ESA) to prepare DB2 Universal Database for
OS/390 (or DB2 for MVS/ESA) to receive inbound connection requests from
your DB2 Connect workstation.

This section provides:
v Examples of VTAM definitions required at your DB2 Universal Database for

OS/390 host for use with DB2 Connect SNA connections. These should be
compared with current definitions. See “Configuring VTAM” on page 48.

v Instructions for establishing TCP/IP network connections between DB2
Connect and DB2 Universal Database for OS/390. See “Configuring TCP/IP
for DB2 Universal Database for OS/390” on page 55.

v DB2 host configuration steps (see “Configuring DB2 Universal Database for
OS/390” on page 52, or “Configuring DB2 for MVS/ESA” on page 53).
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Many details of these steps have changed with the introduction of DB2
Universal Database for OS/390 Version 5.1. Most of these steps apply to
SNA users, but some also apply to users who will connect to DB2 Universal
Database for OS/390 via TCP/IP.

For a summary of the example VTAM names used throughout this book, see
“Sample Network Element Names (VTAM)” on page 49. For TCP/IP names,
see “Configuring TCP/IP for DB2 Universal Database for OS/390” on page 55.

If you anticipate that DB2 for OS/390 will participate in a multisite
update transaction (two phase commit) then please refer to
“Chapter 9. Enabling Multisite Updates (Two-Phase Commit)” on
page 99. The additional steps required to set up multisite updates are
not documented here.

Summary of Steps

In order to prepare DB2 Universal Database for OS/390 or DB2 for MVS/ESA
to receive connection requests from DB2 Connect, you must complete the
following steps at your DB2 Universal Database for OS/390 host:
Step 1. Verify that the following PTFs for OS/390 are installed:

v PTF UQ06843 for APAR PQ05771
v PTF UQ09146 for APAR PQ07537.

Step 2. Configure VTAM - see “Configuring VTAM”, or:

Step 3. Configure TCP/IP - see “Configuring TCP/IP for DB2 Universal
Database for OS/390” on page 55, or:

Step 4. Configure DB2 Universal Database for OS/390 or DB2 for MVS/ESA
- see “Configuring DB2 Universal Database for OS/390” on page 52,
or “Configuring DB2 for MVS/ESA” on page 53.

Configuring VTAM

To configure VTAM, your VTAM Administrator needs to determine the names
and options to be used on your system. The following definitions must be
provided to enable the DB2 Connect workstation to connect to the host:
1. The VTAM APPL Definition for DB2 Universal Database for OS/390 or

DB2 for MVS/ESA. (The APPL name (LU name) for the DB2 subsystem is
NYM2DB2 in these examples.)

2. The VTAM PU and LU Definitions for DB2 Connect. (The PU and LU
definitions for the DB2 Connect workstation are NYX1 and NYX1GW01
respectively in these examples.)

3. The VTAM Log Mode Definition for DB2. (The log mode entry to be used
for the connection is IBMRDB in these examples.)
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The sample VTAM definitions are provided in the sections that follow. These
samples use parameters that match the parameters used elsewhere in this
book.

Sample Network Element Names (VTAM)

Figure 7 shows the sample VTAM definitions used to configure a host
database server.

In this scenario, both userid and password are checked only at the host. If you
use Authentication SERVER, which is the default, then authentication will also
take place at the DB2 Connect server.

Sample VTAM APPL Definition for OS/390

Figure 8 on page 50 shows the sample VTAM application major node
definitions. In most cases, such a definition will already exist with a different
LU name. Otherwise, this application major node must be defined, and DB2

DB2 Connect Server:
- Network ID : SPIFNET
- Local Node Name : NYX1 (PU name)
- Local Node ID : 05D27509

- LU Name : SPIFNET.NYX1GW01 (the same LU is used
for DB2 Connect,
for DB2 Universal Database,
and for the SPM)

- LU Alias : NYX1GW01

HOST:
- Network ID : SPIFNET
- Node Name : NYX

- LU Name : SPIFNET.NYM2DB2
- LU Alias : NYM2DB2
- LAN Destination Address : 400009451902 (NCP TIC address)

MODE DEFINITION:
- Mode Name : IBMRDB

DB2 for MVS/ESA:
- Location : NEW_YORK3

SECURITY:
- Security Type : Program
- Authentication Type : DCS

Figure 7. Network Element Names Used in the VTAM Examples
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Universal Database for OS/390 must be customized in order to use the LU
name defined. This name is the Partner LU name required by DB2 Connect.

Note: Continuations must begin in column 16, with continuation marks in
column 72.

Sample VTAM PU and LU Definitions for DB2 Connect

If your security policies allow it, it is recommended that you enable DYNPU and
DYNLU in VTAM to allow any PU and LU access through VTAM. Contact your
VTAM administrator for more information.

To enable a specific LU or PU, Figure 9 on page 51 shows the sample VTAM
switched major node definitions.

If you already use SNA applications on the DB2 Connect workstation, then a
PU definition already exists. However, an independent LU definition might
not. The independent LU definition required for DB2 Connect must have
LOCADDR=0 specified.

----+----1----+----2----+----3----+----4----+----5----+----6----+----7--

DB2APPLS VBUILD TYPE=APPL

NYM2DB2 APPL APPC=YES, X
AUTH=(ACQ), X
AUTOSES=1, X
DLOGMOD=IBMRDB, X
DMINWNL=512, X
DMINWNR=512, X
DSESSLIM=2048, X
EAS=6000, X
MODETAB=RDBMODES, X
PARSESS=YES, X
PRTCT=SFLU, X
MODETAB=RDBMODES, X
SECACPT=ALREADYV, X
SRBEXIT=YES, X
VERIFY=NONE, X
VPACING=8

Figure 8. Sample VTAM APPL Definition for DB2 Universal Database for OS/390 or DB2 for MVS/ESA
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Sample VTAM Log Mode Definition for DB2

Figure 10 on page 52 shows the sample VTAM logon mode table definition for
the IBMRDB and SNASVCMG modes. Note that this example specifies a 4K
RUSIZE, which may not be suitable for your environment (for example, if you
are using Ethernet, which has a maximum Frame Size of 1536 bytes). Your
VTAM Administrator should check these values and advise you which mode
table entry name and RUSIZE to specify for DB2 Connect.

----+----1----+----2----+----3----+----4----+----5----+----6----+----7--

SWITCHED MAJOR NODE DEFINITION FOR PU NYX1 and
INDEPENDENT LU NYX1GW01

LOC300 VBUILD TYPE=LOCAL

NYX1 ADDR=01,IDBLK=071,IDNUM=27509,ANS=CONT,DISCNT=NO, X
IRETRY=YES,ISTATUS=ACTIVE,MAXDATA=4302,MAXOUT=7, X
MAXPATH=1,PUTYPE=2,SECNET=NO,MODETAB=RDBMODES X
SSCPFM=USSSCS,PACING=0,VPACING=2

NYX1GW01 LOCADDR=000,MODETAB=RDBMODES,DLOGMODE=IBMRDB

OTHERLU LOCADDR=002

Figure 9. Sample VTAM Switched Major Node Definition for DB2 Connect
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You must define the SNASVCMG logon mode when using APPC.

Configuring DB2 Universal Database for OS/390

Before you can use DB2 Connect, your DB2 Universal Database for OS/390
Administrator must configure DB2 Universal Database for OS/390 to permit
connections from DB2 Connect workstations. This section indicates the
minimum updates required in order to permit a DB2 Connect client to make a
connection to the DB2 Universal Database for OS/390 database server. For
more detailed examples, refer to the Connectivity Supplement, and the DB2 for
OS/390 Installation Reference.

The following tables need to be updated, depending on the type of
connections you are using (SNA or TCP/IP):
v SYSIBM.LUNAMES for SNA connections
v SYSIBM.IPNAMES for TCP/IP connections

----+----1----+----2----+----3----+----4----+----5----+----6----+----7---

RDBMODES MODTAB

IBMRDB MODEENT LOGMODE=IBMRDB, DRDA DEFAULT MODE *
TYPE=0, NEGOTIABLE BIND *
PSNDPAC=X'01', PRIMARY SEND PACING COUNT *
SSNDPAC=X'01', SECONDARY SEND PACING COUNT *
SRCVPAC=X'00', SECONDARY RECEIVE PACING COUNT *
RUSIZES=X'8989', RUSIZES IN-4K OUT-4K *
FMPROF=X'13', LU6.2 FM PROFILE *
TSPROF=X'07', LU6.2 TS PROFILE *
PRIPROT=X'B0', LU6.2 PRIMARY PROTOCOLS *
SECPROT=X'B0', LU6.2 SECONDARY PROTOCOLS *
COMPROT=X'D0B1', LU6.2 COMMON PROTOCOLS *
PSERVIC=X'060200000000000000122F00' LU6.2 LU TYPE

SNASVCMG MODEENT LOGMODE=SNASVCMG, DRDA DEFAULT MODE *
PSNDPAC=X'00', PRIMARY SEND PACING COUNT *
SSNDPAC=X'02', SECONDARY SEND PACING COUNT *
SRCVPAC=X'00', SECONDARY RECEIVE PACING COUNT *
RUSIZES=X'8585', RUSIZES IN-1K OUT-1K *
FMPROF=X'13', LU6.2 FM PROFILE *
TSPROF=X'07', LU6.2 TS PROFILE *
PRIPROT=X'B0', LU6.2 PRIMARY PROTOCOLS *
SECPROT=X'B0', LU6.2 SECONDARY PROTOCOLS *
COMPROT=X'D0B1', LU6.2 COMMON PROTOCOLS *
PSERVIC=X'060200000000000000000300' LU6.2 LU TYPE

Figure 10. Sample VTAM Log Mode Definition for DB2 Connect
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The sections that follow contain examples of commands to update these tables
for DB2 Universal Database for OS/390. Work with your DB2 Administrator
to determine the updates required for your DB2 Universal Database for
OS/390 system. For more information on the DB2 Universal Database for
OS/390 Communications Database tables, refer to the DB2 Universal Database
for OS/390 SQL Reference.

Updating SYSIBM.LUNAMES

To permit database connection requests to be accepted from any incoming
DB2 Connect LU, just insert a blank row. Use an SQL similar to the following:

INSERT INTO SYSIBM.LUNAMES (LUNAME) VALUES (' ')

Alternatively, if you want to restrict access by LU name, you can use an SQL
command similar to the following to update this table:

INSERT INTO SYSIBM.LUNAMES (LUNAME,
SECURITY_OUT,
ENCRYPTPSWDS,
USERNAMES)

VALUES('NYX1GW01','P','N','O');

Result:
COLUMN EXAMPLE REMARK
====== ======= ======
LUNAME NYX1GW01 Name of the DB2 Connect LU
SECURITY_OUT P
ENCRYPTPSWDS N
USERNAMES O

Updating SYSIBM.IPNAMES

If you want to permit inbound database connection requests for TCP/IP
nodes, you can use an SQL command such as the following to update this
table:

INSERT INTO SYSIBM.IPNAMES (LINKNAME) VALUES(' ')

Configuring DB2 for MVS/ESA

Before you can use the DB2 Connect connection, your DB2 for MVS/ESA
Administrator must configure DB2 for MVS/ESA to permit connections from
the DB2 Connect workstation. To configure DB2 for MVS/ESA, the following
tables need to be updated:
v SYSIBM.SYSUSERNAMES
v SYSIBM.SYSLUNAMES
v SYSIBM.SYSLUMODES
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The sections that follow contain examples of commands to update these
tables. Work with your DB2 Administrator to determine the options required
for your DB2 for MVS/ESA system.

Updating SYSIBM.SYSUSERNAMES

If you want to use secondary authorization IDs, you can use the following
SQL command to update this table:

INSERT INTO SYSIBM.SYSUSERNAMES VALUES('I','ADBUSER','NYX1GW01',' ',' ');

Result:
COLUMN EXAMPLE REMARK
====== ======= ======
Type I
Authid ADBUSER
LU Name NYX1GW01 Name of the DB2 Connect LU
NewAuthID (blank)
Password (blank)

USERNAME types are: O (outbound translation), I (inbound translation), B
(both inbound and outbound) and blank (no authorization ids are translated,
and no passwords are sent to the server).

Updating SYSIBM.SYSLUNAMES

If you want to restrict access by LU name, you can use an SQL command
similar to the following to update this table:

INSERT INTO SYSIBM.SYSLUNAMES VALUES('NYX1GW01','IBMRDB','A','N',' ','I');

Result:
COLUMN EXAMPLE REMARK
====== ======= ======
LUNAME NYX1GW01 Name of the DB2 Connect LU
SYSMODENAME IBMRDB
USERSECURITY A
ENCRYPTPSWDS N
MODESELECT
USERNAMES I

Alternatively, just insert a blank row, and this will allow any incoming DB2
Connect LUs to be accepted.

Updating SYSIBM.SYSLUMODES

You can use an SQL command such as the following to update this table:
INSERT INTO SYSIBM.SYSLUMODES VALUES ('NYX1 ', 'IBMRDB', 150, 'Y');
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where:
v NYX1 represents the PU name of server involved
v IBMRDB represents the name of VTAM logon mode
v 150 represents the maximum number of conversations
v Y represents the number of sessions preallocated at startup. This can also be

left as N, or blank (the default) for deferred at startup.

Configuring TCP/IP for DB2 Universal Database for OS/390

This section describes how to configure TCP/IP communications between
your DB2 Connect workstation and DB2 Universal Database for OS/390
Version 5.1 or later. It assumes that:
v You are connecting to a single host database via TCP/IP. Multiple host

connections will be handled in exactly the same way, although the port
number and service number required in each case may be different.

v The target database resides on DB2 Universal Database for OS/390 Version
5.1 or later.

v All the necessary software prerequisites are installed.
v DB2 clients have been set up as required.

Prerequisite OS/390 Software for TCP/IP Support

OS/390 R3+ is the minimum operating system level required for TCP/IP
support. OS/390 V2R5+ is the recommended operating system level, and the
best performer.

The following informational APARS for DB2 for OS/390 are regularly updated
with information about PTFs to install for various OS/390 components,
particularly TCP/IP for OS/390. If you use TCP/IP connectivity with DB2 for
OS/390 it is extremely important that you review and apply PTFs and APAR
fixes described in the following DB2 for OS/390 information APARs:
v II11164
v II11263
v II10962

The following fixes are recommended for DB2 for OS/390:
v DB2 for MVS Version 3.1: PTF UQ13906
v DB2 for MVS Version 4.1: PTF UQ13907
v DB2 for OS/390 Version 5.1: PTF UQ13908, PTF UQ17755
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Collecting Information

Before you can use DB2 Connect over a TCP/IP connection, you must collect
information about both the host database server and the DB2 Connect
workstation. For each host server that you are connecting to via TCP/IP, you
must have the following information:
v The location of the TCP/IP services file at the DB2 Connect workstation:

– On a UNIX system, the location of this file is usually /etc/services.
– On OS/2 Warp Version 4 the location of this file is determined by the

ETC environment variable.
– On Windows NT, the location of this file is <NT install

directory>\system32\drivers\etc\services.
v The location of the TCP/IP hosts file at the DB2 Connect workstation:

– On a UNIX system, the location of this file is usually /etc/hosts.
– On OS/2 Warp Version 4, the location of this file is usually

\mptn\etc\hosts.
– On Windows NT, the location of this file is usually <NT install

path>\system32\drivers\etc\hosts.

You may use a Domain Name Server to avoid maintaining this file on
multiple systems.

v The locations of the equivalent files at the target DB2 Universal Database
for OS/390 host.

v The TCP/IP port number defined to DB2 Universal Database for OS/390.
(Note that the associated service name information is not exchanged between
the DB2 Connect workstation and DB2 Universal Database for OS/390).
Port number 446 has been registered as the default for communication from
a DB2 Connect workstation.

v The TCP/IP addresses and hostnames for both the host and the DB2
Connect workstation.

v The LOCATION NAME of the DB2 for OS/390 database server
v The user ID and password to be used when issuing CONNECT requests for

the database at the host.

Refer to your local network administrator and your DB2 for OS/390
administrator for help getting this information. Use one copy of the example
work sheet, Table 7 on page 57, to plan each TCP/IP connection between DB2
Connect and a host database server.
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Example Worksheet:

Table 7. Example Worksheet for Planning TCP/IP Connections to DB2 Universal
Database for OS/390

Ref. Description Sample Value Your Value

User Information

�TCP-1� User Name A.D.B.User

�TCP-2� Contact Info (123)-456-7890

�TCP-5� User ID ADBUSER

�TCP-6� Database Type db2390

�TCP-7� Connection type
(must be TCPIP).

TCPIP TCPIP

Network Elements at the Host

�TCP-8� Host name MVSHOST

�TCP-9� Host IP address 9.21.152.100

�TCP-10� Service name db2inst1c

�TCP-11� Port number 446

�TCP-12� LOCATION NAME NEW_YORK3

�TCP-13� User ID

�TCP-14� Password

Network Elements at the DB2 Connect Workstation

�TCP-18� Host name mcook02

�TCP-19� IP address 9.21.27.179

�TCP-20� Service name db2inst1c

�TCP-21� Port number 446

DB2 Directory Entries (at the DB2 Connect workstation)

�TCP-30� Node name MVSIPNOD

�TCP-31� Database name nyc3

�TCP-32� Database alias mvsipdb1

�TCP-33� DCS database name nyc3

Notes:

1. To obtain the host’s IP address �TCP-9�, enter at the host:
TSO NETSTAT HOME

2. To obtain the port number �TCP-11�, look for DSNL004I in the DB2 master
address space or system log.
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Configuring the TCP/IP Connection

Use the manual steps in this section to complete the configuration and make
the connection.

Complete the Worksheet: Complete a copy of the example worksheet for
each TCP/IP host:
1. Fill in the values to be used for the TCP/IP address and hostname of the

DB2 Universal Database for OS/390 host (items 8 and 9).
2. Fill in the values to be used for the TCP/IP address and hostname of the

DB2 Connect workstation (items 18 and 19).
3. Determine the port number or service name to be used for the connection

(items 10 and 11, or 20 and 21).
4. Determine the LOCATION NAME of the DB2 for OS/390 database server

to which you wish to connect.
5. Determine the values to be used for user ID and PASSWORD when

connecting to the host database.

Note that some additional planning considerations may apply, for example if
you are using DCE. See the DB2 Connect User’s Guide.

Update the DB2 Universal Database for OS/390 Host: At your OS/390 host:
1. Verify the host address or the host name.
2. Verify the port number or the service name.
3. Update the services file with the correct port number and service name if

necessary.
4. Update the hosts file (or the Domain Name Server used by the DB2

Universal Database for OS/390 system) with the hostname and IP address
of the DB2 Connect workstation if necessary.

5. Ensure the new definitions are active before attempting to test the
connection. Refer to your host network administrator or change control
staff if necessary.

6. Check with the DB2 Universal Database for OS/390 administrator that you
have a valid user ID, password, and database LOCATION NAME.

7. PING the DB2 Connect workstation, using the correct port number if that
option is supported by TCP/IP on the host system. For example:

ping remote_host_name -p port_number

Update the DB2 Connect Configuration: At a command line prompt, issue
the following command to update the Database Manager Configuration:

db2 update dbm config using TM_DATABASE 1st_conn

where TM_DATABASE can have one of the following settings:
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v 1ST_CONN, the first database that a connection is established to will be
used as the Transaction Manager database for transactions. If this option is
used, then the first database connected to must be either a DB2 Universal
Database Version 5 or later database, or a DB2 Universal Database for
OS/390 Version 5.1 or later database. This is the recommended setting, and
it is the default value for TM_DATABASE.

v database_name, the named database that is connected to will be used. If this
option is used, we recommend that the named database should be either a
DB2 Universal Database version 5 or later database, or a DB2 Universal
Database for OS/390 Version 5.1 or later database.

Update the DB2 Connect Directories:

1. At a command line prompt, issue the following command to catalog the
DB2 for MVS/ESA node:

db2 catalog tcpip node MVSIPNOD remote MVSHOST server db2inst1c

where:
v MVSIPNOD is the local DB2 Connect node name to be used for the

host.
v MVSHOST is the eight-character TCP/IP host name for the DB2

Universal Database for OS/390 host. TCP/IP name lookup must resolve
this name to the correct destination Internet address, either through an
entry in the local hosts file on the DB2 Connect workstation, or via a
Domain Name Server (DNS) referenced by the DB2 Connect
workstation.

v db2inst1c is the port number defined at the DB2 Connect workstation.
This must resolve to the same port number as that defined for use by
DB2 Connect at the DB2 for MVS/ESA host. Alternatively, you can
specify the service name associated with that port.

2. Create entries for the Database and Data Connection Services directories,
as follows (this shows the values used in the sample worksheet):

db2 catalog dcs database NYC3 as NEW_YORK3
db2 catalog database NYC3 as MVSIPDB1 at node MVSIPNOD authentication dcs

where:
v MVSIPDB1 is user-defined and represents the DB2 Connect database

alias for the host database.
v NYC3 is the DB2 Connect database name for the host database.
v MVSIPNOD is the DB2 Connect node name for the host.
v NEW_YORK3 is the DB2 Universal Database for OS/390 LOCATION

NAME for the target database.
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CONNECT and BIND: Finally, connect to the target host server and bind the
utilities and applications to the server using commands similar to the
following in the command line processor:

connect to MVSIPDB1 user USERID using PASSWORD
bind path/bnd/@ddcsmvs.lst blocking all

sqlerror continue blocking all grant public
disconnect all

where path corresponds to the DB2PATH registry value.

These commands are described in detail in the Command Reference.

Preparing DB2 Universal Database for AS/400 for DB2 Connect

DB2 Connect gives applications on remote systems access to data in your DB2
Universal Database for AS/400 system. In order to set up the connection, the
person installing DB2 Connect needs the following information:
__ 1. The local network name. You can get this information by entering

DSPNETA.
__ 2. The local adapter address. You can get this information by entering

WRKLIND (*trlan).
__ 3. The mode name. You can get a list of mode names by entering

WRKMODD. If the mode IBMRDB has been defined on your AS/400
system, you should use it.

__ 4. The local control point name. You can get this information by entering
DSPNETA.

__ 5. The remote transaction program name. The default is X'07'6DB
(X'07F6C4C2'). The default is always used by DB2 Universal Database
for AS/400. If entering a hexadecimal number is not convenient, an
alias is QCNTEDDM.

__ 6. The relational database name. You can get this information by entering
DSPRDBDIRE. This will display a list. The line containing *LOCAL in
the Remote Location column identifies the RDBNAME which must be
defined to the client. If there is no *LOCAL entry, you can add one, or
use the system name obtained from the DSPNETA command on the
server.
Here is an example screen:
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Display Relational Database Directory Entries

Position to . . . . . .

Type options, press Enter.
5=Display details 6=Print details

Relational Remote
Option Database Location Text

_ __________________
_ DLHX RCHAS2FA
_ JORMT2FA JORMT2FA
_ JORMT4FD JORMT4FD
_ JOSNAR7B RCHASR7B
_ RCHASR7B *LOCAL
_ RCHASR7C RCHASR7C
_ R7BDH3SNA RCH2PDH3
_ RCHASDH3 RCHASDH3

When you have obtained these parameters from OS/400, enter your values
into the worksheet that follows:

Table 8. Configuration Parameters from OS/400

Item Parameter Example Your value

A-1 Local network name SPIFNET

A-2 Local adapter address 400009451902

A-3 Mode name IBMRDB

A-4 Local control point name SYD2101A

A-5 Remote transaction
program

X'07F6C4C2'(default)

A-6 Relational database name NEW_YORK3

For further information about how to set up DB2 Universal Database for
AS/400 as an application server, refer to the online Connectivity Supplement
provided with your DB2 Connect product.

More detailed information can also be found in the DRDA Connectivity Guide,
and on the World Wide Web at the V4R4 AS/400 Information Center. The
Information Center can be found at the following URL:

http://as400bks.rochester.ibm.com

Preparing DB2 for VSE & VM

For information about how to set up DB2 for VSE & VM as an application
server, refer to the Connectivity Supplement online document.

More detailed information can also be found in the DRDA Connectivity Guide.
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Part 4. Configuring Access to Host and AS/400
Databases
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Chapter 7. Configuring DB2 Connect to Host or AS/400
Communications Using the CCA

This section describes how to use the Client Configuration Assistant (CCA) to
configure your DB2 Connect workstation to access host or AS/400 DB2
databases. The configuration steps described in this section apply if you are
connecting to the host or AS/400 system using TCP/IP or SNA (APPC).

The CCA cannot auto-detect or configure the following SNA (APPC)
subsystems:

v IBM eNetwork Communications Server

v Communications Server for Windows NT SNA API Client

v Microsoft SNA Server for Windows NT

To complete the steps in this section, you should be familiar with how to start
the CCA. For more information, see “Starting the Client Configuration
Assistant” on page 143.

To configure communications to a non-host or AS/400 based DB2 database, go to
“Chapter 13. Configuring Client-to-Server Communications Using the Client
Configuration Assistant” on page 115.

To configure communications to a host or AS/400 DB2 database using the command
line processor, or if an SNA product cannot be configured by the CCA, go to the section
that describes the communications protocol that you want to configure:

v TCP/IP - refer to the Installation and Configuration Supplement online document.

v APPC - see “Chapter 8. Configuring APPC Communications on the DB2 Connect
Workstation” on page 75.

With the CCA, you can:

v Configure database connections that applications can use.
v Update or delete existing configured database connections.
v Display the information for existing configured connections.
v Test a connection to a database.
v Enable or disable databases to be configured as CLI or ODBC data sources.
v Export client profiles, or import client and server profiles which contain

information for the setup of a client.
v Update client configuration settings.
v Discover remote databases (if enabled).
v Bind user applications and utilities to databases.
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v Change your server password.

The CCA provides three methods to set up a database connection to a server:
v Using a profile.
v Searching the network for databases.
v Manually entering database and communication protocol information for a

server.

When you add a database using this configuration method, the
Client Configuration Assistant will generate a default node name for
the server where the database resides.

Configuration Steps

To configure your workstation to access a host or AS/400 database, perform
the following steps:
Step 1. Log on to the system with a valid DB2 user ID. For more

information, see “Appendix F. Naming Rules” on page 177.

If you are adding a database to a system that has a DB2 Connect
server product installed, log on to this system as a user with System
Administrative (SYSADM) or System Controller (SYSCTRL) authority
on the instance. For more information, see “Working with the System
Administrative Group” on page 148.

This restriction is controlled by the catalog_noauth database manager
configuration parameter. For more information, refer to the
Administration Guide.

Step 2. Start the CCA. For more information, see “Starting the Client
Configuration Assistant” on page 143.
The Welcome window opens each time you start the CCA, until you
add at least one database to your client.

Step 3. Click on the Add Database or Add push button to configure a
connection.

Go to the section that describes the configuration method that you want to use:

v “Adding a Database Using a Profile” on page 67.

v “Adding a Database Using Discovery” on page 68.

v “Adding a Database Manually” on page 70.
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Adding a Database Using a Profile

A profile contains information about instances and databases on a system, and
databases within each instance. For information on profiles, see “Creating and
Using Profiles” on page 122.

If your administrator provided you with a profile, perform the following
steps:

Step 1. Select the Use an access profile radio button and click on the Next
push button.

Step 2. Click on the ... push button and select a profile.
Step 3. You are presented with a list of systems, instances, and databases.

Select the database that you want to add to your system.
Step 4. Select the type of connection that you want to make to the host or

AS/400 database:
v To make a connection through a DB2 Connect gateway, select the

Connect to the server via the gateway radio button.
v To make a direct connection, select the Connect directly to the

server radio button.
Step 5. Click on the Next push button.
Step 6. Enter a local database alias name in the Database alias field and

add a comment that describes this database in the Comment field.
Click on the Next push button.

If you do not specify a database alias name, the default will be the
same as the remote database alias name.

Step 7. Register this database as an ODBC data source.

If you are not planning to use ODBC, click on the Done push button
and go to the next step.

a. Ensure that the Register this database for ODBC check box is
selected.

b. Select the radio button that describes how you would like to
register this database:
v If you would like all users on your system to have access to

this data source, select the As a system data source radio
button.

v If you would like only the current user to have access to this
data source, select the As a user data source radio button.

Chapter 7. Configuring DB2 Connect to Host or AS/400 Communications Using the CCA 67



c. If you would like to create an ODBC data source file to share
database access, select the Create a file data source check box
and enter the path and filename for this file in the File data
source name field.

d. Click on the Optimize for application drop down box and select
the application for which you want to tune the ODBC settings.

e. Click on the Done push button to add the database that you
selected. The Confirmation window opens.

Step 8. Click on the Test Connection push button to test the connection. The
Connect to DB2 Database window opens.
If the database that you want to add was not added successfully,
click on the Change push button to change any settings that you may
have incorrectly specified or click on the Help push button for more
information. For even more detailed information, refer to the
Troubleshooting Guide.

Step 9. Enter your user ID and password and click on OK. If the connection
is successful, a message confirming the connection appears.

Step 10. You are now able to use this database. To finish using the Add
Database SmartGuide, click on the Close push button; you can then
add more databases by clicking on the Add push button or exit the
CCA.

Adding a Database Using Discovery

This option cannot return information about pre-Version 5 DB2
systems or any systems where an Administration Server is not
running. For more information, refer to the Administration Guide.

You can use the Discovery feature to search the network for databases. To add
a database to your system using Discovery, perform the following steps:
Step 1. Select the Search the network radio button and click on the Next

push button.
Step 2. Click on the [+] sign beside the Known Systems icon to list all the

systems known to your client.
Step 3. Click on the [+] sign beside a system to get a list of the instances

and databases on it.
If the system that contains the database that you want to add is not
listed, perform the following steps:
a. Click on the [+] sign beside the Other Systems (Search the

network) icon to search the network for additional systems.
b. Click on the [+] sign beside a system to get a list of the instances

and databases on it.
c. Select the database that you want to add, click on the Next push

button, and proceed to Step 4.
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The Client Configuration Assistant may be unable to detect a remote
system if:

v The Administration Server is not running on the remote system.

v The Discovery function times out. By default, the Discovery
function will search the network for 40 seconds; this may not be
long enough to detect the remote system. You can set the
DB2DISCOVERYTIME registry variable to specify a longer period
of time.

v The network that the Discovery request is running on is
configured so that the Discovery request does not reach the remote
system desired.

v You are using NetBIOS as the Discovery protocol. You may need
to set the DB2NBDISCOVERRCVBUFS registry variable to a larger
value to enable the client to receive more concurrent Discovery
replies.

For more information, refer to the Administration Guide.

If the system that you want to add is still not listed, it can be added
to the list of systems by performing the following steps:
a. Click on the Add System push button
b. Enter the required communication protocol parameters for the

remote Administration Server and click on OK. A new system is
added. For more information, click on the Help push button.

c. Select the database that you want to add and click on the Next
push button.

Step 4. You are presented with a list of systems, instances, and databases.
Select the database that you want to add to your system.

Step 5. Select the type of connection that you want to make to the host or
AS/400 database:
v To make a connection through a DB2 Connect gateway, select the

Connect to the server via the gateway radio button.
v To make a direct connection, select the Connect directly to the

server radio button.
Step 6. Click on the Next push button.
Step 7. Enter a local database alias name in the Database alias field and add

a comment that describes this database in the Comment field. Click
on the Next push button.

If you do not specify a database alias name, the default will be the
same as the remote database alias name.
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Step 8. Register this database as an ODBC data source.

If you are not planning to use ODBC, click on the Done push button
and go to the next step.

a. Ensure that the Register this database for ODBC check box is
selected.

b. Select the radio button that describes how you would like to
register this database:
v If you would like all users on your system to have access to

this data source, select the As a system data source radio
button.

v If you would like only the current user to have access to this
data source, select the As a user data source radio button.

c. If you would like to create an ODBC data source file to share
database access, select the Create a file data source check box and
enter the path and filename for this file in the File data source
name field.

d. Click on the Optimize for application drop down box and select
the application for which you want to tune the ODBC settings.

e. Click on the Done push button to add the database that you
selected. The Confirmation window opens.

Step 9. Click on the Test Connection push button to test the connection. The
Connect to DB2 Database window opens.
If the database that you want to add was not added successfully,
click on the Change push button to change any settings that you may
have incorrectly specified or click on the Help push button for more
information. For even more detailed information, refer to the
Troubleshooting Guide.

Step 10. Enter your user ID and password and click on OK. If the connection
is successful, a message confirming the connection appears.

Step 11. You are now able to use this database. To finish using the Add
Database SmartGuide, click on the Close push button; you can then
add more databases by clicking on the Add push button or exit the
CCA.

Adding a Database Manually

If you have the protocol information for the server that you want to connect
to, you can manually enter all of the configuration information. This method
is analogous to entering commands via the command line processor, however,
the parameters are presented graphically for you.

To add a database to your system manually, perform the following steps:
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Step 1. Select the Manually configure a connection to a DB2 database radio
button and click on the Next push button.

If you are not using Lightweight Directory Access Protocol (LDAP), this
tab will not be shown, skip this step and go to Step 3.

Step 2. Select the radio button that corresponds to the location where you
would like your DB2 directories to be maintained.
v If you would like to maintain the DB2 directories locally, select the

Add database to your local machine radio button and click on the
Next push button.

v If you would like to maintain the DB2 directories globally at an
LDAP server, select the Add database using LDAP radio button
and click on the Next push button.

Step 3. Select the radio button that corresponds to the protocol that you want
to use from the Protocol list and click on the Next push button.

Step 4. Enter the required communication protocol parameters and click on
the Next push button. For more information, click on the Help push
button.

Step 5. Enter the database alias name of the remote database that you want
to add in the Database name field and a local database alias name in
the Database alias field. Add a comment that describes this database
in the Comment field and click on the Next push button.
If you are adding a database that resides on a host or AS/400 system,
the Database name field will appear as follows:

OS/390 or MVS
Location name

AS/400
RDB name

VM or VSE
DBNAME

When a database is created on the remote server, if a database alias
is not specified during database creation, the database is created with
a database alias=database_name; otherwise, the database alias is the
name that was specified when the database was created.

Step 6. Register this database as an ODBC data source.
a. Ensure that the Register this database for ODBC check box is

selected.
b. Select the radio button that describes how you would like to

register this database:
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v If you would like all users on your system to have access to
this data source, select the As a system data source radio
button.

v If you would like only the current user to have access to this
data source, select the As a user data source radio button.

c. If you would like to create an ODBC data source file to share
database access, select the Create a file data source check box and
enter the path and filename for this file in the File data source
name field.

d. Click on the Optimize for application drop down box and select
the application for which you want to tune the ODBC settings.

e. Click on the Done push button to add the database that you
selected. The Confirmation window opens.

If you are adding a database using the manual method, you can also
select the Node Options tab, the Security Options tab, or the Host or
AS/400 Options tab (if you are adding a host or AS/400 database) to
specify more detailed catalog information. Refer to the online help in
each tab for more information.

If you want to use the default settings for the node, security, and host or
AS/400 (if applicable) options, click on the Done push button and go to
the next step.

Step 7. Click on the Test Connection push button to test the connection. The
Connect to DB2 Database window opens.
If the database that you want to add was not added successfully,
click on the Change push button to change any settings that you may
have incorrectly specified or click on the Help push button for more
information. For even more detailed information, refer to the
Troubleshooting Guide.

Step 8. Enter your user ID and password and click on OK. If the connection
is successful, a message confirming the connection appears.

Step 9. You are now able to use this database. To finish using the Add
Database SmartGuide, click on the Close push button; you can then
add more databases by clicking on the Add push button or exit the
CCA.

When you have finished adding the host or AS/400 database to your system,
we recommended that you bind any DB2 utilities or applications to the
database you just added by performing the following steps:
Step 1. Log on to the system with a user ID that has System Administrative

(SYSADM), Database Administrative (DBADM), or Bind Add
(BINDADD) authority on the database.

Step 2. Start the CCA.
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Step 3. Select the database that you want to bind the utilities and packages
against.

Step 4. Click on the Bind push button.
Step 5. Select the type of bind that you want to perform:

v Select the Bind DB2 utilities radio button if you want to bind
utilities against the database

v Select the Bind applications radio button if you want to bind
applications against the database

Step 6. Click on the Continue push button.
Step 7. Enter a user ID and password to connect to the database.
Step 8. Select the utilities or applications that you want to bind and click on

OK.

Now that you have configured host connections, go to “Chapter 9.
Enabling Multisite Updates (Two-Phase Commit)” on page 99 if you
want to enable the multisite updates feature, or “Chapter 10. Installing
DB2 Clients” on page 107 to install DB2 clients.
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Chapter 8. Configuring APPC Communications on the DB2
Connect Workstation

This section describes how to configure a DB2 Connect workstation to
communicate with a host or AS/400 database server using the APPC
communication protocol. The instructions that follow assume that APPC is
supported on the DB2 Connect and host or AS/400 machines.

You will only need to refer to the instructions in this section if you wish to
configure your APPC connection to a host or AS/400 database by hand. APPC
can often be configured automatically using the Client Configuration Assistant
(CCA). For more information about the CCA, see “Chapter 7. Configuring
DB2 Connect to Host or AS/400 Communications Using the CCA” on page 65.
For further information about the communications requirements of your
platform, see “Software Requirements” on page 26. See “Possible
Client-to-Server Connectivity Scenarios” on page 30 for the protocols
supported for communication between your particular client and server.

The following steps are required to set up a DB2 Connect workstation to use
APPC communications with a host or AS/400 database server:

Step 1. Identify and record parameter values.
Step 2. Update the APPC profiles on the DB2 Connect workstation.
Step 3. Catalog the database.
Step 4. Catalog the APPC or APPN Node.
Step 5. Catalog the database as a Database Connection Service (DCS)

database.
Step 6. Bind utilities and applications to the database server.
Step 7. Test the Host or AS/400 Connection.

Step 1. Identify and Record Parameter Values

Before you configure the DB2 Connect workstation, have your host-side
administrator and LAN administrator fill in copies of the worksheet in Table 9
on page 76 for each host or AS/400 database to which you want to connect.

After you fill in the Your Value entries, you can use the worksheet to configure
APPC communications for DB2 Connect. During the configuration process,
replace the sample values that appear in the configuration instructions with
your values from the worksheet, using the boxed numbers (for example, �1�)
to relate the configuration instructions to the worksheet values.
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Note: The worksheet and configuration instructions supply suggested or
sample values for required configuration parameters. For other
parameters, use the communications program’s default values. If your
network configuration is different from that used in the instructions,
consult your Network Administrator for values that are appropriate to
your network.

In the configuration instructions, the �*� symbol denotes entries that need to
be changed but do not have a representation on the worksheet.

Table 9. Worksheet for Planning Host and AS/400 Server Connections

Ref.

Name at the DB2
Connect
Workstation

Network or VTAM
Name Sample Value Your Value

Network Elements at the Host

�1� Host name Local Network Name SPIFNET

�2� Partner LU Name Application Name NYM2DB2

�3� Network ID SPIFNET

�4� Partner Node name Local CP or SSCP Name NYX

�5� Target database
name
(target_dbname)

OS/390 or MVS:
LOCATION
NAME

VM/VSE:
DBNAME

AS/400:
RDB Name

NEWYORK

�6� Link Name or Mode
Name

IBMRDB

�7� Connection name
(Link name)

LINKHOST

�8� Remote Network or
LAN address

Local Adapter or
Destination Address

400009451902

Network Elements at the DB2 Connect Workstation

�9� Network or LAN ID SPIFNET

�10� Local Control Point
Name

NYX1GW

�11� (Local) LU name NYX1GW0A

�12� (Local LU) alias NYX1GW0A
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Table 9. Worksheet for Planning Host and AS/400 Server Connections (continued)

Ref.

Name at the DB2
Connect
Workstation

Network or VTAM
Name Sample Value Your Value

�13� Local Node or Node
ID

ID BLK 071

�14� ID NUM 27509

�15� Mode name IBMRDB

�16� Symbolic
Destination name

DB2CPIC

�17� (Remote)
Transaction program
(TP) name

OS/390 or MVS:
X'07F6C4C2'
or DB2DRDA

VM/VSE:
AXE for
VSE, or the
DB2 for
VM db
name for
VM

AS/400:
X'07F6C4C2'
or QCNTEDDM

DB2 Directory Entries (at the DB2 Connect workstation)

�19� Node name db2node

�19� Security program

�20� Local database name
(local_dcsname)

ny

For each server that you are connecting to, fill in a copy of the worksheet as
follows:

1. For network ID, determine the network name of both the host and the
DB2 Connect workstations (�1�, �3�, and �9�). Usually these values will
be the same. (For example, SPIFNET.)

2. For the partner LU name (�2�), determine the VTAM application (APPL)
name for OS/390, MVS, VSE, or VM. Determine the local CP name for
AS/400.

3. For partner node name (�4�), determine the System Services Control Point
(SSCP) name for OS/390, MVS, VM, or VSE. Determine the local control
point name for an AS/400.
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4. For database name (�5�), determine the name of the host database. This is
the LOCATION NAME for OS/390 or MVS, the RDB_NAME for VM or
VSE, or a relational database name for AS/400.

5. For mode name (�6� and �15�), usually the default IBMDRB is sufficient.
6. For remote network address (�8�), determine the controller address or local

adapter address of the target host or AS/400 system.
7. Determine the local control point name (�10�) of the DB2 Connect

workstation. This is usually the same as the PU name for the system.
8. Determine the local LU name to be used by DB2 Connect (�11�). If you

use a Syncpoint Manager to manage multisite updates (two-phase
commit), the local LU should be the LU used for the SPM. In this case,
that LU cannot also be the Control Point LU.

9. For local LU alias (�12�), you usually use the same value as for the local
LU name (�11�).

10. For local node or node ID (�13� plus �14�), determine the IDBLK and
IDNUM of the DB2 Connect workstation. The default value should be
correct.

11. For symbolic destination name (�16�), choose a suitable value.
12. For (remote) transaction program (TP) name (�17�), it is recommended that

you use the defaults listed in the worksheet.
13. Leave the other items blank for now (�18� to �21�).

Step 2. Update the APPC Profiles on the DB2 Connect Workstation

Use the completed worksheet in Table 9 on page 76 to configure DB2 Connect
APPC communications for access to a remote host or AS/400 database server.

Go to the sections that describe how to configure APPC communications on the
platforms that are present in your network:

v “Configuring IBM eNetwork Communications Server for Windows NT SNA API
Client”

v “Configuring Microsoft SNA Server for Windows NT” on page 81

v “Configuring Microsoft SNA Client” on page 90

Configuring IBM eNetwork Communications Server for Windows NT SNA
API Client

Read this section if you have a Windows NT workstation that has IBM
eNetwork Communications Server for Windows NT SNA API Client Version
5.0 or higher installed and you want to connect to an IBM eNetwork
Communications Server for Windows NT server.
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The Communications Server for Windows NT server and its SNA API client
act as a split client. This configuration requires that you have an
APPC-enabled application (such as DB2 Connect) running on the SNA API
client workstation.

The instructions in this section use a Windows NT client. The
instructions for other supported operating systems are similar; refer
to your Communications Server for Windows NT documentation for
more information.

To configure the Windows NT SNA API client for APPC communications,
complete the following steps:
Step 1. Create a user account for the SNA API client on the Communications

Server for Windows NT server
a. Click on the Start button and select Programs->Administrative

Tools (Common)->User Manager. The User Manager window
opens.

b. Select Users->New User from the menu bar. The New User
window opens.

c. Fill in the fields for the new SNA client user accout. For more
information, refer to the Windows NT online help.

d. Ensure that this user account is a member of the Administrators,
IBMCSADMIN, and IBMCSAPI groups:
1) Click on the Groups push button
2) Select a group from the Not member of box and click on the

<- Add push button. Repeat this step for each group that your
user account must belong to.

e. Click on OK.
f. Click on the Add push button.

Step 2. Start the configuration GUI for the IBM eNetwork CS/NT SNA API
Client. Click on the Start push button and select Programs->IBM
Communications Server SNA Client->Configuration. The CS/NT
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SNA Client Configuration window opens.

Step 3. Configure Global Data
a. In the Configuration options box, select the Configure Global

Data option and click on the New push button. The Define Global
Data window opens.

b. Enter the user name for the SNA API client in the User name
field. This is the user name that was defined in Step 1.

c. Enter the password for the user account in the Password and
Confirm Password fields.

d. Click on OK.
Step 4. Configure APPC Server List

a. In the Configuration options box, select the Configure APPC
Server List option. Click on the New push button. The Define
APPC Server list window appears.
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b. Type in the IP address of the server (for example,
123.123.123.123).

c. Click on OK.
Step 5. Configure CPI-C Side Information

a. In the Configuration options box, select the Configure CPI-C side
information option and click on the New push button. The
Define CPI-C side information window opens.

b. Enter the symbolic destination name (�16�) in the Symbolic
destination name field.

c. Enter your Local LU alias (�12�) in the Local LU alias field.
d. Enter the mode name (�15�) in the Mode name field.
e. Enter the transaction program name (�17�) in the TP name field.
f. Select the For SNA API Client use check box for this transaction

program.
g. Enter the network ID (�3�) and partner LU name (�2�) in the

Partner LU name field.
h. Click on OK.

Step 6. Save the Configuration
a. Select File->Save As from the menu bar. The Save As window

opens.
b. Type in a file name, and click on the Save push button.

You now need to update the DB2 directories, bind utilities and applications to the
server, and test the connection.

The easiest way to do this is to use the Client Configuration Assistant (CCA). For more
information on using the CCA, go to “Chapter 7. Configuring DB2 Connect to Host or
AS/400 Communications Using the CCA” on page 65. However, you can also perform
these steps manually, as described in “Step 3. Catalog the APPC or APPN Node” on
page 93 and the sections that follow.

Configuring Microsoft SNA Server for Windows NT

This section describes how to configure Microsoft SNA Server Version 4.0 for
Windows NT on your DB2 Connect workstation to connect to host or AS/400
database servers using APPC. Although Microsoft SNA Server will run on
Windows NT 4.0 Workstation, Windows NT 4.0 Server is recommended.

For instructions on how to configure Microsoft SNA Client for Windows NT, go to
“Configuring Microsoft SNA Client” on page 90.

You can define the properties of your SNA connections in the Microsoft SNA
Server Manager (Server Manager). The Server Manager uses an interface
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similar to that of the Windows NT Explorer. The following illustration shows
the interface. There are two panes in the main window of the Server Manager.
All the configuration options we will be using can be accessed by
right-clicking on objects in the left-hand pane of the window. Every object has
a context menu that you can access by right-clicking on the object.

To configure APPC communications for use by DB2 Connect using Microsoft
SNA Server Manager, perform the following steps:

Step 1. Start the Server Manager by clicking on the Start button and selecting
Programs->Microsoft SNA Server->Manager. The Microsoft SNA
Server Manager window opens.

Step 2. Define the control point name
a. Click on the [+] sign beside the Servers folder.
b. Right-click on SNA Service folder and select the Properties

option. The Properties window opens.
c. Enter the correct NETID (�9�) and Control Point Name (�10�) in

the corresponding fields.
d. Click on OK.

Step 3. Define the link service (802.2)
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a. Right-click on the SNA Service icon and select the Insert->Link
Service option. The Insert Link Service window opens.

b. Select DLC 802.2 Link Service.
c. Click on the Add push button.
d. Click on the Finish push button.

Step 4. Define the connection properties
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a. Right-click on SNA Service and select the Insert->Connection-
>802.2 option. The Connection Properties window opens.

b. Enter a connection name (�7�) in the Name field.
c. Click on the Link Service drop-down box and select the SnaDlc1

option.
d. Select the Remote End radio button from the Host System box.
e. Select the Both Directions radio button from the Allowed

Directions box.
f. Select the On Server Startup radio button from the Activation

box.
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g. Select the Address tab.

h. Fill in the Remote Network Address field (�8�). Accept the
default numbers in the other fields.

i. Select the System Identification tab.
j. Enter the following information:

1) For the Local Node Name, add the Network ID (�9�), the
Local PU Name (�10�), and the Local Node ID (�1� plus �14�).
Accept the XID Type default.

2) For the Remote Node Name, add the NETID (�1�) and the
Control Point Name (�4�). Accept the other defaults

k. Click on OK.
Step 5. Define a local LU

a. Right-click on the SNA Service icon and select the
Insert->APPC->Local Lu option. The Local APPC LU Properties
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window opens.

b. Enter the following information:
v The LU Alias (�12�).
v The NETID (�9�).
v The LU Name (�11�).

c. Select the Advanced tab.
d. Select the Member of Default Outgoing Local APPC LU Pool

option. Accept the other defaults.
e. Click on OK.

Step 6. Define a remote LU
a. Right-click on SNA Services icon and select the

Insert->APPC->Remote LU option. The Remote APPC Lu
Properties window opens.

b. Click on the Connection drop down box and select the
appropriate connection name (�7�).

c. Enter the partner LU name (�2�) in the LU Alias field.
d. Enter the Network ID (�1�) in the Network Name field.

The other fields will be filled in by the program. If your LU alias is
not the same as your LU Name, make sure you specify the LU Name
in the appropriate field. The program will fill it in automatically, but
it will be incorrect if the alias and the name are not the same.

e. Click on OK.
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Step 7. Define a mode
a. Right-click on APPC Modes folder and select the

Insert->APPC->Mode Definition option. The APPC Mode
Properties window opens.

b. Enter the Mode Name �6� in the Mode Name field.
c. Select the Limits tab.
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d. Enter appropriate numbers for the Parallel Session Limit and
Minimum Contention Winner Limit fields. Your Host-Side or
LAN administrator should be able to supply you with the
numbers if you do not know the limits you should place here.

e. Accept the other defaults, and click on OK.
Step 8. Define the CPIC name properties

a. Right-click on CPIC Symbolic Name folder icon and select the
Insert->APPC->CPIC Symbolic Name option. The CPIC Name
Properties window opens.

b. Enter the Symbolic Destination Name (�16�) in the Name field.
c. Click on the Mode Name drop down box and select a mode

name, for example, IBMRDB.
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d. Select the Partner Information tab.

e. In Partner TP Name box, select the SNA Service TP (in hex)
radio button and enter the Service TP name (�17�), or select the
Application TP radio button and enter the Application TP name
(�17�).

f. In the Partner LU Name box, select the Fully Qualified radio
button.

g. Enter the fully-qualified Partner LU Name (�1� and �2�) or alias.
h. Click on OK.
i. Save the configuration

1) Select File->Save from the menu bar of the Server Manager
window. The Save File window opens.

2) Type a unique name for your configuration into the File Name
field.

3) Click on the Save push button.

You now need to update the DB2 directories, bind utilities and applications to the
server, and test the connection.

The easiest way to do this is to use the Client Configuration Assistant (CCA). For more
information on using the CCA, go to “Chapter 7. Configuring DB2 Connect to Host or
AS/400 Communications Using the CCA” on page 65. However, you can also perform
these steps manually, as described in “Step 3. Catalog the APPC or APPN Node” on
page 93 and the sections that follow.
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Configuring Microsoft SNA Client

Read this section if you have a Windows NT workstation that has DB2
Connect installed. This section provides step-by-step instructions for setting
up the communications between your DB2 Connect workstation and a
Windows NT workstation that has Microsoft SNA Server V4.0 (or later)
installed.

For instructions on how to configure Microsoft SNA Server Version 4.0 for Windows
NT, go to “Configuring Microsoft SNA Server for Windows NT” on page 81.

Figure 11 on page 91 illustrates the example DB2 Connect Server scenario.
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The rest of this section assumes:

1. The Microsoft SNA Server has already been configured for APPC
communications with the host, and is enabled for ODBC and DRDA. Refer
to the Microsoft SNA Server documentation for further information.

DB2 for
MVS

DB2 for
VSE

DB2 for
VM

OS/390

AS/400

S/390, S/370

DB2 for
AS/400

APPC  TCP/IP***  MPTN

Coax*  Ethernet  Asynch  Twinax**
SDLC  Token-ring  X.25

*** TCP/IP connectivity requires DB2 for OS/390 V5R1, DB2 for AS/400 V4R2,
or DB2 for VM V6.1

** For AS/400
* For Host connections only

ESCON

SNA Gateway
(eg. IBM eNetwork Communications

Server, Microsoft SNA Server)

DB2 Connect Enterprise Edition
with SNA Gateway client software

IPX/SPX, NetBIOS TCP/IP

Figure 11. Indirect Connection to host or AS/400 database server via SNA Communications Gateway
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2. Microsoft SNA Client Version 2.11 is not already installed on your DB2
Connect workstation.

To configure the Microsoft SNA client perform the following steps:

Step 1. Obtain Required Information

For your Microsoft SNA client software to function properly you must have
access to a properly configured Microsoft SNA Server. Request that your SNA
Server administrator:
Step 1. Obtain the proper license for you to use Microsoft SNA Client on

your workstation.
Step 2. Define a user ID and password for you on the SNA Server domain.
Step 3. Define connections to the host and AS/400 databases that you need

to access, as described in “Configuring Microsoft SNA Server for
Windows NT” on page 81.

Step 4. Provide you with the symbolic destination name (�16�), database
name (�5�), and user account to use for each database connection
defined in the previous step.
If you plan to change host passwords, the SNA administrator will
also need to provide you with symbolic destination names for
password management tasks on each host.

Step 5. Provide you with the Microsoft SNA Server domain name and the
protocol used for communicating with the SNA server (TCP/IP,
NetBEUI, IPX/SPX).

Step 2. Install the Microsoft SNA Client on the DB2 Connect Workstation
1. Obtain the Microsoft SNA Client software, and follow its instructions to

start the installation program.
2. Follow the instructions on the screen to complete the installation. Choose

your SNA Server domain name and communication protocol according to
the instructions provided by your SNA Server administrator.

3. When you reach the Optional Components window, deselect Install
ODBC/DRDA driver so that it will not be installed.

4. Complete the installation.

Step 3. Install DB2 Connect for Windows
Step 1. Install DB2 Connect.
Step 2. Open the DB2 Folder, and click on the Client Configuration

Assistant to start the configuration dialog.
Step 3. Click on the Start button and select Programs->DB2 for Windows

NT->Client Configuration Assistant.
Step 4. You need to provide the following information:
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__ a. The Symbolic destination name (�16�) defined at the Microsoft
SNA Server for the Partner LU (�2�) of the target host or
AS/400 database server.

__ b. The real database name (�5�).

You now need to update the DB2 directories, bind utilities and applications to the
server, and test the connection.

The easiest way to do this is to use the Client Configuration Assistant (CCA). For more
information on using the CCA, go to “Chapter 7. Configuring DB2 Connect to Host or
AS/400 Communications Using the CCA” on page 65. However, you can also perform
these steps manually, as described in “Step 3. Catalog the APPC or APPN Node” and
the sections that follow.

Step 3. Catalog the APPC or APPN Node

You must add an entry to the DB2 Connect workstations’s node directory to
describe the remote node. In most cases, you will add an APPC node entry to
the node directory. For OS/2, Windows 9x, and Windows NT, you can
alternatively add an APPN node entry if your local SNA node has been set up
as an APPN node.

To catalog the node, perform the following steps:
Step 1. Log on to the system as a user with System Administrative

(SYSADM) or System Controller (SYSCTRL) authority.
Step 2. To catalog an APPC node, specify the chosen alias (node_name),

Symbolic destination name (sym_dest_name), and the APPC security
type (security_type) that the client will use for the APPC connection.
Enter the following commands:

catalog "appc node node_name remote sym_dest_name
security security_type"

terminate

The sym_dest_name parameter is case-sensitive and must exactly must
match the case of the Symbolic destination name you defined
previously.

For example, to catalog a remote database server with the Symbolic
destination name DB2CPIC on the node called db2node, using APPC
Security type program, enter the following commands:

catalog appc node db2node remote DB2CPIC security program
terminate

Step 3. To catalog an APPN node, specify the chosen alias (node_name), the
network ID (�9�), the remote partner LU (�4�), the transaction
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program name (�17�), the mode (�15�), and the security type. Enter
the following commands substituting your values from the worksheet
in Table 9 on page 76:

catalog "appn node db2node network SPIFNET remote NYM2DB2
tpname QCNTEDDM mode IBMRDB security PROGRAM"

terminate

Note: To connect to DB2 for MVS, it is recommended that you use security
PROGRAM.

If you need to change values that were set with the catalog node
command, perform the following steps:

Step 1. Run the uncatalog node command in the command line
processor as follows:

uncatalog node node_name

Step 2. Recatalog the node with the values that you want to use.

Step 4. Catalog the Database as a Database Connection Service (DCS) Database

To catalog the remote database as a Data Connection Services (DCS) database,
perform the following steps:
Step 1. Log on to the system as a user with System Administrative

(SYSADM) or System Controller (SYSCTRL) authority.
Step 2. Enter the following commands:

catalog dcs db local_dcsname as target_dbname
terminate

where:
v local_dcsname is the local name of the host or AS/400 database.
v target_dbname is the name of database on the host or AS/400

database system.

For example, to make ny the local database name for DB2 Connect,
for the remote host or AS/400 database called newyork, enter the
following commands:

catalog dcs db ny as newyork
terminate

Step 5. Catalog the Database

Before a client application can access a remote database, the database must be
cataloged on the host system node and on any DB2 Connect workstation
nodes that will connect to it. When you create a database, it is automatically
cataloged on the host with the database alias (database_alias) the same as the
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database name (database_name). The information in the database directory,
along with the information in the node directory, is used on the DB2 Connect
workstation to establish a connection to the remote database.

To catalog a database on the DB2 Connect Workstation, perform the following
steps.
Step 1. Log on to the system as a user with System Administrative

(SYSADM) or System Controller (SYSCTRL) authority.
Step 2. Fill in the Your Value column in the following worksheet.

Table 10. Worksheet: Parameter Values for Cataloging Databases

Parameter Description Sample Value Your Value

Database name
(database_name)

The local DCS database name
(local_dcsname) of the remote
database. You specified this
when you catalogued the DCS
database directory. For example,
ny.

ny

Database alias
(database_alias)

An arbitrary local nickname for
the remote database. If you do
not provide one, the default is
the same as the database name
(database_name). This is the name
that you use when connecting to
the database from a client.

localny

Node name
(node_name)

The name of the node directory
entry that describes where the
database resides. Use the same
value for node name (node_name)
that you used to catalog the
node in the previous step.

db2node

Step 3. Catalog the database by entering the following commands:
catalog database database_name as database_alias at node node_name
terminate

For example, to catalog the DCS known database ny so that it has the
local database alias localny, on the node db2node, enter the following
commands:

catalog database ny as localny at node db2node
terminate
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If you need to change values that were set with the catalog database
command, perform the following steps:

Step a. Run the uncatalog database command:

uncatalog database database_alias

Step b. Recatalog the database with the value that you want to use.

Step 6. Bind Utilities and Applications to the Database Server

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host or AS/400 system. You must now bind the utilities
and applications to the host or AS/400 database server.

To bind the utilities and applications to the host or AS/400 database server,
enter the following commands:

db2 connect to dbalias user userid using password
db2 "bind path@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public"
db2 connect reset

For example:
db2 connect to NYC3 user myuserid using mypassword
db2 "bind /sqllib/myapps@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public"
db2 connect reset

The userid and password specified must have the authority to bind
applications against the target database.

Further information about these commands can be found in the DB2 Connect
User’s Guide.

Step 7. Test the Host or AS/400 Connection

When you have finished configuring the DB2 Connect workstation for
communications, you need to test the connection to the remote database.

Enter the following command at the DB2 Connect workstation, remembering
to substitute the db_alias value you defined in “Step 3. Catalog the APPC or
APPN Node” on page 93 :

connect to db_alias user userid using password

For example, enter the following command:
connect to nyc3 user userid using password
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The userid and password values required are those defined at the host or
AS/400 system, and must be provided to you by your DB2 Administrator. For
more information, refer to the DB2 Connect User’s Guide.

If the connection is successful, you will get a message showing the name of
the database to which you have connected. You are now able to retrieve data
from that database. For example, to retrieve a list of all the table names listed
in the system catalog table, enter the following command:

"select tabname from syscat.tables"

When you are finished using the database connection, enter the connect reset
command to end the database connection.

If the connection fails, check the following items at the DB2 connect
workstation:

__ 1. The node was cataloged with the correct symbolic destination name
(sym_dest_name).

__ 2. The node name (node_name) that was specified in the database directory
points to the correct entry in the node directory.

__ 3. The database was cataloged properly, using the correct real_host_dbname
for the database on the host or AS/400 server.

If the connection still fails after you verify these items, refer to the
Troubleshooting Guide.
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Chapter 9. Enabling Multisite Updates (Two-Phase Commit)

This chapter provides an overview of the multisite update function as it
applies to scenarios that involve host and AS/400 database servers. It
describes products and components needed to implement PC, UNIX and web
applications that update multiple DB2 databases in the same transaction.

Multisite update, also known as Distributed Unit of Work (DUOW) and
Two-Phase commit, is a function that enables your applications to update data
in multiple remote database servers with guaranteed integrity. A good
example of a multisite update is a banking transaction that involves the
transfer of money from one account to another in a different database server.
In such a transaction it is critical that updates that implement debit operation
on one account do not get committed unless updates required to process
credit to the other account are committed as well. The multisite update
considerations apply when data representing these accounts is managed by
two different database servers.

DB2 products provide comprehensive support for multisite update. This
support is available for applications developed using regular SQL as well as
applications that utilize Transaction Monitor products that implement X/Open
XA interface specification. Examples of such Transaction Monitor products
include IBM TxSeries (CICS and Encina), Message and Queuing Series,
Component Broker Series, San Francisco Project as well as Microsoft
Transaction Server (MTS), BEA Tuxedo, NCR TopEnd and several others.
There are different setup requirements depending on whether native SQL
multisite update or TP Monitor multisite update is used.

Both the native SQL and TP Monitor multisite update programs must be
precompiled with the CONNECT 2 SYCNCPOINT TWOPHASE options. Both can use
the SQL Connect statement to indicate which database they want to be used
for the SQL statements that follow. If there is no TP Monitor to tell DB2 it is
going to coordinate the transaction (as indicated by DB2 receiving the xa_open
calls from the TP monitor to establish a database connection), then the DB2
software will be used to coordinate the transaction.

When using TP monitor multisite update, the application must request
commit or rollback by using the TP monitor’s API, e.g. CICS SYNCPOINT,
Encina Abort(), MTS SetAbort(). When using native SQL multisite update,
the normal SQL COMMIT and ROLLBACK must be used.
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TP Monitor multisite update can coordinate a transaction that accesses both
DB2 and non-DB2 resource managers such as Oracle, Informix, SQLServer, etc.
Native SQL multisite update is used with DB2 servers only.

For a multisite update transaction to work, each of the databases participating
in a distributed transaction must be capable of supporting Distributed Unit of
Work. At the time of this writing, the following DB2 servers provided DUOW
support that enabled them to participate in distributed transactions:
v DB2 Common Server V2
v DB2 Universal Database V5 and V6
v DB2 for MVS/ESA V3.1 and 4.1
v DB2 for OS/390 V5.1
v DB2 Universal Database for OS/390 V6.1
v DB2/400 V3.1 or later (using SNA only at this time)
v DB2 Server for VM and VSE V5.1 and 6.1

A distributed transaction can update any mix of supported database servers.
For example, your application can update several tables in DB2 Universal
Database on Windows NT, a DB2 for OS/390 database and a DB2/400
database all within a single transaction.

Host and AS/400 database servers require DB2 Connect to participate in a
distributed transaction originating from PC, UNIX, and web applications. In
addition, many of the multisite update scenarios that involve host and AS/400
database servers require that the Syncpoint Manager (SPM) component be
configured. The need for SPM is dictated by the choice of protocol (SNA vs.
TCP/IP) and use of a TP monitor. See the following table for a summary of
scenarios that require use of the SPM. The table shows that DB2 Connect is
required for any access to the host or AS/400 from Intel or UNIX machines. In
addition, for multisite updates, the SPM component of DB2 Connect is
required if the access is via SNA or uses a TP monitor.

Host and AS/400 multisite update scenarios that require SPM.

TP Monitor
Used?

Protocol SPM Needed? Product
Required
(choose One)

Host and
AS/400
Database
Supported
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Host and AS/400 multisite update scenarios that require SPM.

Yes TCP/IP Yes v DB2 Connect
Enterprise
Edition

v DB2
Universal
Database
Enterprise
Edition

v DB2
Universal
Database
Enterprise-
Extended
Edition

v DB2 for
OS/390 V5.1

v DB2
Universal
Database for
OS/390 V6.1

Yes SNA Yes v DB2 Connect
Enterprise
Edition*

v DB2
Universal
Database
Enterprise
Edition*

v DB2
Universal
Database
Enterprise-
Extended
Edition*

Note: *AIX,
OS/2 and
Windows NT
platforms only.

v DB2 for
MVS/ESA
V3.1 and 4.1

v DB2 for
OS/390 V5.1

v DB2
Universal
Database for
OS/390 V6.1

v DB2/400
V3.1 or later

v DB2 Server
for VM or
VSE V5.1 or
later
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Host and AS/400 multisite update scenarios that require SPM.

No TCP/IP No v DB2 Connect
Personal
Edition

v DB2 Connect
Enterprise
Edition

v DB2
Universal
Database
Enterprise
Edition

v DB2
Universal
Database
Enterprise-
Extended
Edition

v DB2 for
OS/390 V5.1

v DB2
Universal
Database for
OS/390 V6.1

No SNA Yes v DB2 Connect
Enterprise
Edition*

v DB2
Universal
Database
Enterprise
Edition*

v DB2
Universal
Database
Enterprise-
Extended
Edition*

Note: *AIX,
OS/2 and
Windows NT
platforms only

v DB2 for
MVS/ESA
V3.1 and 4.1

v DB2 for
OS/390 V5.1

v DB2
Universal
Database for
OS/390 V6.1

v DB2/400
V3.1 or later

v DB2 Server
for VM and
VSE V5.1 or
later

Note:

For more information about DUOW refer to the DB2 Connect User’s
Guide.

For additional information about DB2 Connect two-phase commit
support, as well as instructions for setting up for several popular TP
monitors, please see the Administration Guide or access the DB2 Product
and Service Technical Library on the World Wide Web:
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1. Set your Web browser to the following URL:
http://www.software.ibm.com/data/db2/library/

2. Select ″DB2 Universal Database″.
3. Search for ″Technotes″ using the search keywords ″DDCS″, ″SPM″,

″MTS″, ″CICS″, and ″ENCINA″.

Enabling Multisite Updates Using the Control Center

As of Version 6, you can use the Control Center to provide multisite update.
The procedure is very simple, and is outlined below. For more information
about the multisite update configuration process, including how to configure
your system manually, refer to the on-line Connectivity Supplement.

Starting the Multisite Update Smartguide

From the Control Center, click on the [+] sign to expand the tree view. With
the right mouse button, select the instance that you wish to configure. A
popup menu opens. Select Multisite Update->Configure from this menu.

Smartguide Steps

The Smartguide provides a notebook-type interface. Each page of the
notebook will prompt you for certain information about your configuration.
The pages are shown below in the order in which you will encounter them.
Step 1. Specify a Transaction Processor (TP) monitor.

This field will show the defaults for the TP Monitor you have
enabled. If you do not wish to use a TP monitor, select Do Not Use a
TP Monitor.

Step 2. Specify the communications protocols you will use.
Step 3. Specify a Transaction Manager database.

This panel defaults to the first database you connect to (1ST_CONN).
You can leave this default or select another catalogued database.

Step 4. Specify the types of database servers involved in the update, and also
whether or not TCP/IP is to be used exclusively.

Step 5. Specify the Syncpoint Manager settings.
This page will only appear if the settings on the previous page
indicate that you need to use DB2’s Syncpoint Manager in a multisite
update scenario.

Testing the Multisite Update Feature
Step 1. Select the instance with the right mouse button and choose the

Multisite Update->Test menu option from the pop-up menu. The
Test Multi-Site Update window opens.
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Step 2. Select the databases you wish to test from the available databases in
the left sub-window. You can use the arrow buttons in the middle to
move selections to and from the Selected Databases sub-window.

Step 3. When you have finished your selection, press the Test... button at the
bottom of the window. The Multi-Site Update Test Result window
opens.

Step 4. The Multi-Site Update Test Result window shows which of the
databases you selected succeeded or failed the update test. The
window will show sql codes and error messages for those that failed.
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Part 5. Installing and Configuring Clients
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Chapter 10. Installing DB2 Clients

This section describes how to install a DB2 Administration Client, a DB2
Run-Time Client, or a DB2 Software Developer’s Kit on your workstation. For
information on how to deploy this product using a distributed installation,
refer to the Installation and Configuration Supplement.

DB2 Administration Clients are available for the following platforms: AIX,
HP-UX, Linux, OS/2, Silicon Graphics IRIX, Solaris, Windows 9x, and
Windows NT. For more information on using Administration Client tools, see
“Appendix C. Using the Control Center to Administer DB2 for OS/390 and
DB2 Connect Enterprise Edition servers” on page 167.

DB2 Run-Time Clients and DB2 Software Developer’s Kits are available for
the following platforms: AIX, HP-UX, Linux, OS/2, Silicon Graphics IRIX,
Solaris, Windows 9x, and Windows NT.

Clients that connect to a server must have the appropriate DB2
Administration Client, DB2 Run-Time Client, or DB2 Software Developer’s Kit
installed.

You may install a DB2 client on any number of workstations. For information
about licensing, refer to your License Information Booklet.

Go to the section that provides installation instructions for the DB2
client that you want to install:

v “Chapter 11. Installing DB2 Clients on Windows 32-Bit Operating
Systems” on page 109

v “Chapter 12. Installing DB2 Clients on OS/2 Operating Systems” on
page 113

For information on how to install all other Version 6 DB2 clients or DB2
Software Developer’s Kits, refer to the Installation and Configuration
Supplement.

To download installation packages for all supported DB2 clients, which
include pre-Version 6 DB2 clients such as DOS, Macintosh, SCO
OpenServer, SCO Unixware, SINIX, and Windows 3.x, connect to the
IBM DB2 Client Application Enabler Web site at
http://www.software.ibm.com/data/db2/db2tech/clientpak.html.
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Chapter 11. Installing DB2 Clients on Windows 32-Bit
Operating Systems

This section contains the information you need to install a DB2 client or DB2
Software Developer’s Kit on Windows 32-bit operating systems.

Before You Begin

Before you begin the installation, be sure that you have the following items
and information:
__ 1. Ensure that your system meets all of the memory, hardware, and

software requirements to install your DB2 product. For more
information, see “Chapter 2. Planning for Installation” on page 23.

__ 2. A user account to perform the installation.

Windows 9x
Any valid Windows 9x user.

Windows NT
Any user account that does not belong to the Guests group on
the machine where the account is defined.

Installation Steps

To install a DB2 Client or Software Developer’s Kit, perform the following
steps:
Step 1. Log on to the system with the user account that you created to

perform the installation.
Step 2. Shut down any other programs so that the setup program can update

files as required.
Step 3. Insert the appropriate CD-ROM into the drive. The auto-run feature

automatically starts the setup program. The setup program will
determine the system language, and launch the setup program for
that language. If you want to run the setup program in a different
language, or the setup program failed to auto-start, see the tip that
follows.
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To manually invoke the setup program, perform the following steps:

a. Click on Start and select the Run option.

b. In the Open field, enter the following command:

x:\setup /i language

where:

v x: represents your CD-ROM drive

v language represents the country code for your language (for
example, EN for English). Table 12 on page 171 lists the code
for each available language.

c. Click on OK.

Step 4. The Welcome window opens.

Step 5. Respond to the setup program’s prompts. Online help is available to
guide you through the remaining steps. Invoke online help by
clicking on the Help push button, or by pressing the F1 key at any
time.
You can click on the Cancel push button at any time to end the
installation.
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For information on errors encountered during installation, see the
db2.log file. The db2.log file stores general information and error
messages resulting from the install and uninstall activities. By
default, the db2.log file is located in the x:\db2log directory, where
x: represents the drive on which your operating system is installed.

For more information, refer to the Troubleshooting Guide.

The setup program has:
v Created DB2 program groups and items (or shortcuts).
v Updated the Windows registry.
v Created a default client instance called DB2.

To configure your client to access remote servers, go to “Chapter 13.
Configuring Client-to-Server Communications Using the Client
Configuration Assistant” on page 115.
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Chapter 12. Installing DB2 Clients on OS/2 Operating
Systems

This section contains the information that you need to install a DB2 client or
Software Developer’s Kit on OS/2 operating systems. If you have a
pre-Version 6 DB2 client for OS/2, the WIN-OS/2 support installed will be
kept at its current level.

Before You Begin

Before you begin the installation, be sure that you have the following items
and information:
__ 1. Ensure that your system meets all of the memory, hardware, and

software requirements to install your DB2 product. For more
information, see “Chapter 2. Planning for Installation” on page 23.

__ 2. The protocol to be used for host connectivity:
__ a. SNA
__ b. TCP/IP
__ c. MPTN

__ 3. A user ID to perform the installation.
If UPM is installed, the user ID you specify must have Administrator or
Local Administrator authority. Create a user ID with these characteristics
if necessary.
If UPM is not installed, DB2 will install it and set up the userid USERID
with password PASSWORD.

__ 4. To verify that DB2 installed correctly, you will need to have a user
account that belongs to the System Administrative (SYSADM) group, is
8 characters or less, and complies with all of DB2’s naming rules.
By default, any user that belongs to the Local Administrators group, on
the local machine where the account is defined, has SYSADM authority
on the instance. For more information, see “Working with the System
Administrative Group” on page 148. For more information on valid
DB2 usernames, see “Appendix F. Naming Rules” on page 177.
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Installation Steps

To install a DB2 client or Software Developer’s Kit for OS/2, perform the
following steps:
Step 1. Insert the appropriate CD-ROM into the drive.
Step 2. Open an OS/2 command window and set the directory to your

CD-ROM drive by entering the following command:
x:\install

where x: represents your CD-ROM drive.
Step 3. The Welcome window opens.

Step 4. Respond to the install program’s prompts. Online help is available to
guide you through the remaining steps. Invoke online help by
clicking on the Help push button, or by pressing the F1 key at any
time.

For information on errors encountered during installation, see the
l1.log and l2.log files. These files store general information and
error messages resulting from installation and uninstall activities. By
default, these files are located in the x:\db2log directory; where x:
represents the drive on which your operating system is installed.

For more information, refer to the Troubleshooting Guide.

To configure your client to access remote servers, go to “Chapter 13.
Configuring Client-to-Server Communications Using the Client
Configuration Assistant” on page 115.
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Chapter 13. Configuring Client-to-Server Communications
Using the Client Configuration Assistant

To configure communications from a DB2 client to a server, the remote
server must be configured to accept inbound client requests. By default,
the server installation program automatically detects and configures
most protocols on the server for inbound client connections.

If you have added a new protocol to your network that is not detectable,
or wish to modify any of the default settings, refer to the Installation and
Configuration Supplement.

If you are adding a host or AS/400 database, go to “Chapter 7.
Configuring DB2 Connect to Host or AS/400 Communications Using the
CCA” on page 65.

The information in this section describes how to use the Client Configuration
Assistant (CCA) to configure your OS/2, Windows 9x, or Windows NT clients
to access remote servers. To complete the steps in this section, you should be
familiar with how to start the CCA, for more information, see “Starting the
Client Configuration Assistant” on page 143.

With the CCA, you can:

v Configure database connections that applications can use.
v Update or delete existing configured database connections.
v Display the information for existing configured connections.
v Test a connection to a database.
v Enable or disable databases to be configured as CLI or ODBC data sources.
v Export client profiles, or import client and server profiles which contain

information for the setup of a client.
v Update client configuration settings.
v Discover remote databases (if enabled).
v Bind user applications and utilities to databases.
v Change your server password.

The CCA provides three methods to set up a database connection to a server:
v Using a profile.
v Searching the network for databases.
v Manually entering database and communication protocol information for a

server.
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When you add a database using this configuration method, the
Client Configuration Assistant will generate a default node name for
the server where the database resides.

Configuration Steps

To configure your workstation to access a database on a remote server,
perform the following steps:
Step 1. Log on to the system with a valid DB2 user ID. For more

information, see “Appendix F. Naming Rules” on page 177.

If you are adding a database to a system that has a DB2 Connect
server product installed, log on to this system as a user with System
Administrative (SYSADM) or System Controller (SYSCTRL) authority
on the instance. For more information, see “Working with the System
Administrative Group” on page 148.

This restriction is controlled by the catalog_noauth database manager
configuration parameter. For more information, refer to the
Administration Guide.

Step 2. Start the CCA. For more information, see “Starting the Client
Configuration Assistant” on page 143.
The Welcome window opens each time you start the CCA, until you
add at least one database to your client.

Step 3. Click on the Add Database or Add push button to configure a
connection.

Go to the section that describes the configuration method that you want
to use:

v “Adding a Database Using a Profile”.

v “Adding a Database Using Discovery” on page 118.

v “Adding a Database Manually” on page 120.

Adding a Database Using a Profile

A profile contains information about instances and databases on a system, and
databases within each instance. For information on profiles, see “Creating and
Using Profiles” on page 122.

If your administrator provided you with a profile, perform the following
steps:

Step 1. Select the Use an access profile radio button and click on the Next
push button.

116 Quick Beginnings for OS/2 and Windows NT



Step 2. Click on the ... push button and select a profile.
Step 3. Enter a local database alias name in the Database alias field and add

a comment that describes this database in the Comment field. Click
on the Next push button.

If you do not specify a database alias name, the default will be the
same as the remote database alias name.

Step 4. Register this database as an ODBC data source.

If you are not planning to use ODBC, click on the Done push button
and go to the next step.

a. Ensure that the Register this database for ODBC check box is
selected.

b. Select the radio button that describes how you would like to
register this database:
v If you would like all users on your system to have access to

this data source, select the As a system data source radio
button.

v If you would like only the current user to have access to this
data source, select the As a user data source radio button.

c. If you would like to create an ODBC data source file to share
database access, select the Create a file data source check box and
enter the path and filename for this file in the File data source
name field.

d. Click on the Optimize for application drop down box and select
the application for which you want to tune the ODBC settings.

e. Click on the Done push button to add the database that you
selected. The Confirmation window opens.

Step 5. Click on the Test Connection push button to test the connection. The
Connect to DB2 Database window opens.
If the database that you want to add was not added successfully,
click on the Change push button to change any settings that you may
have incorrectly specified or click on the Help push button for more
information. For even more detailed information, refer to the
Troubleshooting Guide.

Step 6. Enter your user ID and password and click on OK. If the connection
is successful, a message confirming the connection appears.

Step 7. You are now able to use this database. To finish using the Add
Database SmartGuide, click on the Close push button; you can then
add more databases by clicking on the Add push button or exit the
CCA.
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Adding a Database Using Discovery

This option cannot return information about pre-Version 5 DB2
systems or any systems where an Administration Server is not
running. For more information, refer to the Administration Guide.

You can use the Discovery feature to search the network for databases. To add
a database to your system using Discovery, perform the following steps:
Step 1. Select the Search the network radio button and click on the Next

push button.
Step 2. Click on the [+] sign beside the Known Systems icon to list all the

systems known to your client.
Step 3. Click on the [+] sign beside a system to get a list of the instances and

databases on it. Select the database that you want to add, click on the
Next push button, and proceed to Step 4.
If the system that contains the database that you want to add is not
listed, perform the following steps:
a. Click on the [+] sign beside the Other Systems (Search the

network) icon to search the network for additional systems.
b. Click on the [+] sign beside a system to get a list of the instances

and databases on it.
c. Select the database that you want to add, click on the Next push

button, and proceed to Step 4.

The Client Configuration Assistant may be unable to detect a remote
system if:

v The Administration Server is not running on the remote system.

v The Discovery function times out. By default, the Discovery
function will search the network for 40 seconds; this may not be
long enough to detect the remote system. You can set the
DB2DISCOVERYTIME registry variable to specify a longer period
of time.

v The network that the Discovery request is running on is
configured so that the Discovery request does not reach the remote
system desired.

v You are using NetBIOS as the Discovery protocol. You may need
to set the DB2NBDISCOVERRCVBUFS registry variable to a larger
value to enable the client to receive more concurrent Discovery
replies.

For more information, refer to the Administration Guide.

If the system that you want to add is still not listed, it can be added
to the list of systems by performing the following steps:
a. Click on the Add System push button
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b. Enter the required communication protocol parameters for the
remote Administration Server and click on OK. A new system is
added. For more information, click on the Help push button.

c. Select the database that you want to add and click on the Next
push button.

Step 4. Enter a local database alias name in the Database alias field and add
a comment that describes this database in the Comment field. Click
on the Next push button.

If you do not specify a database alias name, the default will be the
same as the remote database alias name.

Step 5. Register this database as an ODBC data source.

If you are not planning to use ODBC, click on the Done push button
and go to the next step.

a. Ensure that the Register this database for ODBC check box is
selected.

b. Select the radio button that describes how you would like to
register this database:
v If you would like all users on your system to have access to

this data source, select the As a system data source radio
button.

v If you would like only the current user to have access to this
data source, select the As a user data source radio button.

c. If you would like to create an ODBC data source file to share
database access, select the Create a file data source check box and
enter the path and filename for this file in the File data source
name field.

d. Click on the Optimize for application drop down box and select
the application for which you want to tune the ODBC settings.

e. Click on the Done push button to add the database that you
selected. The Confirmation window opens.

Step 6. Click on the Test Connection push button to test the connection. The
Connect to DB2 Database window opens.
If the database that you want to add was not added successfully,
click on the Change push button to change any settings that you may
have incorrectly specified or click on the Help push button for more
information. For even more detailed information, refer to the
Troubleshooting Guide.

Step 7. Enter your user ID and password and click on OK. If the connection
is successful, a message confirming the connection appears.
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Step 8. You are now able to use this database. To finish using the Add
Database SmartGuide, click on the Close push button; you can then
add more databases by clicking on the Add push button or exit the
CCA.

Adding a Database Manually

If you have the protocol information for the server that you want to connect
to, you can manually enter all of the configuration information. This method
is analogous to entering commands via the command line processor, however,
the parameters are presented graphically for you.

To add a database to your system manually, perform the following steps:
Step 1. Select the Manually configure a connection to a DB2 database radio

button and click on the Next push button.

If you are not using Lightweight Directory Access Protocol (LDAP), this
tab will not be shown, skip this step and go to Step 3.

Step 2. Select the radio button that corresponds to the location where you
would like your DB2 directories to be maintained.
v If you would like to maintain the DB2 directories locally, select the

Add database to your local machine radio button and click on the
Next push button.

v If you would like to maintain the DB2 directories globally at an
LDAP server, select the Add database using LDAP radio button
and click on the Next push button.

Step 3. Select the radio button that corresponds to the protocol that you want
to use from the Protocol list and click on the Next push button.

If you have installed a DB2 Connect product or the DB2 Connect
Server Support feature available with DB2 Enterprise Edition or DB2
Enterprise - Extended Edition, and have selected the TCP/IP or
APPC radio button, select the radio button from the Target
operating system list that corresponds to the type of system where
the database that you are trying to connect to resides.

Step 4. Enter the required communication protocol parameters and click on
the Next push button. For more information, click on the Help push
button.

Step 5. Enter the database alias name of the remote database that you want
to add in the Database name field and a local database alias name in
the Database alias field. Add a comment that describes this database
in the Comment field and click on the Next push button.
If you are adding a database that resides on a host or AS/400 system,
the Database name field will appear as follows:
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OS/390 or MVS
Location name

AS/400
RDB name

VM or VSE
DBNAME

When a database is created on the remote server, if a database alias
is not specified during database creation, the database is created with
a database alias=database_name; otherwise, the database alias is the
name that was specified when the database was created.

Step 6. Register this database as an ODBC data source.
a. Ensure that the Register this database for ODBC check box is

selected.
b. Select the radio button that describes how you would like to

register this database:
v If you would like all users on your system to have access to

this data source, select the As a system data source radio
button.

v If you would like only the current user to have access to this
data source, select the As a user data source radio button.

c. If you would like to create an ODBC data source file to share
database access, select the Create a file data source check box and
enter the path and filename for this file in the File data source
name field.

d. Click on the Optimize for application drop down box and select
the application for which you want to tune the ODBC settings.

e. Click on the Done push button to add the database that you
selected. The Confirmation window opens.

If you are adding a database using the manual method, you can also
select the Node Options tab, the Security Options tab, or the Host or
AS/400 Options tab (if you are adding a host or AS/400 database) to
specify more detailed catalog information. Refer to the online help in
each tab for more information.

If you want to use the default settings for the node, security, and host or
AS/400 (if applicable) options, click on the Done push button and go to
the next step.

Step 7. Click on the Test Connection push button to test the connection. The
Connect to DB2 Database window opens.
If the database that you want to add was not added successfully,
click on the Change push button to change any settings that you may
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have incorrectly specified or click on the Help push button for more
information. For even more detailed information, refer to the
Troubleshooting Guide.

Step 8. Enter your user ID and password and click on OK. If the connection
is successful, a message confirming the connection appears.

Step 9. You are now able to use this database. To finish using the Add
Database SmartGuide, click on the Close push button; you can then
add more databases by clicking on the Add push button or exit the
CCA.

You can use the Export feature of the CCA to create a Client Profile
for an existing client configuration and use it to create identical
target clients across your network. A Client Profile contains database
connection, ODBC/CLI, and configuration information for an
existing client. Use the CCA Import feature to set up multiple clients
across your network. Each target client will have the same
configuration and settings as the existing client. For more
information on creating and using Client Profiles, see “Creating and
Using Profiles”.

You have now completed all the tasks that are involved in Quick
Beginnings and are ready to start using DB2 Connect.

If you want to deploy this product using a distributed installation, refer
to the Installation and Configuration Supplement.

Creating and Using Profiles

The information in this section describes how to create and use profiles to set
up connections between DB2 clients and servers. You can use either a Server
Profile or a Client Profile to configure database connections on a client.

Go to the section that describes the type of profile that you want to use:

v “Server Profiles”.

v “Client Profiles” on page 123.

Server Profiles

A Server Profile contains information about instances on a server system, and
databases within each instance. The information for each instance includes the
protocol information required to set up a client to connect to databases in that
instance.

To generate a Server Profile, use the Export Server Profile function provided
in the Control Center. When a profile is generated, it includes instances that
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have the discover_inst database manager configuration parameter and
databases with the discover_db database configuration parameter set to
ENABLE. The discover parameter in the Administration Server’s configuration
file must be set to either SEARCH or KNOWN to generate a profile for a
server system.

The default settings for these configuration parameters enable you to discover
all instances and databases on your network. For information on setting the
discover_inst, discover_db, and discover configuration parameters, refer to the
Administration Guide.

We recommend that you create a Server Profile only after you have
created the DB2 databases that you want your remote clients to
access.

To create a Server Profile, perform the following steps:
Step 1. Start the Control Center. For more information, refer to “Starting the

Control Center” on page 144.

Step 2. Select the system that you want to create a profile for and click on
the right mouse button.

If the system that you want to create a profile for is not shown,
select the Systems icon, click on the right mouse button, and select
the Add option. Click on the Help push button and follow the
online help.

Step 3. Select the Export server profile option.
Step 4. Enter a path and filename for this profile and click on the Export

push button.

You are ready to use this profile on your system. For more information
on how to add a database to your system using a Server Profile, go to
“Configuration Steps” on page 116.

Client Profiles

Information in a Client Profile can be used to configure clients using the
Import function in the Client Configuration Assistant (CCA). These clients can
import all or a subset of the configuration information in a profile.

This scenario assumes that the database connections configured on
one client will be exported and used to set up one or more clients.
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A Client Profile is generated from a client using the Export function of the
CCA. The information contained in a Client Profile is determined during the
export process. Depending on the settings chosen, it can contain the existing
client’s:
v Database connection information (including CLI or ODBC settings).
v Client settings (including database manager configuration parameters, DB2

registry variables).
v CLI or ODBC common parameters.
v Configuration data for the local APPC or NetBIOS communications

subsystem.

To create a Client Profile, perform the following steps:
Step 1. Start the CCA. For more information, see “Starting the Client

Configuration Assistant” on page 143.

Step 2. Click on the Export push button. The Select Export Option window
opens.

Step 3. Select one of the following export options:
v If you want to create a profile that contains all of the databases

cataloged on your system, and all of the configuration information
for this client, select the All radio button, click on OK, and go to
Step 6.

v If you want to create a profile that contains all of the databases
cataloged on your system without any of the configuration
information for this client, select the Database connection
information radio button, click on OK, and go to Step 6.

v If you want to select a subset of the databases that are cataloged
on your system, or a subset of the configuration information for
this client, select the Customize radio button, click on OK, and go
to the next step.

Step 4. Select the databases to be exported from the Available DB2
databases box and add them to the Selected databases box by
clicking on the > push button.

To add all of the available databases to the Databases to be exported
box, click on the >> button.

Step 5. Select the check boxes from the Select custom export option box that
correspond to the options that you want to set up for the target
client.
To customize settings, click on the appropriate Customize push
button. The settings that you customize will only affect the profile to
be exported, no changes will be made to your workstation. For more
information, click on the Help push button.
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Step 6. Click on OK. The Export Client Profile window opens.
Step 7. Enter a path and file name for this Client Profile and click on OK.

The DB2 Message window opens.
Step 8. Click on OK.

To import a Client Profile, perform the following steps:
Step 1. Start the CCA. For more information, see “Starting the Client

Configuration Assistant” on page 143.

Step 2. Click on the Import push button. The Select Profile window opens.
Step 3. Select a Client Profile to import and click on OK. The Import Profile

window opens.
Step 4. You can select to import all or a subset of the information in a

Client Profile. Select one of the following import options:
v To import all the databases defined in a Client Profile, select the

All radio button.
v To import a specific database, or settings, that are defined in a

Client Profile, select the Customize radio button. Select the check
boxes that correspond to the options that you want to customize.

Step 5. Click on OK.

If you selected the All radio button, you are now ready to start using
your DB2 product. For more advanced topics, refer to the Administration
Guide and the Installation and Configuration Supplement online document.

Step 6. You are presented with a list of systems, instances, and databases.
Select the database that you want to add and click on the Next push
button.

Step 7. Enter a local database alias name in the Database alias field and
add a comment that describes this database in the Comment field.
Click on the Next push button.

If you do not specify a database alias name, the default will be the
same as the remote database alias name.

Step 8. Register this database as an ODBC data source.

If you are not planning to use ODBC, click on the Done push button
and go to the next step.

a. Ensure that the Register this database for ODBC check box is
selected.

b. Select the radio button that describes how you would like to
register this database:
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v If you would like all users on your system to have access to
this data source, select the As a system data source radio
button.

v If you would like only the current user to have access to this
data source, select the As a user data source radio button.

c. If you would like to create an ODBC data source file to share
database access, select the Create a file data source check box
and enter the path and filename for this file in the File data
source name field.

d. Click on the Optimize for application drop down box and select
the application for which you want to tune the ODBC settings.

e. Click on the Done push button to add the database that you
selected. The Confirmation window opens.

Step 9. Click on the Test Connection push button to test the connection. The
Connect to DB2 Database window opens.
If the database that you want to add was not added successfully,
click on the Change push button to change any settings that you may
have incorrectly specified or click on the Help push button for more
information. For even more detailed information, refer to the
Troubleshooting Guide.

Step 10. Enter your user ID and password and click on OK. If the connection
is successful, a message confirming the connection appears.

Step 11. You are now able to use this database. To finish using the Add
Database SmartGuide, click on the Close push button; you can then
add more databases by clicking on the Add push button or exit the
CCA.
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Part 6. Using DB2 Connect
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Chapter 14. Running Your Own Applications

Various types of applications can access DB2 databases:
v Applications developed using the DB2 Software Developer’s Kit that

include embedded SQL, APIs, stored procedures, user-defined functions or
calls to the DB2 CLI.

v ODBC applications such as Lotus Approach.
v JDBC applications and applets.
v Net.Data macros containing HTML and SQL.

An application on a DB2 client can access a remote database without knowing
its physical location. The DB2 client determines the location of the database,
manages the transmission of the requests to the database server, and returns
the results.

In general, to run a database client application, use the following steps:
1. Ensure the server is configured and running.

Be sure that the database manager is started on the database server to
which the application program is connecting. If it is not, you must issue
the db2start command at the server before starting the application.

2. Ensure that you can connect to the database that the application uses.
3. Bind the utilities and the applications to the database. See “Binding

Database Utilities” for information about binding the utilities.

4. Run the application program.

Binding Database Utilities

You must bind the database utilities (import, export, reorg, the command line
processor) and DB2 CLI bind files to each database before they can be used
with that database. In a network environment, if you are using multiple
clients that run on different operating systems or are at different versions or
service levels of DB2, you must bind the utilities once for each operating
system and DB2-version combination.

Binding a utility creates a package, which is an object that includes all of the
information that is needed to process specific SQL statements from a single
source file.
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The bind files are grouped together in different .lst files in the bnd directory,
under the installation directory (typically sqllib). Each file is specific to a
server.

Binding to Host Databases

To bind the utilities and applications to the DRDA server, connect to the
DRDA server and use commands similar to the following:

connect to dbalias user userid using password
bind path/bnd/@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public
connect reset

where path corresponds to the DB2PATH registry value. These commands are
described in detail in the DB2 Connect User’s Guide.

Running CLI/ODBC Programs

The DB2 Call Level Interface (CLI) run-time environment and the DB2
CLI/ODBC driver are included with DB2 clients as optional components
during install.

This support enables applications developed using ODBC and DB2 CLI APIs
to work with any DB2 server. DB2 CLI application development support is
provided by the DB2 Software Developer’s Kit (DB2 SDK) which is packaged
with your DB2 server.

Before DB2 CLI or ODBC applications can access DB2, the DB2 CLI packages
must be bound on the server. Although this will occur automatically on the
first connection if the user has the required authority to bind the packages, it
is recommended that the administrator do this first with each version of the
client on each platform that will access the server. See “Binding Database
Utilities” on page 129 for specific details.

The following general steps are required on the client system to give DB2 CLI
and ODBC applications access to DB2 databases. These instructions assume
that you have successfully connected to DB2 using a valid user ID and
password. Depending on the platform many of these steps are automatic. For
complete details, see the section that deals specifically with your platform.

Step 1. Use the Client Configuration Assistant (CCA) to add the database (if
you have separate client and server machines) so that its instances
and databases can be made known to the Control Center, then add
the instances and databases for that system. (Your local system is
represented by Local icon.) If you do not have access to this program
you can use the catalog command in the command line processor.
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Step 2. On all platforms other than OS/2 the DB2 CLI/ODBC driver is an
optional component during the DB2 client install. Be sure it is
selected at that point. On OS/2 you must use the Install ODBC
Driver icon to install both the DB2 CLI/ODBC driver and the ODBC
driver manager.

Step 3. To access the DB2 database from ODBC:
a. The ODBC Driver Manager (From Microsoft or other vendor)

must already be installed (this is done by default during the
installation of DB2 only on 32-bit Windows systems).

b. The DB2 databases must be registered as ODBC data sources. The
ODBC driver manager does not read the DB2 catalog information;
instead it references its own list of data sources.

c. If a DB2 table does not have a unique index then many ODBC
applications will open it as read-only. A unique index should be
created for each DB2 table that is to be updated by an ODBC
application. Refer to the CREATE INDEX statement in the SQL
Reference. Using the Control Center you would alter the settings of
the table, then select the Primary Key tab and move one or more
columns from the available columns list over to the primary key
columns list. Any column you select as part of the primary key
must be defined as NOT NULL.

Step 4. If necessary, you can set various CLI/ODBC Configuration Keywords
to modify the behavior of DB2 CLI/ODBC and the applications using
it.

If you followed the above steps to install ODBC support, and added DB2
databases as ODBC data sources, your ODBC applications will now be able to
access them.

Platform Specific Details for CLI/ODBC Access

The platform specific details on how to give DB2 CLI and ODBC
applications access to DB2 are divided into the following categories:

v “Windows 32-bit operating systems Client Access to DB2 using
CLI/ODBC”

v “OS/2 Client Access to DB2 using CLI/ODBC” on page 133

Windows 32-bit operating systems Client Access to DB2 using CLI/ODBC

Before DB2 CLI and ODBC applications can successfully access a DB2
database from a Windows client, perform the following steps on the client
system:
Step 1. The DB2 database (and node if the database is remote) must be

cataloged. To do so, use the CCA (or the command line processor).
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For more information refer to the on-line help in the CCA (or the
CATALOG DATABASE and CATALOG NODE commands in the
Command Reference).

Step 2. Verify that the Microsoft ODBC Driver Manager and the DB2
CLI/ODBC driver are installed. On Windows 32-bit operating
systems they are both installed with DB2 unless the ODBC
component is manually unselected during the install.
To verify that they both exist on the machine:
a. Run the Microsoft ODBC Administrator from the icon in the

Control Panel, or issue the appropriate command from the
command line: odbcad32.exe.

b. Click on the ODBC Drivers tab.
c. Verify that ″IBM DB2 ODBC DRIVER″ is shown in the list.

If either the Microsoft ODBC Driver Manager or the IBM DB2
CLI/ODBC driver is not installed, then rerun the DB2 install and
select the ODBC component on Windows 32-bit operating systems.

Step 3. Register the DB2 database with the ODBC driver manager as a data
source. On Windows 32-bit operating systems you can make the data
source available to all users of the system (a system data source), or
only the current user (a user data source). Use either of these
methods to add the data source:
v Using the CCA:

a. Select the DB2 database alias that you want to add as a data
source.

b. Click on the Properties push button. The Database Properties
window opens.

c. Select the Register this database for ODBC check box.
d. On Windows 32-bit operating systems you can use the radio

buttons to add the data source as either a user or system data
source.

v Using the Microsoft 32-bit ODBC Administration tool, which you
can access from the icon in the Control Panel or by running
odbcad32.exe from the command line:
a. On Windows 32-bit operating systems the list of user data

sources appears by default. If you want to add a system data
source click on the System DSN button, or the System DSN
tab (depending on the platform).

b. Click on the Add push button.
c. Double-click on the IBM DB2 ODBC Driver in the list.
d. Select the DB2 database to add and click on OK.
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v On Windows 32-bit operating systems there is a command that can
be issued in the command line processor to register the DB2
database with the ODBC driver manager as a data source. An
administrator could create a command line processor script to
register the required databases. This script could then be run on all
of the machines that require access to the DB2 databases through
ODBC.
The Command Reference contains more information on the
CATALOG command:

CATALOG [ user | system ] ODBC DATA SOURCE

Step 4. Configure the DB2 CLI/ODBC driver using the CCA: (Optional)
a. Select the DB2 database alias you want to configure.
b. Click on the Properties push button. The Database Properties

window opens.
c. Click on the Settings push button. The CLI/ODBC Settings

window opens.
d. Click on the Advanced push button. You can set the configuration

keywords in the window that opens. These keywords are
associated with the database alias name, and affect all DB2
CLI/ODBC applications that access the database. The online help
explains all of the keywords, as does an appendix in the
Installation and Configuration Supplement online manual.

Step 5. If you have installed ODBC access (as described above), you can
now access DB2 data using ODBC applications. Start the ODBC
application and go to the Open window. Select the ODBC databases
file type. The DB2 databases that you added as ODBC data sources
will be selectable from the list. Many ODBC applications will open
the table as read-only unless a unique index exists.

OS/2 Client Access to DB2 using CLI/ODBC

Before DB2 CLI and ODBC applications can successfully access a DB2
database from an OS/2 client, perform the following steps on the client
system:
1. The DB2 database (and node if the database is remote) must be cataloged.

To do so, use the CCA (or the command line processor).
For more information see the on-line help in the CCA

2. If you are using ODBC applications to access DB2 data, perform the
following steps. (If you are using only CLI applications, skip this step and
go to the next step.)
a. Check that there is an ODBC Driver Manager installed. The ODBC

Driver Manager is not installed with DB2; we suggest you use the
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Driver Manager that was shipped with your ODBC application. Also
ensure that the DB2 CLI/ODBC driver is installed:
1) Run the ODBC Administration tool as described in its

documentation. This is usually done in one of two ways:
v Double-click on the ODBC Folder in OS/2, and double-click on

the ODBC Administrator icon.
v Run odbcadm.exe from the command line.

The Data Sources window opens.
2) Click on the Drivers push button. The Drivers window opens.
3) Verify that ″IBM DB2 ODBC DRIVER″ is shown in the list.

If the ODBC Driver Manager is not installed then follow the
installation instructions that came with your ODBC application. If the
IBM DB2 CLI/ODBC driver is not installed then double-click on the
Install ODBC Driver icon in the DB2 folder to install the DB2
CLI/ODBC driver.

b. Register the DB2 database with the ODBC driver manager as a data
source using either of these methods:
v Using the CCA:

1) Select the DB2 database alias that you want to add as a data
source.

2) Click on the Properties push button.
3) Select the Register this database for ODBC check box.

v Using the ODBC Driver Manager:
1) Run the ODBC Driver Manager, as described in its

documentation. This is usually done in one of two ways:
– Double-click on the ODBC Folder in OS/2, and double-click

on the ODBC Administrator icon.
– Run odbcadm.exe from the command line.

2) Click on the Add push button from the Data Sources window.
The Add Data Source Window opens.

3) Double-click on the IBM DB2 ODBC DRIVER in the list.
4) Select the DB2 database to add and click on OK.

3. Configure the DB2 CLI/ODBC driver using the CCA: (Optional)
a. Select the DB2 database alias you want to configure.
b. Click on the Properties push button. The Database Properties window

opens.
c. Click on the Settings push button. The CLI/ODBC Settings window

opens.
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d. Click on the Advanced push button. You can set the configuration
keywords in the window that appears. These keywords are associated
with the database alias name, and affect all DB2 CLI/ODBC
applications that access the database. The online help explains all of
the keywords, as does an appendix in the Installation and Configuration
Supplement manual.

4. If you have installed ODBC access (as described above), you can now
access DB2 data using ODBC applications. Start the ODBC application and
go to the Open window. Select the ODBC databases file type. The DB2
databases that you added as ODBC data sources will be selectable from
the list. Many ODBC applications will open the table as read-only unless a
unique index exists.

Detailed Configuration Information

The section “Platform Specific Details for CLI/ODBC Access” on page 131
should provide you with all of the information you require. Installation and
Configuration Supplement includes additional information on setting up and
using DB2 CLI and ODBC applications. This information is useful where DB2
tool support is not available, and for administrators who require more
detailed information.

The following topics are covered in the Installation and Configuration
Supplement online manual:

v How to Bind the DB2 CLI/ODBC Driver to the Database
v How to Set CLI/ODBC Configuration Keywords
v Configuring db2cli.ini

Running Java Programs

You can develop Java programs to access DB2 databases with the appropriate
Java Development Kit (JDK) on AIX, HP-UX, Linux, OS/2, Silicon Graphics
IRIX, Solaris, or Windows 32-bit operating systems. The JDK includes Java
Database Connectivity (JDBC), a dynamic SQL API for Java.

For DB2 JDBC support, you must include the DB2 Java Enablement
component when you install the DB2 client. With DB2 JDBC support you can
build and run JDBC applications and applets. These contain dynamic SQL
only, and use a Java call interface to pass SQL statements to DB2.

The DB2 Software Developer’s Kit (DB2 SDK) provides support for Java
embedded SQL (SQLJ). With DB2 SQLJ support and DB2 JDBC support you
can build and run SQLJ applications and applets. These contain static SQL
and use embedded SQL statements that are bound to the DB2 database.
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Java can also be used on the server to create JDBC and SQLJ stored
procedures and user-defined functions (UDFs).

Building and running different types of Java programs requires support from
different components of DB2:
v To build JDBC applications, you must install a DB2 client with the DB2 Java

Enablement component. To run JDBC applications, your DB2 client with the
DB2 Java Enablement component must connect to a DB2 server.

v To build SQLJ applications, you must install the DB2 SDK and a DB2
Administrative Client with the DB2 Java Enablement component. To run
SQLJ applications, your DB2 client with the DB2 Java Enablement
component must connect to a DB2 server.

v To build JDBC applets, you must install a DB2 client with the DB2 Java
Enablement component. To run JDBC applets, the client machine does not
require any DB2 components.

v To build SQLJ applets, you must install the DB2 SDK and a DB2
Administrative Client with the DB2 Java Enablement component. To run
SQLJ applets, the client machine does not require any DB2 components.

For detailed information on building and running JDBC and SQLJ programs
see Application Building Guide. For more information on DB2 programming in
Java, refer to the Application Development Guide. This covers creating and
running JDBC and SQLJ applications, applets, stored procedures and UDFs.

For the latest, updated DB2 Java information, visit the Web Page at:
http://www.software.ibm.com/data/db2/java

Configuring the Environment

To build and run DB2 Java programs, you need to install and configure the
appropriate version of the Java Development Kit (JDK) on your development
machine:

AIX: The Java Development Kit (JDK) Version 1.1.2 for AIX from IBM.

HP-UX:
The HP-UX Developer’s Kit for Java Release 1.1.3 or later from
Hewlett-Packard.

Linux: The Java Development Kit (JDK) 1.1.7, Version 1a or later for Linux
from the Blackdown Organization.

OS/2: The Java Development Kit (JDK) Version 1.1.4 for OS/2 from IBM.

Silicon Graphics IRIX:
The Java Development Environment 3.1 (Sun JDK 1.1.5) and the Java
Execution Environment 3.1 (Sun JRE 1.1.5) from Silicon Graphics, Inc.
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Solaris:
The Java Development Kit (JDK) Version 1.1.4 for Solaris, and the
Solaris Native Thread pack, from Sun Microsystems.

Windows 32-bit operating systems
The Java Development Kit (JDK) Version 1.1 for Win32 from Sun
Microsystems.

For information on installing and configuring any of the above JDKs, please
refer to:

http://www.software.ibm.com/data/db2/java

For all supported platforms, you must also install and configure a DB2 client
with the DB2 Java Enablement component. To bind SQLJ programs to a
database, you must install and configure a DB2 Administrative Client with the
DB2 Java Enablement component.

To run DB2 Java stored procedures or UDFs, you also need to update the DB2
database manager configuration to include the path where the JDK version 1.1
is installed on your development machine. You can do this by entering the
following on the command line:

db2 update dbm cfg using JDK11_PATH /home/smith/jdk11

where /home/smith/jdk11 is the path where the JDK version 1.1 is installed.

You can check the DB2 database manager configuration to verify the correct
value for the JDK11_PATH field by entering the following command:

db2 get dbm cfg

You may want to pipe the output to a file for easier viewing. The JDK11_PATH
field appears near the beginning of the output. For more information on these
commands, refer to the Command Reference.

On Solaris, some Java Virtual Machine implementations do not work
well in programs that run in a ″setuid″ environment. The shared
library that contains the Java interpreter, libjava.so, may fail to
load. As a workaround, you can create symbolic links for all needed
JVM shared libraries in /usr/lib, with a command similar to the
following (depending on where Java is installed on your machine):

ln -s /opt/jdk1.1.3/lib/sparc/native_threads/*.so /usr/lib

For more information on this and other workarounds available,
please visit:

http://www.software.ibm.com/data/db2/java/v5/faq.html
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To run Java programs, the following environment variables are automatically
updated during DB2 installation on OS/2 and the Windows Operating
System, and during instance creation on UNIX platforms.

On UNIX platforms:
v CLASSPATH includes ″.″ and the file sqllib/java/db2java.zip

v On AIX, Linux, Silicon Graphics IRIX, and Solaris: LD_LIBRARY_PATH
includes the directory sqllib/lib; on HP-UX: SHLIB_PATH includes the
directory sqllib/lib

v On Solaris only: THREADS_FLAG is set to ″native″

On Windows and OS/2 platforms:
v CLASSPATH includes ″.″ and the file %DB2PATH%\java\db2java.zip

In order to build and run SQLJ programs, CLASSPATH is also automatically
updated to include these files:

On UNIX platforms:
v sqllib/java/sqlj.zip (required to build SQLJ programs)
v sqllib/java/runtime.zip (required to run SQLJ programs)

On Windows and OS/2 platforms:
v %DB2PATH%\java\sqlj.zip (required to build SQLJ programs)
v %DB2PATH%\java\runtime.zip (required to run SQLJ programs)

Java Applications

Start your application from the desktop or command line by running the Java
interpreter on the executable program with this command:

java prog_name

where prog_name is the name of the program.

The DB2 JDBC driver handles the JDBC API calls from your application and
uses the DB2 CAE to communicate the requests to the server and receive the
results.

An SQLJ application must be bound to the database before it is run.

Java Applets

Because Java applets are delivered over the web, a web server must be
installed on your DB2 machine (server or client).
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To run your applet, make sure your .html file is properly configured. Start the
JDBC applet server on the TCP/IP port specified in the .html file. For
example, if you specified:

param name=port value='6789'

then you would enter:
db2jstrt 6789

You must ensure that your working directory is accessible to your web
browser. If it is not, copy your applet’s .class and .html files into a directory
that is accessible. For SQLJ applets, you must also copy the profile .class and
.ser files as well.

Copy the sqllib/java/db2java.zip file into the same directory as these other
files. For SQLJ applets, also copy the sqllib/java/runtime.zip file into this
directory. Then on your client machine start your web browser (which
supports JDK 1.1) and load the .html file.

When your applet calls the JDBC API to connect to DB2, the JDBC driver
establishes separate communications with the DB2 database through the JDBC
applet server residing on the DB2 server.

An SQLJ applet must be bound to the database before it is run.
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Part 7. Appendixes
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Appendix A. Basic Task Knowledge

This section describes the basic tasks that you will need to know to use this
product effectively.

Go to the task that you want to perform:

v “Starting the Software Registration Tool”.

v “Starting the Client Configuration Assistant”.

v “Starting the Control Center” on page 144.

v “Entering Commands Using the Command Center” on page 144.

v “Entering Commands Using the Command Line Processor” on page 146.

v “Working with the System Administrative Group” on page 148.

Starting the Software Registration Tool

Start the Software Registration Tool as follows:

OS/2 Click on OS/2 Warp and select DB2 for OS/2–>Registration

Windows 9x or Windows NT
Click on Start and select Programs->DB2 for
Windows->Registration

Starting the Client Configuration Assistant

Start the Client Configuration Assistant (CCA) as follows:

OS/2 Click on OS/2 Warp, and select DB2 for OS/2–>Client
Configuration Assistant

Windows 9x or Windows NT
Click on Start and select Programs->DB2 for
Windows->Client Configuration Assistant

You can also start the CCA by entering the db2cca command at a
command prompt.
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Starting the Control Center

Start the Control Center in one of the following ways:

On OS/2

v Enter the db2cc command at a command prompt.
or

v Click on the OS/2 Warp button and select DB2 for OS/2–>Control
Center.

Note: You must have the prerequisite Java Runtime Environment
(JRE) level to launch the Control Center using this command.
For more information, refer to the Control Center readme,
which can be found in the x:\sqllib\cc\prime directory,
where x: is drive where you installed your DB2 product.

On Windows 9x or Windows NT

v Enter the db2cc command at a command prompt.
or

v Click on Start and select Programs->DB2 for Windows->Control
Center.

You can also run the Control Center as an applet through a web
browser. For more information, refer to the Control Center readme,
which can be found in the x:\sqllib\cc\prime directory, where x: is
drive where you installed your DB2 product.

Entering Commands Using the Command Center

This section describes how to enter commands using the Command Center.
The Command Center provides an interactive window to:
v Run SQL statements, DB2 commands, and operating system commands.
v See the execution result of SQL statements and DB2 commands in a results

window. You can scroll through the results and save the output to a file.
v Save a sequence of SQL statements and DB2 commands to a script file. You

can then schedule the script to run as a job. When a saved script is
modified, all jobs dependent on the saved script inherit the new modified
behavior.

v Recall and run a script file.
v See the execution plan and statistics associated with a SQL statement before

execution. You do this by invoking Visual Explain in the interactive
window.

v Get quick access to database administrative tools from the main tool bar.
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v Display all the command scripts known to the system through the Script
Center, with summary information listed for each.

Start the Command Center in one of the follows ways:
v Click on the Command Center icon in the Control Center.
v Enter the db2cctr command.
v Launch the Command Center from the toolbar as follows:

On Windows 9x or Windows NT

– Click on the Start button and select Programs->DB2 for
Windows->Command Center.

On OS/2

– Click on the OS/2 Warp button and select DB2 for OS/2
–>Command Center.

The Command Center contains a large input area in which you enter your
commands. To run the commands you have entered, click on the Execution
icon (the gears icon), or press CTRL+Enter.

In the Command Center, you do not have to enter a command with
the db2 prefix; instead you just enter the DB2 command. For
example:

list database directory

To enter operating system commands, precede the operating-system
command with an exclamation mark (!). For example:

!dir

If you want to enter multiple commands, you must end each command with
the termination character, then press then Enter key to start the next
command on a new line. The default termination character is a semicolon (;).
To specify a different termination character, click on the Tools Settings icon in
the menu toolbar.

For example, you could connect to a database called SAMPLE and list all the
system tables by entering the following command:

connect to sample;
list tables for system

After you have clicked on the Execution icon (or pressed CTRL+Enter), the
Command Center switches to the Results window which informs you how the
commands are proceeding.

To recall commands that you have entered, select the Script Tab, click on the
drop down box, and select a command.
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To save commands as scripts, select Script->Save as from the menu bar. For
more information, click on the Help push button or press the F1 key.

If you want to store commonly used SQL statements or DB2
commands as scripts, click on the Script Center icon from the main
tool bar. For more information, click on the Help push button or
press the F1 key.

Entering Commands Using the Command Line Processor

You can use the command line processor to enter DB2 commands, SQL
statements, and operating system commands. It operates in the following
modes:

Command Line Mode
The DB2 command line processor behaves like a command window
from your operating system. You can enter operating system
commands, DB2 commands, or SQL statements and view their output.

Interactive Input Mode
The db2 prefix that you use for DB2 commands (in Command Line
Mode) is pre-entered for you. You can enter operating systems
commands, DB2 commands, or SQL statements and view their output.

File Input Mode
Processes commands that are stored in a file. For information on the
file input mode, refer to the Command Reference.

Command Line Mode

To invoke a DB2 Command window, do the following:

OS/2 Click on OS/2 Warp, and select DB2 for OS/2->Command
Line Processor, or open any command window.

Windows 9x or Windows NT
Click on Start and select Programs->DB2 for
Windows->Command Window

You can also invoke the DB2 command window by entering the
db2cmd command at an MS-DOS prompt.

If you are entering commands via the Command Window, you must include
the db2 prefix. For example:

db2 list database directory
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If the DB2 command contains characters that have special meaning
on the operating system you are using, you will need to enter the
command in quotation marks to ensure that it is run properly.

For example, the following command would retrieve all the
information from the employee table, even if the * character has a
special meaning on the operating system:

db2 "select * from employee"

If you need to enter a long command that does not fit on one line, use the line
continuation character, \. When you have reached the end of the line, press
the Enter key to continue entering the command on the next line. For
example:

db2 select empno, function, firstname, lastname, birthdate, from \
db2 (cont.) => employee where function='service' and \
db2 (cont.) => firstname='Lily' order by empno desc

Interactive Input Mode

To invoke the command line processor in interactive input mode, do the
following:

OS/2 Click on OS/2 Warp, and select DB2 for OS/2–>Command
Line Processor or enter the db2 command.

Windows 9x or Windows NT
Click on Start, and select Programs->DB2 for
Windows->Command Line Processor.

You can also invoke the command line processor in interactive input
mode by entering the db2cmd command followed by the db2
command at an MS-DOS prompt.

In interactive input mode, the prompt looks like this:
db2 =>

In interactive input mode, you do not have to enter DB2 commands with a
db2 prefix; instead, you just enter the DB2 command. For example:

db2 => list database directory

To enter operating system commands in interactive mode, precede the
operating-system command with an exclamation mark (!). For example:

db2 => !dir

If you need to enter a long command that does not fit on one line, use the line
continuation character, \. When you have reached the end of the line, press
the Enter key to continue entering the command on the next line. For
example:
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db2 => select empno, function, firstname, lastname, birthdate, from \
db2 (cont.) => employee where function='service' and \
db2 (cont.) => firstname='Lily' order by empno desc

To end interactive input mode, enter the quit command.

For more information on advanced topics using the CLP, refer to the Command
Reference.

Working with the System Administrative Group

By default, System Administrative (SYSADM) authority is granted to the
following:

OS/2 Any valid DB2 user ID which belongs to the Administrator or
Local Administrator group.

Windows NT Any valid DB2 user account which belongs to the local
Administrators group on the machine where the account is
defined.

For example, if a user logs on to a domain account and tries
to access a DB2 database, DB2 will go to a Domain Controller
to enumerate groups (including the Administrator’s group).
You can change this behavior in either of two ways:
1. Set the registry variable DB2_GRP_LOOKUP=local and add

the domain accounts (or global groups) to the local
Administrators group.

2. Update the database manager configuration file to specify
a new group. If you want that group enumerated on the
local machine, the you must also set the DB2_GRP_LOOKUP
registry variable.

By default, in a Windows NT domain environment, only domain
users that belong to the Administrators group at the Primary
Domain Controller (PDC) have SYSADM authority on an instance.
Since DB2 always performs authorization at the machine where the
account is defined, adding a domain user to the local Administrators
group on the server does not grant the domain user SYSADM
authority to this group.

To avoid adding a domain user to the Administrators group at the
PDC, we suggest that you create a global group and add the users
(both domain and local) that you want to grant SYSADM authority.
To do so, enter the following commands:

db2stop
db2 update dbm cfg using sysadm_group global_group
db2start
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For information on how to change the default SYSADM settings and how to
assign this authority to a different user or set of users, refer to the
Administration Guide.
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Appendix B. How the DB2 Library Is Structured

The DB2 Universal Database library consists of SmartGuides, online help,
books and sample programs in HTML format. This section describes the
information that is provided, and how to access it.

To access product information online, you can use the Information Center. You
can view task information, DB2 books, troubleshooting information, sample
programs, and DB2 information on the Web. See “Accessing Information with
the Information Center” on page 162 for details.

Completing Tasks with SmartGuides

SmartGuides help you complete some administration tasks by taking you
through each task one step at a time. SmartGuides are available through the
Control Center and the Client Configuration Assistant. The following table
lists the SmartGuides.

Note: Create Database, Index, and Configure Multisite Update SmartGuide
are available for the partitioned database environment.

SmartGuide Helps You to... How to Access...

Add Database Catalog a database on a client workstation. From the Client Configuration
Assistant, click Add.

Back up Database Determine, create, and schedule a backup
plan.

From the Control Center, click with
the right mouse button on the
database you want to back up and
select Backup->Database using
SmartGuide.

Configure Multisite
Update SmartGuide

Perform a multi-site update, a distributed
transaction, or a two-phase commit.

From the Control Center, click with
the right mouse button on the
Database icon and select Multisite
Update.

Create Database Create a database, and perform some basic
configuration tasks.

From the Control Center, click with
the right mouse button on the
Databases icon and select
Create->Database using
SmartGuide.
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SmartGuide Helps You to... How to Access...

Create Table Select basic data types, and create a primary
key for the table.

From the Control Center, click with
the right mouse button on the
Tables icon and select
Create->Table using SmartGuide.

Create Table Space Create a new table space. From the Control Center, click with
the right mouse button on the
Table spaces icon and select
Create->Table space using
SmartGuide.

Index Advise which indexes to create and drop for
all your queries.

From the Control Center, click with
the right mouse button on the
Index icon and select
Create->Index using SmartGuide.

Performance
Configuration

Tune the performance of a database by
updating configuration parameters to match
your business requirements.

From the Control Center, click with
the right mouse button on the
database you want to tune and
select Configure using
SmartGuide.

Restore Database Recover a database after a failure. It helps
you understand which backup to use, and
which logs to replay.

From the Control Center, click with
the right mouse button on the
database you want to restore and
select Restore->Database using
SmartGuide.

Accessing Online Help

Online help is available with all DB2 components. The following table
describes the various types of help. You can also access DB2 information
through the Information Center. For information see “Accessing Information
with the Information Center” on page 162.

Type of Help Contents How to Access...

Command Help Explains the syntax of
commands in the command
line processor.

From the command line processor in interactive
mode, enter:

? command

where command is a keyword or the entire
command.

For example, ? catalog displays help for all the
CATALOG commands, while ? catalog database
displays help for the CATALOG DATABASE
command.
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Type of Help Contents How to Access...

Control Center Help

Client Configuration
Assistant Help

Event Analyzer Help

Command Center Help

Explains the tasks you can
perform in a window or
notebook. The help includes
prerequisite information you
need to know, and describes
how to use the window or
notebook controls.

From a window or notebook, click the Help push
button or press the F1 key.

Message Help Describes the cause of a
message, and any action
you should take.

From the command line processor in interactive
mode, enter:

? XXXnnnnn

where XXXnnnnn is a valid message identifier.

For example, ? SQL30081 displays help about the
SQL30081 message.

To view message help one screen at a time, enter:

? XXXnnnnn | more

To save message help in a file, enter:

? XXXnnnnn > filename.ext

where filename.ext is the file where you want to
save the message help.

SQL Help Explains the syntax of SQL
statements.

From the command line processor in interactive
mode, enter:

help statement

where statement is an SQL statement.

For example, help SELECT displays help about
the SELECT statement.
Note: SQL help is not available on UNIX-based
platforms.

SQLSTATE Help Explains SQL states and
class codes.

From the command line processor in interactive
mode, enter:

? sqlstate or ? class-code

where sqlstate is a valid five-digit SQL state and
class-code is the first two digits of the SQL state.

For example, ? 08003 displays help for the 08003
SQL state, while ? 08 displays help for the 08 class
code.
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DB2 Information – Hardcopy and Online

The table in this section lists the DB2 books. They are divided into two
groups:

Cross-platform books
These books contain the common DB2 information for all
platforms.

Platform-specific books
These books are for DB2 on a specific platform. For example,
there are separate Quick Beginnings books for DB2 on OS/2,
on Windows NT, and on the UNIX-based platforms.

Cross-platform sample programs in HTML
These samples are the HTML version of the sample programs
that are installed with the SDK. They are for informational
purposes and do not replace the actual programs.

Most books are available in HTML and PostScript format, or you can choose
to order a hardcopy from IBM. The exceptions are noted in the table.

On OS/2 and Windows platforms, HTML documentation files can be installed
under the doc\html subdirectory. Depending on the language of your system,
some files may be in that language, and the remainder are in English.

On UNIX platforms, you can install multiple language versions of the HTML
documentation files under the doc/%L/html subdirectories. Any
documentation that is not available in a national language is shown in
English.

You can obtain DB2 books and access information in a variety of different
ways:

View See “Viewing Online Information” on page 161.

Search See “Searching Online Information” on page 164.

Print See “Printing the PostScript Books” on page 164.

Order See “Ordering the Printed Books” on page 165.
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Name Description Form Number

File Name for
Online Book

HTML
Directory

Cross-Platform Books

Administration Guide Administration Guide, Design and
Implementation contains information
required to design, implement, and
maintain a database. It also describes
database access using the Control
Center(whether local or in a
client/server environment), auditing,
database recovery, distributed database
support, and high availability.

Administration Guide, Performance
contains information that focuses on the
database environment, such as
application performance evaluation and
tuning.

You can order both volumes of the
Administration Guide in the English
language in North America using the
form number SBOF-8922.

Volume 1
SC09-2839
db2d1x60

Volume 2
SC09-2840
db2d2x60

db2d0

Administrative API
Reference

Describes the DB2 application
programming interfaces (APIs) and data
structures you can use to manage your
databases. Explains how to call APIs
from your applications.

SC09-2841

db2b0x60

db2b0

Application Building
Guide

Provides environment setup information
and step-by-step instructions about how
to compile, link, and run DB2
applications on Windows, OS/2, and
UNIX-based platforms.

This book combines the Building
Applications books for the OS/2,
Windows, and UNIX-based
environments.

SC09-2842

db2axx60

db2ax

APPC, CPI-C and SNA
Sense Codes

Provides general information about
APPC, CPI-C, and SNA sense codes that
you may encounter when using DB2
Universal Database products.
Note: Available in HTML format only.

No form number

db2apx60

db2ap
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Name Description Form Number

File Name for
Online Book

HTML
Directory

Application Development
Guide

Explains how to develop applications
that access DB2 databases using
embedded SQL or JDBC, how to write
stored procedures, user-defined types,
user-defined functions, and how to use
triggers. It also discusses programming
techniques and performance
considerations.

This book was formerly known as the
Embedded SQL Programming Guide.

SC09-2845

db2a0x60

db2a0

CLI Guide and Reference Explains how to develop applications
that access DB2 databases using the DB2
Call Level Interface, a callable SQL
interface that is compatible with the
Microsoft ODBC specification.

SC09-2843

db2l0x60

db2l0

Command Reference Explains how to use the command line
processor, and describes the DB2
commands you can use to manage your
database.

SC09-2844

db2n0x60

db2n0

Data Movement Utilities
Guide and Reference

Explains how to use the Load, Import,
Export, Autoloader, and Data
Propogation utilities to work with the
data in the database.

SC09-2858

db2dmx60

db2dm

DB2 Connect Personal
Edition Quick Beginnings

Provides planning, installing, and
configuring information for DB2 Connect
Personal Edition.

GC09-2830

db2c1x60

db2c1

DB2 Connect User’s Guide Provides concepts, programming and
general usage information about the DB2
Connect products.

SC09-2838

db2c0x60

db2c0

Connectivity Supplement Provides setup and reference information
on how to use DB2 for AS/400, DB2 for
OS/390, DB2 for MVS, or DB2 for VM as
DRDA application requesters with DB2
Universal Database servers, and on how
to use DRDA application servers with
DB2 Connect application requesters.
Note: Available in HTML and PostScript
formats only.

No form number

db2h1x60

db2h1

Glossary Provides a comprehensive list of all DB2
terms and definitions.
Note: Available in HTML format only.

No form number

db2t0x50

db2t0
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Name Description Form Number

File Name for
Online Book

HTML
Directory

Installation and
Configuration Supplement

Guides you through the planning,
installation, and set up of
platform-specific DB2 clients. This
supplement contains information on
binding, setting up client and server
communications, DB2 GUI tools, DRDA
AS, distributed installation, and the
configuration of distributed requests and
access methods to heterogeneous data
sources.

GC09-2857

db2iyx60

db2iy

Message Reference Lists messages and codes issued by DB2,
and describes the actions you should
take.

GC09-2846

db2m0x60

db2m0

Replication Guide and
Reference

Provides planning, configuration,
administration, and usage information
for the IBM Replication tools supplied
with DB2.

SC26-9642

db2e0x60

db2e0

SQL Getting Started Introduces SQL concepts, and provides
examples for many constructs and tasks.

SC09-2856

db2y0x60

db2y0

SQL Reference, Volume 1
and Volume 2

Describes SQL syntax, semantics, and the
rules of the language. Also includes
information about release-to-release
incompatibilities, product limits, and
catalog views.

You can order both volumes of the SQL
Reference in the English language in
North America with the form number
SBOF-8923.

SBOF-8923

Volume 1
db2s1x60

Volume 2
db2s2x60

db2s0

System Monitor Guide and
Reference

Describes how to collect different kinds
of information about databases and the
database manager. Explains how to use
the information to understand database
activity, improve performance, and
determine the cause of problems.

SC09-2849

db2f0x60

db2f0

Troubleshooting Guide Helps you determine the source of
errors, recover from problems, and use
diagnostic tools in consultation with DB2
Customer Service.

S10J-8169 db2p0

Appendix B. How the DB2 Library Is Structured 157



Name Description Form Number

File Name for
Online Book

HTML
Directory

What’s New Describes the new features, functions,
and enhancements in DB2 Universal
Database, Version 6.0, including
information about Java-based tools.

SC09-2851

db2q0x60

db2q0

Platform-Specific Books

Administering Satellites
Guide and Reference

Provides planning, configuration,
administration, and usage information
for satellites.

GC09-2821

db2dsx60

db2ds

DB2 Personal Edition
Quick Beginnings

Provides planning, installation,
migration, and configuration information
for DB2 Universal Database Personal
Edition on the OS/2, Windows 95, and
Windows NT operating systems.

GC09-2831

db2i1x60

db2i1

DB2 for OS/2 Quick
Beginnings

Provides planning, installation,
migration, and configuration information
for DB2 Universal Database on the OS/2
operating system. Also contains
installing and setup information for
many supported clients.

GC09-2834

db2i2x60

db2i2

DB2 for UNIX Quick
Beginnings

Provides planning, installation,
migration, and configuration information
for DB2 Universal Database on
UNIX-based platforms. Also contains
installing and setup information for
many supported clients.

GC09-2836

db2ixx60

db2ix

DB2 for Windows NT
Quick Beginnings

Provides planning, installation,
migration, and configuration information
for DB2 Universal Database on the
Windows NT operating system. Also
contains installing and setup information
for many supported clients.

GC09-2835

db2i6x60

db2i6

DB2 Enterprise - Extended
Edition for UNIX Quick
Beginnings

Provides planning, installation, and
configuration information for DB2
Enterprise - Extended Edition for UNIX.
Also contains installing and setup
information for many supported clients.

GC09-2832

db2v3x60

db2v3
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Name Description Form Number

File Name for
Online Book

HTML
Directory

DB2 Enterprise - Extended
Edition for Windows NT
Quick Beginnings

Provides planning, installation, and
configuration information for DB2
Enterprise - Extended Edition for
Windows NT. Also contains installing
and setup information for many
supported clients.

GC09-2833

db2v6x60

db2v6

DB2 Connect Enterprise
Edition for OS/2 and
Windows NT Quick
Beginnings

Provides planning, migration,
installation, and configuration
information for DB2 Connect Enterprise
Edition on the OS/2 and Windows NT
operating systems. Also contains
installation and setup information for
many supported clients.

This book was formerly part of the DB2
Connect Enterprise Edition Quick
Beginnings.

GC09-2828

db2c6x60

db2c6

DB2 Connect Enterprise
Edition for UNIX Quick
Beginnings

Provides planning, migration,
installation, configuration, and usage
information for DB2 Connect Enterprise
Edition in UNIX-based platforms. Also
contains installation and setup
information for many supported clients.

This book was formerly part of the DB2
Connect Enterprise Edition Quick
Beginnings.

GC09-2829

db2cyx60

db2cy

DB2 Data Links Manager
for AIX Quick Beginnings

Provides planning, installation,
configuration, and task information for
DB2 Data Links Manager for AIX.

GC09-2837

db2z0x60

db2z0

DB2 Data Links Manager
for Windows NT Quick
Beginnings

Provides planning, installation,
configuration, and task information for
DB2 Data Links Manager for Windows
NT.

GC09-2827

db2z6x60

db2z6

DB2 Query Patroller
Administration Guide

Provides administration information on
DB2 Query Patrol.

SC09-2859

db2dwx60

db2dw

DB2 Query Patroller
Installation Guide

Provides installation information on DB2
Query Patrol.

GC09-2860

db2iwx60

db2iw

DB2 Query Patroller
User’s Guide

Describes how to use the tools and
functions of the DB2 Query Patrol.

SC09-2861

db2wwx60

db2ww
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Name Description Form Number

File Name for
Online Book

HTML
Directory

Cross-Platform Sample Programs in HTML

Sample programs in
HTML

Provides the sample programs in HTML
format for the programming languages
on all platforms supported by DB2 for
informational purposes (not all samples
are available in all languages). Only
available when the SDK is installed.

See Application Building Guide for more
information on the actual programs.
Note: Available in HTML format only.

No form number db2hs/c
db2hs/cli
db2hs/clp
db2hs/cpp
db2hs/cobol
db2hs/cobol_mf
db2hs/fortran
db2hs/java
db2hs/rexx

Notes:

1. The character in the sixth position of the file name indicates the language
of a book. For example, the file name db2d0e60 indicates that the
Administration Guide is in English. The following letters are used in the file
names to indicate the language of a book:

Language Identifier
Brazilian Portuguese b
Bulgarian u
Czech x
Danish d
Dutch q
English e
Finnish y
French f
German g
Greek a
Hungarian h
Italian i
Japanese j
Korean k
Norwegian n
Polish p
Portuguese v
Russian r
Simp. Chinese c
Slovenian l
Spanish z
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Swedish s
Trad. Chinese t
Turkish m

2. For late breaking information that could not be included in the DB2 books:
v On UNIX-based platforms, see the Release.Notes file. This file is located

in the DB2DIR/Readme/%L directory, where %L is the locale name and
DB2DIR is:
– /usr/lpp/db2_06_01 on AIX
– /opt/IBMdb2/V6.1 on HP-UX, Solaris, SCO UnixWare 7, and Silicon

Graphics IRIX
– /usr/IBMdb2/V6.1 on Linux.

v On other platforms, see the RELEASE.TXT file. This file is located in the
directory where the product is installed.

v Under Windows Start menu

Viewing Online Information

The manuals included with this product are in Hypertext Markup Language
(HTML) softcopy format. Softcopy format enables you to search or browse the
information, and provides hypertext links to related information. It also makes
it easier to share the library across your site.

You can view the online books or sample programs with any browser that
conforms to HTML Version 3.2 specifications.

To view online books or sample programs on all platforms other than SCO
UnixWare 7:
v If you are running DB2 administration tools, use the Information Center.

See “Accessing Information with the Information Center” on page 162 for
details.

v Select the Open Page menu item of your Web browser. The page you open
contains descriptions of and links to DB2 information:
– On UNIX-based platforms, open the following page:

file:/INSTHOME/sqllib/doc/%L/html/index.htm

where %L is the locale name.
– On other platforms, open the following page:

sqllib\doc\html\index.htm

The path is located on the drive where DB2 is installed.
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If you have not installed the Information Center, you can open the page
by double-clicking on the DB2 Online Books icon. Depending on the
system you are using, the icon is in the main product folder or the
Windows Start menu.

To view online books or sample programs on the SCO UnixWare 7:
v DB2 Universal Database for SCO UnixWare 7 uses the native SCOhelp

utility to search the DB2 information. You can access SCOhelp by the
following methods:
– entering the ″scohelp″ command on the command line,
– selecting the Help menu in the Control Panel of the CDE desktop or
– selecting Help in the Root menu of the Panorama desktop

For more information on SCOhelp, refer to the Installation and Configuration
Supplement.

Accessing Information with the Information Center

The Information Center provides quick access to DB2 product information.
The Information Center is available on all platforms on which the DB2
administration tools are available.

Depending on your system, you can access the Information Center from the:
v Main product folder
v Toolbar in the Control Center
v Windows Start menu
v Help menu of the Control Center

The Information Center provides the following kinds of information. Click the
appropriate tab to look at the information:

Tasks Lists tasks you can perform using DB2.

Reference Lists DB2 reference information, such as
keywords, commands, and APIs.

Books Lists DB2 books.

Troubleshooting Lists categories of error messages and their
recovery actions.

Sample Programs Lists sample programs that come with the
DB2 Software Developer’s Kit. If the Software
Developer’s Kit is not installed, this tab is not
displayed.

Web Lists DB2 information on the World Wide
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Web. To access this information, you must
have a connection to the Web from your
system.

When you select an item in one of the lists, the Information Center launches a
viewer to display the information. The viewer might be the system help
viewer, an editor, or a Web browser, depending on the kind of information
you select.

The Information Center provides some search capabilities, so you can look for
specific topics, and filter capabilities to limit the scope of your searches.

For a full text search, click the Search button of the Information Center follow
the Search DB2 Books link in each HTML file.

The HTML search server is usually started automatically. If a search in the
HTML information does not work, you may have to start the search server by
double-clicking its icon on the Windows or OS/2 desktop.

Refer to the release notes if you experience any other problems when
searching the HTML information.

Note: Search function is not available in the Linux and Silicon Graphics
environments.

Setting Up a Document Server

By default, the DB2 information is installed on your local system. This means
that each person who needs access to the DB2 information must install the
same files. To have the DB2 information stored in a single location, use the
following instructions:
1. Copy all files and subdirectories from \sqllib\doc\html on your local

system to a Web server. Each book has its own subdirectory containing all
the necessary HTML and GIF files that make up the book. Ensure that the
directory structure remains the same.

2. Configure the Web server to look for the files in the new location. For
information, see the NetQuestion Appendix in Installation and Configuration
Supplement.

3. If you are using the Java version of the Information Center, you can
specify a base URL for all HTML files. You should use the URL for the list
of books.

4. Once you are able to view the book files, you should bookmark commonly
viewed topics. Among those, you will probably want to bookmark the
following pages:
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v List of books
v Tables of contents of frequently used books
v Frequently referenced articles, such as the ALTER TABLE topic
v The Search form

For information about setting up a search, see the NetQuestion Appendix in
Installation and Configuration Supplement book.

Searching Online Information

To search for information in the HTML books, you can do the following:
v Click on Search the DB2 Books at the bottom of any page in the HTML

books. Use the search form to find a specific topic. This function is not
available in the Linux or Silicon Graphics IRIX environments.

v Click on Index at the bottom of any page in an HTML book. Use the index
to find a specific topic in the book.

v Display the table of contents or index of the HTML book, and then use the
find function of the Web browser to find a specific topic in the book.

v Use the bookmark function of the Web browser to quickly return to a
specific topic.

v Use the search function of the Information Center to find specific topics. See
“Accessing Information with the Information Center” on page 162 for
details.

Printing the PostScript Books

If you prefer to have printed copies of the manuals, you can decompress and
print PostScript versions. For the file name of each book in the library, see the
table in “DB2 Information – Hardcopy and Online” on page 154. Specify the
full path name for the file you intend to print.

On OS/2 and Windows platforms:

1. Copy the compressed PostScript files to a hard drive on your system. The
files have a file extension of .exe and are located in the
x:\doc\language\books\ps directory, where x: is the letter representing the
CD-ROM drive and language is the two-character country code that
represents your language (for example, EN for English).

2. Decompress the file that corresponds to the book that you want. Each
compressed book is a self-extracting executable file. To decompress the
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book, simply run it as you would run any other executable program. The
result from this step is a printable PostScript file with a file extension of
.ps.

3. Ensure that your default printer is a PostScript printer capable of printing
Level 1 (or equivalent) files.

4. Enter the following command from a command line:
print filename.ps

On UNIX-based platforms:
1. Mount the CD-ROM. Refer to your Quick Beginnings manual for the

procedures to mount the CD-ROM.
2. Change to /cdrom/doc/%L/ps directory on the CD-ROM, where /cdrom is

the mount point of the CD-ROM and %L is the name of the desired locale.
The manuals will be installed in the previously-mentioned directory with
file names ending with .ps.Z.

3. Decompress and print the manual you require using the following
command:
v For AIX:

zcat filename | qprt -P PSPrinter_queue

v For HP-UX, Solaris, or SCO UnixWare 7:
zcat filename | lp -d PSPrinter_queue

v For Linux:
zcat filename | lpr -P PSPrinter_queue

v For Silicon Graphics IRIX:
zcat < filename | lp -d PSPrinter_queue

where filename is the full path name and extension of the compressed
PostScript file and PSprinter_queue is the name of the PostScript printer
queue.

For example, to print the English version of DB2 for UNIX Quick
Beginnings on AIX, you can use the following command:
zcat /cdrom/doc/en/ps/db2ixe60.ps.Z || qprt -P ps1

Ordering the Printed Books

You can order the printed DB2 manuals either as a set or individually. There
are three sets of books available. The form number for the entire set of DB2
books is SBOF-8926-00. The form number for the books listed under the
heading ″Cross-Platform Books″ is SBOF-8924-00.
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Note: These form numbers only apply if you are ordering books that are
printed in the English language in North America.

You can also order books individually by the form number listed in “DB2
Information – Hardcopy and Online” on page 154. To order printed versions,
contact your IBM authorized dealer or marketing representative, or phone
1-800-879-2755 in the United States or 1-800-IBM-4YOU in Canada.
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Appendix C. Using the Control Center to Administer DB2
for OS/390 and DB2 Connect Enterprise Edition servers

DB2 Control Center is an easy to use application provided as part of the DB2
Administration Client. The Control Center gives database administrators a
powerful tool for managing DB2 Family databases. In Version 6, the Control
Center has been greatly enhanced to deliver new management functions to
database administrators who need to manage DB2 for OS/390 V5.1 and V6.1
database servers. Version 6 of the Control Center has also been enhanced to
manage operational and performance characteristics of DB2 Connect
Enterprise Edition connectivity servers. The combination of DB2 for OS/390
server management and new DB2 Connect monitoring support provide
complete end-to-end administration and monitoring for desktop and web
applications that work with DB2 for OS/390 servers.

The DB2 Control Center uses the familiar ″explorer″ interface to allow
database administrators to easily navigate between different database servers
and the database objects they manage. Context sensitive right-mouse activated
menus provide administrators with the ability to change attributes of database
objects and to launch commands and utilities. Database objects are presented
in a consistent fashion for all DB2 family servers. This greatly reduces the
amount of learning that is required for administrators who need to manage
both DB2 for OS/390 and DB2 Universal Databases on Windows NT, UNIX
and OS/2 servers. While the Control Center preserves consistency across
servers it does not hide capabilities that are unique to each DB2 server. This
gives database administrators the power to perform all aspects of their tasks.

The ability to manage DB2 Connect connectivity servers is delivered through
management of user connections and by keeping vital statistics on various
performance aspects of the connectivity server. For example, database
administrators can easily view all of the users connected through a particular
DB2 Connect server, and their connection characteristics. Administrators can
also collect load and performance information such as the number of SQL
statements and transactions executed, number of bytes sent and received,
statement and transaction execution times and much more. Collected data can
be displayed using easy to understand live graphs.
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Preparing DB2 for OS/390 Servers for the Control Center

The DB2 Control Center uses stored procedures to deliver many of its
management functions. Therefore, for the control center to function properly
each DB2 for OS/390 server that will be managed from the Control Center
needs to have stored procedures enabled and the proper stored procedures
installed on that server.

Consult the DB2 for OS/390 Program Directory for additional information on
applying service and required Function Modification Identifiers.

Using the Control Center

Before you can work with a server and its databases you will need to catalog
information about the server on the Control Center workstation. The DB2
Control Center only works with servers and databases that are catalogued on
the workstation where the Control Center is running. The easiest way to
accomplish this on Windows 95, 98, NT and OS/2 workstations is to use the
DB2 Client Configuration Assistant (CCA). For information about using the
CCA, see “Chapter 7. Configuring DB2 Connect to Host or AS/400
Communications Using the CCA” on page 65.

Once the Control Center is running, start by clicking on the plus sign next to
the server you want to administer. Select the database or connectivity server
objects that you want to administer and click the right mouse button on the
object to work with object properties or to execute actions on the object.
Remember to press F1 to display help as you work.
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Appendix D. db2cpic.dll - Extended SNA Security Codes on
Windows NT and Windows 95

Extended SNA Security Codes were not implemented by some SNA
subsystem providers. This may affect customers using one or more of the
following:
v DB2 Universal Database (UDB) for Windows NT Version 5 (all editions).
v DB2 Connect Enterprise Edition for Windows NT Version 5
v DB2 Connect Personal Edition Version 5 (when running on Windows 95 or

Windows NT).

A new DLL, called db2cpic2.dll has been provided in order to support
Extended SNA Security Codes in these environments. The new DLL was
originally packaged with FixPak 1 for DB2 Universal Database Version 5. It is
identical to the original DLL db2cpic.dll, except that it includes a call to
extract secondary information (cmesi()).

Table 11. Which version of db2cpic.dll to use?

If you have this SNA
subsystem

On Windows NT use On Windows 95 use

IBM Communications
Server for Windows NT

db2cpic2.dll (new) db2cpic.dll (old)

IBM Personal
Communications for
Windows (also Integrated
SNA Support provided
with DB2 Connect Personal
Edition)

db2cpic2.dll db2cpic.dll

Microsoft SNA Server db2cpic.dll db2cpic.dll

If DB2 fails to load db2cpic2.dll, you can do the following in the directory
where it has been installed:

copy db2cpic2.dll db2cpic2.bak
copy db2cpic.dll db2cpic2.dll

This will make db2cpic2.dll the same as db2cpic.dll.

Note: If you wish to use Extended Security Support with DB2 UDB Version
5.0 on Windows 95, we recommend using IBM Personal
Communications (PComm) for Windows 95 Version 4.2 (not Version
4.1). Copy db2cpic.dll to db2cpic.bak and copy db2cpic2.dll to
db2cpic.dll. This will make db2cpic.dll the same as db2cpic2.dll.
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Appendix E. National Language Support (NLS)

This section contains information about configuring national language support
for the DB2 Connect product, and includes information on:
v Which languages are supported by DB2 Connect Enterprise Edition and

DB2 Connect Personal Edition.
v How DB2 Connect handles the conversion of data between unalike systems.
v How to customize your DB2 Connect workstation for your particular

national language environment.
v How to customize your host Coded Character Set Identifier (CCSID)

setting.

Code Page and Language Support

During installation of DB2, the country, codepage, and regional settings are
established. However, you can change these settings after installing DB2:
including regional settings such as code page, country language (for monetary,
date, and numeric formatting), and time zone. When a new connection to a
database is made, the database manager uses these new values.

You must ensure that your regional settings are set correctly. DB2
may not produce the expected results if the country, code page, or
regional settings are incorrect for the intended language.

Table 12 shows the languages into which the DB2 messages are translated.

Note: The code page values in the table that follows are also used as
directory names on DB2 CD-ROMs. For example, a reference to
x:\language\win32\install would be x:\en\win32\install for English.
For more detailed information on the languages and code pages
support, refer to the Administration Guide.

Table 12. Languages and Code Pages

Country Code Language

bg Bulgarian

br Brazilian Portuguese

cn Simplified Chinese (PRC)

cz Czech

de German

dk Danish
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Table 12. Languages and Code Pages (continued)

Country Code Language

en English

es Spanish

fi Finnish

fr French

gr Greek

hu Hungarian

il Hebrew

it Italian

jp Japanese

kr Korean

nl Dutch

no Norwegian

pl Polish

pt Portuguese

ru Russian

se Swedish

si Slovenian

tr Turkish

tw Traditional Chinese (Taiwan)

Conversion of Character Data

When character data is transferred between machines, it must be converted to
a form that the receiving machine can use.

For example, when data is transferred between the DB2 Connect workstation
and a host or AS/400 database server, it is usually converted from a
workstation code page to a host CCSID, and vice versa. If the two machines
use different code pages or CCSIDs, code points are mapped from one code
page or CCSID to the other. This conversion is always performed at the
receiver.

Character data sent to a database consists of SQL statements and input data.
Character data sent from a database consists of output data. Output data that
is interpreted as bit data (for example, data from a column declared with the
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FOR BIT DATA clause) is not converted. Otherwise all input and output
character data is converted if the two machines have different code pages or
CCSIDs.

For example, if DB2 Connect is used to access DB2 Universal Database for
OS/390 or DB2/MVS data, the following happens:
1. DB2 Connect sends an SQL statement and input data to OS/390 or MVS.
2. DB2 Universal Database for OS/390 converts the data to an EBCDIC

CCSID and processes it.
3. DB2 Universal Database for OS/390 sends the result back to the DB2

Connect workstation.
4. DB2 Connect converts the result to an ASCII or ISO code page and returns

it to the user.

The table that follows shows the conversions that are supported between code
pages (on the workstation) and CCSIDs (on the host).

For more detailed information about supported code page conversions, refer
to the Administration Guide.

Table 13. Workstation Code Page to Host CCSID Conversion

Host CCSIDs Code Page Countries

037, 273, 277, 278, 280, 284,
285, 297, 500, 871, 1140-1149

437, 819, 850, 858, 860, 863,
1004, 1051, 1252, 1275

Albania, Australia, Austria,
Belgium, Brazil, Canada,
Denmark, Finland, France,
Germany, Iceland, Ireland,
Italy, Latin America,
Netherlands, New Zealand,
Norway, Portugal, South
Africa, Spain, Sweden,
Switzerland, UK, USA

423, 875 737, 813, 869, 1253, 1280 Greece

870 852, 912, 1250, 1282 Croatia, Czech Republic,
Hungary, Poland, Romania,
Serbia/Montenegro (Latin),
Slovakia, Slovenia

1025 855, 866, 915, 1251, 1283 Bulgaria, FYR Macedonia,
Russia, Serbia/Montenegro
(Cyrillic)

1026 857, 920, 1254, 1281 Turkey

424 862, 916, 1255 Israel - see note 3 below

420 864, 1046, 1089, 1256 Arabic countries - see note
3 below
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Table 13. Workstation Code Page to Host CCSID Conversion (continued)

Host CCSIDs Code Page Countries

838 874 Thailand

930, 939, 5026, 5035 932, 942, 943, 954, 5039 Japan

937 938, 948, 950, 964 Taiwan

933, 1364 949, 970, 1363 Korea

935, 1388 1381, 1383, 1386 People’s Republic of China

1112, 1122 921, 922 Estonia, Latvia, Lithuania

1025 915, 1131, 1251, 1283 Belarus

1123 1124, 1125, 1251 Ukraine

Notes:

1. Code page 1004 is supported as code page 1252.
2. In general, data can be converted from a code page to a CCSID and back

again to the same code page with no change. The following are the only
exceptions to that rule:
v In double-byte character set (DBCS) code pages, some data containing

user-defined characters may be lost.
v For single-byte code pages defined within mixed-byte code pages, and

for some newer single-byte code pages, characters that do not exist in
both the source and the target may be mapped to substitution characters
and then lost when the data is converted back to the original code page.

3. For bidirectional languages, a number of special ″BiDi CCSIDS″ have been
defined by IBM and are supported by DB2 Connect Version 6.
If the bidirectional attributes of the database server are different from those
of the client you can use these special CCSIDS to manage the difference.
Refer to the Administration Guide for details of these special CCSIDs. Refer
to the Release Notes for DB2 Connect Version 6 for detailed information
about how to set them up for DRDA host connections.

Bidirectional CCSID Support

The following BiDi attributes are required for correct handling of Bidirectional
data on different platforms:

- Text type (LOGICAL vs VISUAL)
- Shaping (SHAPED vs UNSHAPED)
- Orientation (RIGHT-TO-LEFT vs LEFT-TO-RIGHT)
- Numeral shape (ARABIC vs HINDI)
- Symmetric swapping (YES or NO)
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Since defaults on different platforms are not the same, problems appear when
DB2 data is sent from one platform to another. For example, Windows
platforms use LOGICAL UNSHAPED data, while data on OS/390 is usually
in SHAPED VISUAL format. Therefore, without any support for these
attributes data sent from DB2 Universal Database for OS/390 to DB2 UDB on
a Windows 32-bit operating systems workstation displays incorrectly.

Bidirectional-specific CCSIDs

The following bidirectional Coded Character Set Identifiers (CCSID) have been
defined and are implemented with DB2 UDB:

CCSID - Code - String
- Page - Type

-------+--------+----------
00420 420 4
00424 424 4
08612 420 5
08616 424 6
12708 420 7

X'3F00' 856 4
X'3F01' 862 4
X'3F02' 916 4
X'3F03' 424 5
X'3F04' 856 5
X'3F05' 862 5
X'3F06' 916 5
X'3F07' 1255 5
X'3F08' 1046 5
X'3F09' 864 5
X'3F0A' 1089 5
X'3F0B' 1256 5
X'3F0C' 856 6
X'3F0D' 862 6
X'3F0E' 916 6
X'3F0F' 1255 6
X'3F10' 420 6
X'3F11' 864 6
X'3F12' 1046 6
X'3F13' 1089 6
X'3F14' 1256 6
X'3F15' 424 8
X'3F16' 856 8
X'3F17' 862 8
X'3F18' 916 8
X'3F19' 420 8
X'3F1A' 420 9
X'3F1B' 424 10
X'3F1C' 856 10
X'3F1D' 862 10
X'3F1E' 916 10
X'3F1F' 1255 10
X'3F20' 424 11
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X'3F21' 856 11
X'3F22' 862 11
X'3F23' 916 11
X'3F24' 1255 11

Where CDRA String Types are defined:
String - Text - Numerical - Orientation - Shaping - Symmetrical
Type - Type - Shape - - - Swapping

---------+-------+------------+-------------+-----------+-------------
4 Visual Arabic LTR Shaped OFF
5 Implicit Arabic LTR Unshaped ON
6 Implicit Arabic RTL Unshaped ON
7(*) Visual Arabic Contextual(*) Unshaped-Lig OFF
8 Visual Arabic RTL Shaped OFF
9 Visual Passthru RTL Shaped ON

10 Implicit Contextual-L ON
11 Implicit Contextual-R ON

Note: Field orientation is left-to-right (LTR) when the first alphabetic
character is a Latin one, and right-to-left (RTL) when it is a
bidirectional (RTL) character. Characters are unshaped, but LamAlef
ligatures are kept, and not broken into constituents.
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Appendix F. Naming Rules
Go to the section that describes the naming rules that you require
information on:

v “General Naming Rules”

v “Database, Database Alias, and Catalog Node Name Rules”

v “Object Name Rules” on page 178

v “Username, User ID, Group Name, and Instance Name Rules” on
page 179

v “Password Rules” on page 180

v “DB2SYSTEM Naming Rules” on page 180

v “Workstation Name (nname) Rules” on page 179

General Naming Rules

Unless otherwise specified, all names can include the following characters:
v A through Z

When used in most names, characters A through Z are converted
from lowercase to uppercase.

v 0 through 9
v @, #, $, and _ (underscore)

Unless otherwise specified, all names must begin with one of the following
characters:
v A through Z
v @, #, and $

Do not use SQL reserved words to name tables, views, columns, indexes, or
authorization IDs.

For a list of SQL reserved words, refer to SQL Reference.

Database, Database Alias, and Catalog Node Name Rules

Database names are the identifying names assigned to databases in the
database manager.
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Database alias names are synonyms given to remote databases. Database aliases
must be unique within the System Database Directory in which all aliases are
stored.

When naming a database or database alias, see “General Naming Rules” on
page 177.

In addition, the name you specify can only contain 1 to 8 characters.

To avoid potential problems, do not use the special characters @, #,
and $ in a database name if you intend to have a client remotely
connect to a host database. Also, because these characters are not
common to all keyboards, do not use them if you plan to use the
database in another country.

On Windows NT systems, ensure that no instance name is the same
as a service name.

Object Name Rules

Database objects include:
v Tables
v Views
v Columns
v Indexes
v User-defined functions (UDFs)
v User-defined types (UDTs)
v Triggers
v Aliases
v Table spaces
v Schemas

When naming database objects, see “General Naming Rules” on page 177.

In addition, the name you specify:

v Can contain 1 to 18 characters except for the following:
– Table names (including view names, summary table names, alias names,

and correlation names), which can contain up to 128 characters; and
– column names, which can contain up to 30 characters

v Cannot be any of the SQL reserved words that are listed in the SQL
Reference.
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Using delimited identifiers, it is possible to create an object that
violates these naming rules; however, subsequent use of the object
could result in errors.

For example, if you create a column with a + or − sign included in
the name and you subsequently use that column in an index, you
will experience problems when you attempt to reorganize the table.
To avoid potential problems with the use and operation of your
database, do not violate these rules.

Username, User ID, Group Name, and Instance Name Rules

Usernames or User IDs are the identifiers assigned to individual users. When
naming users, groups, or instances, see “General Naming Rules” on page 177.

In addition, the name you specify:

v Can contain 1 to 8 characters
v Cannot be any of the following:

– USERS
– ADMINS
– GUESTS
– PUBLIC
– LOCAL

v Cannot begin with:
– IBM
– SQL
– SYS

v Cannot include accented characters
v In general, when naming users, groups, or instances:

OS/2 Use uppercase names.

UNIX Use lowercase names.

Windows 32-bit operating systems
Use any case.

Workstation Name (nname) Rules

A workstation name specifies the NetBIOS name for a database server or client
that resides on the local workstation. This name is stored in the database
manager configuration file. The workstation name is known as the workstation
nname. When naming workstations, see “General Naming Rules” on page 177.
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In addition, the name you specify:

v Can contain 1 to 8 characters
v Cannot include &, #, and @
v Must be unique within the network

DB2SYSTEM Naming Rules

DB2 uses the DB2SYSTEM name to identify a physical DB2 machine, system,
or workstation within a network. On UNIX, the DB2SYSTEM name defaults to
the TCP/IP hostname. On OS/2, you must specify the DB2SYSTEM name
during install. On Windows 32-bit operating systems, you do not need to
specify a DB2SYSTEM name; the DB2 setup program detects the NT
Computer name and assigns it to DB2SYSTEM.

When creating a DB2SYSTEM name, see “General Naming Rules” on
page 177.

In addition, the name you specify:

v Must be unique within a network
v Can contain a maximum of 21 characters

Password Rules

When determining passwords, consider the following rules:

OS/2 A maximum of 14 characters.

UNIX A maximum of 8 characters.

Windows 9x or Windows NT
A maximum of 14 characters.
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Appendix G. List Files, Bind Files, and Packages

This appendix lists the bind files contained in different .lst files shipped with
the product. Although the contents of these lists are similar for each platform,
the bind packages are generated specifically for each platform. Each package
name can be mapped back to the client platform.

Note that the Bind function in the DB2 Client Configuration Assistant chooses
the correct bind files for you automatically.

Note: In the following tables, under the Package Name columns, each DB2
bind package is represented as follows. For example, in the file name
SQLabxYz:
v SQL identifies the bind package as a DB2 utility,
v ab identifies the utility,
v x represents the last digit of the year the product became available,
v Y represents the platform of the client,
v z represents the modification level.

Users on OS/2, Windows 32-bit operating systems, and AIX systems can use
the ddcspkgn command to determine the package name for for individual
bind files or list (.lst) files. This command is found in the bin directory under
the DB2 installation directory. For example, on an AIX system, enter the
following command with the bind file in the local directory:

/sqllib/bin/ddcspkgn db2ajgrt.bnd

The following list maps Y values to platforms:

xAz Clients for AIX

xHz Clients for HP-UX

xLz Clients for Linux

xUz Clients for Solaris

xXz Clients for SINIX

xPz Clients for Power PC

xDz Clients for OS/2

xWz Clients for Windows

xNz Clients for Windows 32-bit operating systems

xMz Clients for Macintosh
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xGz Clients for Silicon Graphics

List Files Associated with DRDA Servers

The following table lists which bind files are included in the .lst file
associated with a particular DRDA host. The package associated with each
bind file is also listed:

DRDA Server
List File

OS/390 and MVS
ddcsmvs.lst

VSE ddcsvse.lst

VM ddcsvm.lst

OS/400
ddcs400.lst

Table 14. DRDA Bind Files and Packages

Component Bind File
Name

Package
Name

MVS VM/VSE OS/400

DB2 Call Level Interface

Isolation level CS db2clics.bnd sqll1xyz yes yes yes

Isolation level RR db2clirr.bnd sqll2xyz yes yes yes

Isolation level UR db2cliur.bnd sqll3xyz yes no yes

Isolation level RS db2clirs.bnd sqll4xyz no no yes

Isolation level NC db2clinc.bnd sqll5xyz no no yes

Using MVS table
names

db2clims.bnd sqll7xyz yes no no

Using OS/400 table
names (OS/400 3.1 or
later)

db2clias.bnd sqllaxyz no no yes

Using VSE/VM table
names

db2clivm.bnd sqll8xyz no yes no

Command Line Processor

Isolation level CS db2clpcs.bnd sqlc2xyz yes yes yes

Isolation level RR db2clprr.bnd sqlc3xyz yes yes yes

Isolation level UR db2clpur.bnd sqlc4xyz yes yes yes

Isolation level RS db2clprs.bnd sqlc5xyz no no yes

Isolation level NC db2clpnc.bnd sqlc6xyz no no yes
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Table 14. DRDA Bind Files and Packages (continued)

Component Bind File
Name

Package
Name

MVS VM/VSE OS/400

REXX

Isolation level CS db2arxcs.bnd sqla1xyz yes yes yes

Isolation level RR db2arxrr.bnd sqla2xyz yes yes yes

Isolation level UR db2arxur.bnd sqla3xyz yes yes yes

Isolation level RS db2arxrs.bnd sqla4xyz yes yes yes

Isolation level NC db2arxnc.bnd sqla5xyz no no yes

Utilities

Export db2uexpm.bnd sqlubxyz yes yes yes

Import db2uimpm.bnd sqlufxyz yes yes yes

Import db2uimtb.bnd db2ukxyz yes yes yes

Note: If your DB2 for MVS/ESA system has APAR PN60988 installed (or if it
is a later release than Version 3 Release 1), you can add the bind files
for isolation level NC to the ddcsmvs.lst file.
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Appendix H. Notices

Any reference to an IBM licensed program in this publication is not intended
to state or imply that only IBM’s licensed program may be used. Any
functionally equivalent product, program or service that does not infringe any
of IBM’s intellectual property rights may be used instead of the IBM product,
program, or service. Evaluation and verification of operation in conjunction
with other products, except those expressly designated by IBM, is the user’s
responsibility.

IBM may have patents or pending patent applications covering subject matter
in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to the

IBM Director of Licensing
IBM Corporation, North Castle Drive
Armonk, NY 10504-1785
U.S.A.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Canada Limited
Office of the Lab Director
1150 Eglinton Ave. East
North York, Ontario
M3C 1H7
CANADA

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

This publication may contain examples of data and reports used in daily
business operations. To illustrate them as completely as possible, the examples
include the names of individuals, companies, brands, and products. All of
these names are fictitious and any similarity to the names and addresses used
by an actual business enterprise is entirely coincidental.
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Trademarks

The following terms are trademarks or registered trademarks of the IBM
Corporation in the United States and/or other countries:

ACF/VTAM
ADSTAR
AISPO
AIX
AIXwindows
AnyNet
APPN
AS/400
CICS
C Set++
C/370
DATABASE 2
DataHub
DataJoiner
DataPropagator
DataRefresher
DB2
DB2 Connect
DB2 Universal Database
Distributed Relational Database Architecture
DRDA
Extended Services
FFST
First Failure Support Technology
IBM
IMS
LAN Distance

MVS/ESA
MVS/XA
OS/400
OS/390
OS/2
PowerPC
QMF
RACF
RISC System/6000
SP
SQL/DS
SQL/400
S/370
System/370
System/390
SystemView
VisualAge
VM/ESA
VSE/ESA
VTAM
WIN-OS/2

Trademarks of Other Companies

The following terms are trademarks or registered trademarks of the
companies listed:

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or
both.

HP-UX is a trademark of Hewlett-Packard.

Java, HotJava, Solaris, Solstice, and Sun are trademarks of Sun Microsystems,
Inc.
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Microsoft, Windows, Windows NT, Visual Basic, and the Windows logo are
trademarks or registered trademarks of Microsoft Corporation in the United
States, other countries, or both.

PC Direct is a trademark of Ziff Communications Company in the United
States, other countries, or both and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium, and ProShare are trademarks of Intel
Corporation in the United States, other countries, or both.

UNIX is a registered trademark in the United States, other countries or both
and is licensed exclusively through X/Open Company Limited.

Other company, product, or service names, which may be denoted by a
double asterisk (**), may be trademarks or service marks of others.
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Contacting IBM

This section lists ways you can get more information from IBM.

If you have a technical problem, please take the time to review and carry out
the actions suggested by the Troubleshooting Guide before contacting DB2
Customer Support. Depending on the nature of your problem or concern, this
guide will suggest information you can gather to help us to serve you better.

For information or to order any of the DB2 Universal Database products
contact an IBM representative at a local branch office or contact any
authorized IBM software remarketer.

Telephone

If you live in the U.S.A., call one of the following numbers:
v 1-800-237-5511 to learn about available service options.
v 1-800-IBM-CALL (1-800-426-2255) or 1-800-3IBM-OS2 (1-800-342-6672) to

order products or get general information.
v 1-800-879-2755 to order publications.

For information on how to contact IBM outside of the United States, see
Appendix A of the IBM Software Support Handbook. You can access this
document by accessing the following page:
http://www.ibm.com/support/

then performing a search using the keyword “handbook”.

Note that in some countries, IBM-authorized dealers should contact their
dealer support structure instead of the IBM Support Center.

World Wide Web
http://www.software.ibm.com/data/
http://www.software.ibm.com/data/db2/library/

The DB2 World Wide Web pages provide current DB2 information about
news, product descriptions, education schedules, and more. The DB2 Product
and Service Technical Library provides access to frequently asked questions,
fixes, books, and up-to-date DB2 technical information. (Note that this
information may be in English only.)

Anonymous FTP Sites
ftp.software.ibm.com
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Log on as anonymous. In the directory /ps/products/db2, you can find
demos, fixes, information, and tools concerning DB2 and many related
products.

Internet Newsgroups
comp.databases.ibm-db2, bit.listserv.db2-l

These newsgroups are available for users to discuss their experiences with
DB2 products.

CompuServe
GO IBMDB2 to access the IBM DB2 Family forums

All DB2 products are supported through these forums.

To find out about the IBM Professional Certification Program for DB2 Universal
Database, go to http://www.software.ibm.com/data/db2/db2tech/db2cert.html
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